
Oracle Utilities Analytics
Installation Guide
Release 2.7.0.1
F18413-02

July 2019
(Updated February 2022)



Oracle Utilities Analytics Installation Guide, Release 2.7.0.1

F18413-02

Copyright © 2011, 2022, Oracle and/or its affiliates. All rights reserved.

This software and related documentation are provided under a license agreement containing restrictions on 
use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your 
license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, 
transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse 
engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is 
prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If 
you find any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on 
behalf of the U.S. Government, then the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs (including any operating system, integrated software, 
any programs embedded, installed or activated on delivered hardware, and modifications of such programs) 
and Oracle computer documentation or other Oracle data delivered to or accessed by U.S. Government end 
users are "commercial computer software" or "commercial computer software documentation" pursuant to 
the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, the use, 
reproduction, duplication, release, display, disclosure, modification, preparation of derivative works, and/or 
adaptation of i) Oracle programs (including any operating system, integrated software, any programs 
embedded, installed or activated on delivered hardware, and modifications of such programs), ii) Oracle 
computer documentation and/or iii) other Oracle data, is subject to the rights and limitations specified in the 
license contained in the applicable contract. The terms governing the U.S. Government's use of Oracle cloud 
services are defined by the applicable contract for such services. No other rights are granted to the U.S. 
Government.

This software or hardware is developed for general use in a variety of information management applications. 
It is not developed or intended for use in any inherently dangerous applications, including applications that 
may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you 
shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe 
use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software 
or hardware in dangerous applications.

Oracle, Java, and MySQL are registered trademarks of Oracle and/or its affiliates. Other names may be 
trademarks of their respective owners.

Intel and Intel Inside are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are 
used under license and are trademarks or registered trademarks of SPARC International, Inc. AMD, Epyc, and 
the AMD logo are trademarks or registered trademarks of Advanced Micro Devices. UNIX is a registered 
trademark of The Open Group.

This software or hardware and documentation may provide access to or information about content, products, 
and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly 
disclaim all warranties of any kind with respect to third-party content, products, and services unless otherwise 
set forth in an applicable agreement between you and Oracle. Oracle Corporation and its affiliates will not be 
responsible for any loss, costs, or damages incurred due to your access to or use of third-party content, 
products, or services, except as set forth in an applicable agreement between you and Oracle.



Contents - i
Oracle Utilities Analytics Installation Guide

Contents
Preface...................................................................................................................................................................................  i

Audience ................................................................................................................................................................................................  ii
Pre-requisite Knowledge .....................................................................................................................................................................  ii
Related Documents ..............................................................................................................................................................................  ii
Conventions..........................................................................................................................................................................................  iii
Abbreviations .......................................................................................................................................................................................  iii
Documentation Accessibility .............................................................................................................................................................  iv
Documentation Roadmap ..................................................................................................................................................................  iv

Chapter 1
 Introduction ......................................................................................................................................................................  1-1

Installation Components ..................................................................................................................................................................  1-2
Installation Types............................................................................................................................................................................... 1-2

Initial Installation............................................................................................................................................................... 1-2
Upgrade............................................................................................................................................................................... 1-3
Demo Installation..............................................................................................................................................................  1-3

Media Pack Components..................................................................................................................................................................  1-4

Chapter 2
Supported Platforms and Hardware Requirements .......................................................................................................... 2-1

Operating Systems and Application Servers..................................................................................................................................  2-2
Additional Notes on Supported Platforms....................................................................................................................................  2-3
Support for Software Patches and Upgrades ................................................................................................................................  2-3

Chapter 3
Planning the Installation ................................................................................................................................................... 3-1

Pre-requisite Software ....................................................................................................................................................................... 3-2
Pre-requisite Software for Oracle Utilities Analytics Database..................................................................................  3-2
Pre-requisite Software for Oracle Utilities Analytics Installer.................................................................................... 3-2
Pre-requisite Software for Oracle Data Integrator Based ELT Component........................................................... 3-2
Pre-requisite Software for Oracle Utilities Analytics Administration .......................................................................  3-3
Pre-requisite Software for Oracle Utilities Analytics Dashboards............................................................................. 3-3

Supported Source Application Versions ........................................................................................................................................  3-3
Deployment ........................................................................................................................................................................................ 3-4
Installation Checklist .........................................................................................................................................................................  3-4

Chapter 4
Installing Oracle Utilities Analytics - Initial Installation .................................................................................................. 4-1

Before You Install .............................................................................................................................................................................  4-2
Installing Oracle Utilities Analytics Database ............................................................................................................................... 4-2

Installing Prerequisite Software....................................................................................................................................... 4-2
Copying and Decompressing Install Media ..................................................................................................................  4-2
Creating the Database....................................................................................................................................................... 4-2
Creating Users and Tablespaces...................................................................................................................................... 4-3
Installing RELADM Schema...........................................................................................................................................  4-3
Installing MDADM Schema............................................................................................................................................  4-4
Installing DWADM Schema ...........................................................................................................................................  4-6



Contents - ii
Oracle Utilities Analytics Installation Guide

Configuring Spatial Data ..................................................................................................................................................  4-7
Installing Oracle Data Integrator Based ELT Component.........................................................................................................  4-7

Installing Prerequisite Software....................................................................................................................................... 4-7
Setting up Oracle GoldenGate........................................................................................................................................  4-7
Copying and Decompressing Install Media ................................................................................................................ 4-15
Starting the Installer........................................................................................................................................................ 4-15
Installation Steps ............................................................................................................................................................. 4-16
Creating a Database Directory ...................................................................................................................................... 4-20
Configuring Oracle Data Integrator Repository Creation Utility (RCU) ............................................................... 4-20
Creating WebLogic Domain for Oracle Data Integrator Agent.............................................................................. 4-21
Starting the WebLogic Admin Server .......................................................................................................................... 4-24
Starting the Managed Server (ODI_server1) .............................................................................................................. 4-25

Installing Oracle Utilities Analytics Administration Component ............................................................................................ 4-25
Installation Steps ............................................................................................................................................................. 4-25
Changing Default Password of the Admin User........................................................................................................ 4-33

Installing Oracle Utilities Analytics Dashboards Component.................................................................................................. 4-34
Copying and Decompressing Install Media ................................................................................................................ 4-34
Starting the Installer........................................................................................................................................................ 4-35
Installation Steps ............................................................................................................................................................. 4-35
Deploying Web Catalog ................................................................................................................................................. 4-37
Deploying the Repository (RPD) File.......................................................................................................................... 4-38
Configuring and Deploying the MapViewer............................................................................................................... 4-41
Updating MapViewer Configuration............................................................................................................................ 4-43
Enabling WriteBack ........................................................................................................................................................ 4-43
Enabling Auto Complete Feature in OBIEE ............................................................................................................. 4-43

Chapter 5
Upgrading Oracle Utilities Analytics from v2.7.0.0.11....................................................................................................... 5-1

Pre-requisites ......................................................................................................................................................................................  5-2
Upgrading Oracle Utilities Analytics Database Component.......................................................................................................  5-6

Copying and Decompressing the Install Media............................................................................................................  5-6
Creating Users and Tablespaces...................................................................................................................................... 5-7
Installing RELADM Schema...........................................................................................................................................  5-7
Installing MDADM Schema............................................................................................................................................  5-8
Installing DWADM Schema ...........................................................................................................................................  5-9

Upgrading Oracle Data Integrator Based ELT Component .................................................................................................... 5-10
Prerequisites for Running Oracle Utilities Analytics Installer ................................................................................. 5-10
Setting up Oracle GoldenGate...................................................................................................................................... 5-10
Copying and Decompressing Install Media ................................................................................................................ 5-17
Configuring Source Applications.................................................................................................................................. 5-22
Upgrading Oracle Utilities Analytics Administration Tool Component ................................................................ 5-23

Upgrading Oracle Utilities Analytics Dashboards Component ............................................................................................... 5-32
Prerequisites ..................................................................................................................................................................... 5-32
Copying and Decompressing Install Media ................................................................................................................ 5-32
Starting the Installer........................................................................................................................................................ 5-32
Upgrade Steps .................................................................................................................................................................. 5-33
Deploying Web Catalog ................................................................................................................................................. 5-35
Deploying Repository (RPD) File ................................................................................................................................ 5-36
Enabling WriteBack ........................................................................................................................................................ 5-39
Enabling Auto Complete Feature in OBIEE ............................................................................................................. 5-39

Chapter 6
Upgrading Oracle Utilities Analytics from v2.6.0.0.10 ...................................................................................................... 6-1

Pre-requisites ......................................................................................................................................................................................  6-2
Upgrading Source Applications to be Compatible with Oracle Utilities Analytics v2.7.0.1.................................. 6-3

Upgrading Oracle Utilities Analytics Database Component.......................................................................................................  6-6
Upgrading Oracle Data Integrator Based ELT Component ...................................................................................................... 6-6

Prerequisites for Running Oracle Utilities Analytics Installer .................................................................................... 6-6



Contents - iii
Oracle Utilities Analytics Installation Guide

Setting Up Oracle GoldenGate....................................................................................................................................... 6-6
Copying and Decompressing Install Media ................................................................................................................ 6-12
Starting the Installer........................................................................................................................................................ 6-12
Upgrade Steps .................................................................................................................................................................. 6-13
Configuring Source Applications.................................................................................................................................. 6-17

Upgrading Oracle Utilities Analytics Administration Tool Component ................................................................................ 6-21
Prerequisites ..................................................................................................................................................................... 6-21
Installation Steps ............................................................................................................................................................. 6-22
Changing Default Password of Admin User .............................................................................................................. 6-26

Upgrading Oracle Utilities Analytics Dashboards Component ............................................................................................... 6-27
Prerequisites ..................................................................................................................................................................... 6-27
Copying and Decompressing Install Media ................................................................................................................ 6-28
Starting the Installer........................................................................................................................................................ 6-28
Upgrade Steps .................................................................................................................................................................. 6-28
Deploying Web Catalog ................................................................................................................................................. 6-30
Deploying Repository (RPD) File ................................................................................................................................ 6-31

Chapter 7
Installing Demo Database ................................................................................................................................................. 7-1

Installing Oracle Utilities Analytics Demo Database Component ............................................................................................ 7-2
Copying and Decompressing Install Media ..................................................................................................................  7-2
Creating Database and Importing the Dump File .......................................................................................................  7-2
Configuring Security .........................................................................................................................................................  7-3
Configuring Spatial Data ..................................................................................................................................................  7-4

Installing Oracle Utilities Analytics Dashboards Component....................................................................................................  7-4
Copying and Decompressing Install Media ..................................................................................................................  7-5
Starting the Installer..........................................................................................................................................................  7-5
Installation Steps ............................................................................................................................................................... 7-5
Deploying Web Catalog ...................................................................................................................................................  7-8
Deploying the Repository (RPD) File............................................................................................................................  7-8
Configuring and Deploying the MapViewer............................................................................................................... 7-11
Updating MapViewer Configuration............................................................................................................................ 7-13
Enabling WriteBack ........................................................................................................................................................ 7-13
Enabling Auto Complete Feature in OBIEE ............................................................................................................. 7-13

Chapter 8
Configuring Spatial Data ................................................................................................................................................... 8-1

Acquiring the Spatial Data................................................................................................................................................................ 8-2
Installing Spatial Data ....................................................................................................................................................................... 8-2
Importing Spatial Data into Oracle Utilities Analytics Spatial Data Tables ............................................................................. 8-3

Importing Theme Related Spatial Data into Oracle Utilities Analytics .................................................................... 8-4
Improving Performance by Prefetching the Map Tiles...............................................................................................  8-6

Loading the Oracle Utilities Specific Themes ............................................................................................................................... 8-7
Additional Setup for Oracle Utilities Outage Analytics...............................................................................................................  8-8

Chapter 9
Installing NMS BI Publisher Reports ............................................................................................................................... 9-1

Chapter 10
Installing/Upgrading to Oracle Analytics Server............................................................................................................  10-1

Prerequisites...................................................................................................................................................................................... 10-2
Installing Oracle Analytics Server for the First Time ................................................................................................................ 10-2

Installing Oracle Utilities Analytics Dashboards Component ................................................................................. 10-2
Deploying Repository (RPD) File ................................................................................................................................ 10-5
Deploying Writeback Templates in Oracle Analytics Server Domain.................................................................... 10-8
Configuring and Deploying the MapViewer............................................................................................................... 10-9
Updating the MapViewer Configuration ................................................................................................................... 10-10
Enabling WriteBack ...................................................................................................................................................... 10-11
Enabling Auto Complete Feature Oracle Analytics Server .................................................................................... 10-11



Contents - iv
Oracle Utilities Analytics Installation Guide

Existing Customers Performing New Oracle Analytics Server Installation......................................................................... 10-11
Upgrading Oracle Utilities Analytics Dashboards Component ............................................................................. 10-12
Deploying Repository (RPD) File .............................................................................................................................. 10-16
Deploying Writeback Templates in Oracle Analytics Server Domain.................................................................. 10-19
Configuring and Deploying the MapViewer............................................................................................................. 10-19
Updating the MapViewer Configuration ................................................................................................................... 10-21
Enabling Writeback....................................................................................................................................................... 10-21
Enabling Auto Complete Feature Oracle Analytics Server .................................................................................... 10-21

In-place Upgrade to an Existing Oracle Analytics Server ....................................................................................................... 10-22
Upgrading Oracle Utilities Analytics Dashboards Component ............................................................................. 10-22
Deploying Repository (RPD) File .............................................................................................................................. 10-25
Deploying Writeback Templates in Oracle Analytics Server Domain.................................................................. 10-28
Configuring and Deploying the MapViewer............................................................................................................. 10-29
Updating MapViewer Configuration.......................................................................................................................... 10-30



Preface - i
Oracle Utilities Analytics Installation Guide

Preface

Welcome to Oracle Utilities Analytics Installation Guide. 

This guide provides information for those installing and configuring Oracle Utilities Analytics on 
Linux, AIX, and Solaris systems. 

The preface includes the following: 

• Audience

• Pre-requisite Knowledge

• Related Documents

• Conventions

• Abbreviations

• Documentation Accessibility

• Documentation Roadmap
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Audience
This guide is intended for use by anyone who is responsible for installing or upgrading Oracle 
Utilities Analytics. 

Pre-requisite Knowledge
Oracle Utilities Extractors and Schema and Oracle Utilities Analytics Dashboards make use of 
several technologies. It is assumed that you have a working knowledge of the following to 
configure and administer Oracle Utilities Analytics: 

• Oracle Data Warehouse

https://docs.oracle.com/en/database/oracle/oracle-database/18/dwhsg/index.html

• Oracle GoldenGate

https://docs.oracle.com/middleware/12213/cross/getstartedtasks.htm

• Oracle Data Integrator

http://docs.oracle.com/goldengate/1221/cross/getstartedtasks.htm

• Oracle GoldenGate Monitor

https://docs.oracle.com/goldengate/m12212/gg-monitor/index.html

• Oracle WebLogic Server

https://docs.oracle.com/middleware/12213/wls/index.html

• Oracle Business Intelligence Enterprise Edition

https://docs.oracle.com/middleware/12213/bisuite/docs.htm

Related Documents
The following documentation is included with this release.

Installation, Administration, and Release Notes

• Oracle Utilities Analytics Release Notes

• Oracle Utilities Analytics Getting Started Guide

• Oracle Utilities Analytics License Information User Manual

• Oracle Utilities Analytics Installation Guide

• Oracle Utilities Analytics Quick Install Guide

• Oracle Utilities Analytics Administration Guide

• Oracle Utilities Analytics Developer’s Guide

Metric Reference Guides

• Oracle Utilities Analytics Dashboards for Oracle Utilities Meter Data Analytics Metric Reference Guide

• Oracle Utilities Analytics Dashboards for Oracle Utilities Customer Analytics, Revenue Analytics and 
Credit & Collections Analytics Metric Reference Guide

• Oracle Utilities Analytics Dashboards for Oracle Utilities Exception Analytics Metric Reference Guide

• Oracle Utilities Analytics Dashboards for Oracle Utilities Mobile Workforce Analytics Metric Reference 
Guide

https://docs.oracle.com/en/database/oracle/oracle-database/18/dwhsg/index.html
http://docs.oracle.com/cd/E28280_01/nav/bi.htm
http://docs.oracle.com/cd/E28280_01/bi.1111/e10544/toc.htm
https://docs.oracle.com/en/database/oracle/oracle-database/18/dwhsg/index.html
http://docs.oracle.com/cd/E11882_01/server.112/e25554/toc.htm
http://docs.oracle.com/goldengate/1212/gg-winux/index.html
https://docs.oracle.com/goldengate/m12212/gg-monitor/index.html
http://docs.oracle.com/middleware/1221/wls/index.html
http://docs.oracle.com/middleware/1221/wls/index.html
https://docs.oracle.com/middleware/12213/wls/index.html
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• Oracle Utilities Analytics Dashboards for Oracle Utilities Distribution Analytics and Outage Analytics 
Metric Reference Guide

• Oracle Utilities Analytics Dashboards for Oracle Utilities Work and Asset Analytics Metric Reference 
Guide

• Oracle Utilities Analytics Dashboards for Oracle Utilities Operational Device Analytics Metric Reference 
Guide

Data Mapping Guides

• Oracle Utilities Extractors and Schema for Oracle Utilities Customer Care and Billing Data Mapping 
Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Meter Data Management Data Mapping Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Mobile Workforce Management Data Mapping 
Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Network Management System Data Mapping 
Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Operational Device Management Data Mapping 
Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Work & Asset Management Data Mapping 
Guide

You can view the latest documentation at http://docs.oracle.com/cd/E72219_01/
documentation.html.

Conventions
The following text conventions are used in this document: 

Abbreviations
The following table lists the commonly used acronyms and terms in this guide: 

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.

Convention Meaning

APEX Oracle Application Express

CDC Changed Data Capture

ELT Extraction, Loading and Transformation

ETL Extraction, Transformation, and Loading

OBIEE Oracle Business Intelligence Enterprise Edition

BI Business Intelligence

http://docs.oracle.com/cd/E72219_01/documentation.html
http://docs.oracle.com/cd/E72219_01/documentation.html
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Documentation Accessibility
For information about configuring and using accessibility features for Oracle Utilities Analytics, 
see the documentation at http://docs.oracle.com/cd/E23943_01/bi.1111/e10544/
appaccess.htm#BIEUG2756.

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility 
Program website at http://www.oracle.com/us/corporate/accessibility/index.html.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For more 
information, visit: http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or http://
www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Documentation Roadmap
This guide is organized based on the typical flow you need to follow to install and configure 
Oracle Utilities Analytics. Use the following documentation roadmap to find the information that 
you need to install Oracle Utilities Analytics.

1. Introduction

Includes a general description about Oracle Utilities Analytics and provides information 
about the installation types and components required to install or upgrade Oracle Utilities 
Analytics.

2. Supported Platforms and Hardware Requirements

Shows each of the operating system/server combinations that Oracle Utilities Analytics is 
certified for.

3. Planning the Installation

Describes the setup steps or pre-installation tasks that you must complete before you begin 
an Oracle Utilities Analytics installation or upgrade.

ODI Oracle Data Integrator

OGG Oracle GoldenGate

OUA Oracle Utilities Analytics

WAM Oracle Utilities Work and Asset Management

CC&B Oracle Utilities Customer Care and Billing

MDM Oracle Utilities Meter Data Management

MWM Oracle Utilities Mobile Workforce Management

NMS Oracle Utilities Network Management System

ODM Oracle Utilities Operational Device Management

OSDC Oracle Software Delivery Cloud

OAS Oracle Analytics Server

Convention Meaning

http://docs.oracle.com/cd/E23943_01/bi.1111/e10544/appaccess.htm#BIEUG2756
http://docs.oracle.com/cd/E23943_01/bi.1111/e10544/appaccess.htm#BIEUG2756
http://www.oracle.com/us/corporate/accessibility/index.html
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
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4. Installing Oracle Utilities Analytics - Initial Installation

Provides the steps for a new Oracle Utilities Analytics installation. It includes procedures to 
install various components for Oracle Utilities Analytics to be functional.

5. Upgrading Oracle Utilities Analytics from v2.7.0.0.11

Includes the steps to upgrade Oracle Utilities Analytics from v2.7.0.0.11 to v2.7.0.1. 

6. Upgrading Oracle Utilities Analytics from v2.6.0.0.10

Includes the steps to upgrade Oracle Utilities Analytics from v2.6.0.0.10 to v2.7.0.1.

7. Installing Demo Database

Provides instructions for installing the demonstration database.

8. Configuring Spatial Data 

Provides information about spatial data setup for the Oracle Business Intelligence Enterprise 
Edition dashboards in Oracle Utilities Analytics and how to set up the spatial data. It explains 
the steps to acquire, install import, and load the spatial data.

9. Installing NMS BI Publisher Reports 

Describes the steps to install the Oracle Utilities Network Management System IEEE outage 
reports in Oracle Utilities Analytics. 

10. Installing/Upgrading to Oracle Analytics Server 

Address various use cases for initial install/upgrade of Oracle Analytics Server for Oracle 
Utilities Analytics. 
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Chapter 1
 Introduction

This chapter provides an overview of the Oracle Utilities Analytics v2.7.0.1 installation. It is a 
complete installation and does not need to install any of the previous versions. 

Note: For information about configuring and administering Oracle Utilities 
Analytics (Oracle Utilities Analytics Dashboards and Oracle Utilities Extractors 
and Schema), refer to the Oracle Utilities Analytics Administration Guide. 

A typical Oracle Utilities Analytics installation involves installing various components across 
different installation types. The chapter focuses on the following:

• Installation Components

• Installation Types

• Media Pack Components
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Installation Components
The Oracle Utilities Analytics installation includes installing the following components. For a 
successful installation, it is required to install ALL of these components:

• Oracle Utilities Analytics Database - Contains star schemas and product metadata.

• Oracle Utilities Analytics ELT - Based on Oracle Data Integrator (ODI), it includes pre-built 
ODI objects necessary for ELT processes.

Note: Oracle GoldenGate (OGG) is used to capture the data and is required 
for ODI-based ELT.

• Oracle Utilities Analytics Administration - An Oracle Application Express (APEX) 
application used to maintain several Oracle Utilities Analytics configuration parameters.

• Oracle Utilities Analytics Dashboard - Includes the pre-built OBIEE Web Catalog, RPD file, 
and answers, based on OBIEE.

Note: Install this component on the server where OBIEE is installed. It also 
includes a demo database with pre-populated data used for training or 
demonstration purposes. Refer to the Installing Demo Database chapter for 
more information.

Refer to Prerequisite Software in the Planning the Installation chapter for information about the 
prerequisite software required to install each of the components. 

Installation Types
The first step in the installation procedure is to determine the installation type that meets your 
business requirements. The possible installation types are as follows:

• Initial Installation - A base installation, typically used for a production environment.

• Upgrade - An upgrade installation from v2.7.0.0.11 to v2.7.0.1.0. 

• Demo Installation - A base installation with pre-populated demo data, typically used for 
demonstration or training purposes.

The following sections describe these installation types in detail.

Initial Installation
This type is applicable for a new Oracle Utilities Analytics installation. For an initial installation, 
you must install all of the following components:

• Oracle Utilities Analytics Database

• Oracle Utilities Analytics ELT

• Oracle Utilities Analytics Administration

• Oracle Utilities Analytics Dashboard

Following is a high-level workflow of the installation process:

• Step 1: Install the database components.

• Oracle Database 18.3

• WebLogic 12.2.1.3

• Oracle Data Integrator 12.2.1.3 with JavaEE

• Oracle Utilities Analytics Database
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• Oracle Utilities Analytics Administration

• Oracle Utilities Analytics ODI-Based ELT

• Step 2: Install the dashboard components.

• Oracle Client 18.3 

• OBIEE 12.2.1.4

• Oracle Utilities Analytics Dashboard

Refer to the Planning the Installation chapter for information about the prerequisite software 
required to install each of the components. Refer to the Installing Oracle Utilities Analytics - Initial 
Installation chapter for the respective component installation steps.

Upgrade
This installation type is applicable while upgrading Oracle Utilities Analytics from v2.7.0.0.11 to 
v2.7.0.1. 

For an upgrade, you must upgrade all of the following components:

• Oracle Utilities Analytics Database

• Oracle Utilities Analytics ELT

• Oracle Utilities Analytics Administration

• Oracle Utilities Analytics Dashboard

Following is a high-level workflow of the upgrade process:

• Step 1: Upgrade the database components in the order below:

• Oracle Database 18.3

• Oracle Utilities Analytics Database

• Oracle Utilities Analytics Administration

• Oracle Utilities Analytics ODI-Based ELT

• Step 2: Install/upgrade the dashboard components as below:

• Oracle Client 18.3

• OBIEE 12.2.1.4

• Oracle Utilities Analytics Dashboard

Refer to the Planning the Installation chapter for information about the prerequisite software 
required to install each of the components. 

If you are upgrading the product from v 2.7.0.0.11, refer to chapter Upgrading Oracle Utilities 
Analytics from v2.7.0.0.11 for the steps involved in upgrading each of the required components. 

Demo Installation
This installation type is applicable when installing a database component for Oracle Utilities 
Analytics Dashboards for demonstration or training purposes. For a demo installation, install the 
following components: 

• Oracle Utilities Analytics Demo Database

• Oracle Utilities Analytics Dashboard



Media Pack Components

Introduction 1-4
Oracle Utilities Analytics Installation Guide

Following is a high-level workflow of the demo installation process:

• Step 1: Install the database components in the order below:

• Oracle Database 18.3

• Import demo data

• Step 2: Install the dashboard components as below: 

• Oracle Client 18.3 

• OBIEE 12.2.1.4 

• Oracle Utilities Analytics Dashboard 

Refer to the Planning the Installation chapter for information about the prerequisite software 
required to install each of the components. Refer to the Installing Demo Database chapter for the 
respective component installation steps.

Media Pack Components
The Oracle Utilities Analytics Media Pack consists of the following packages:

Documentation Package
• Oracle Utilities Analytics Release Notes

• Oracle Utilities Analytics Quick Install Guide

• Oracle Utilities Analytics Installation Guide

• Oracle Utilities Analytics Administration Guide

• Oracle Utilities Analytics Developer's Guide

• Oracle Utilities Analytics License Information User Manual

• Oracle Utilities Analytics Dashboards for Customer Analytics, Revenue Analytics, and Credit 
& Collections Analytics Metric Reference Guide

• Oracle Utilities Analytics Dashboards for Exception Analytics Metric Reference Guide

• Oracle Utilities Analytics Dashboards for Mobile Workforce Analytics Metric Reference 
Guide

• Oracle Utilities Analytics Dashboards for Distribution Analytics and Outage Analytics

• Oracle Utilities Analytics Dashboards for Work and Asset Analytics Metric Reference Guide

• Oracle Utilities Analytics Dashboards for Operational Device Analytics Metric Reference 
Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Customer Care and Billing Data 
Mapping Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Meter Data Management Data 
Mapping Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Mobile Workforce Management 
Data Mapping Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Network Management System 
Data Mapping Guide
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• Oracle Utilities Extractors and Schema for Oracle Utilities Operational Device Management 
Data Mapping Guide

• Oracle Utilities Extractors and Schema for Oracle Utilities Work and Asset Management 
Data Mapping Guide

Installation Package
• Oracle Utilities Analytics v2.7.0.1 Dashboard Component Multiplatform

• Oracle Utilities Analytics v2.7.0.1 ELT Component Based on ODI Multiplatform

• Oracle Utilities Analytics v2.7.0.1 Oracle Database Multiplatform

• Oracle Utilities Analytics v2.7.0.1 Demo Data
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Chapter 2
Supported Platforms and Hardware

Requirements

This chapter provides an overview of the operating system/server combinations that Oracle 
Utilities Analytics is certified for. It includes: 

• Operating Systems and Application Servers

• Additional Notes on Supported Platforms

• Support for Software Patches and Upgrades
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Operating Systems and Application Servers
An Oracle Utilities Analytics installation is tested and supported on a wide variety of operating 
system, application server, and database server combinations. The following table provides the 
details of the minimum versions supported. 

Infrastructure 12.2.1.3 and JDK 1.8.0(201)+ are applicable to OBIEE 12.2.1.4 and ODI 12.2.1.3 
but not OAS. Refer to the table below for infrastructure and JDK versions required for OAS 5.5.0. 

Important: For the latest system requirements and supported platforms details, refer to the 
knowledge article “System Requirements and Supported Platforms for Oracle Utilities Analytics” 
available on My Oracle Support (https://support.oracle.com/). 

Customers installing Oracle Utilities Analytics 2.7.0.1.3 must skip all OBIEE related installation 
steps. Refer to the Installing Dashboard Component and Installing Oracle Utilities 
Analytics Dashboards Component sections in Chapter 9: Initial Install on OAS for more 
information. 

The existing customers should refer to the Upgrading Oracle Utilities Analytics Dashboards 
Component section in Chapter 9: Upgrade Install on OAS. 

Make sure to install the Oracle GoldenGate, Apex, and Oracle REST data Service combinations 
mentioned below while using the respective Oracle databases. 

Multiple Fusion Middleware products (ODI, OBIEE, etc.) can be installed in the same Home. In 
this scenario, Fusion Middleware Infrastructure is installed only once, and the Home is reused 
while installing other Fusion Middleware products. 

Browser
Operating 

System
(Client)

Operating 
System
(Server) 

Chipset Application 
Server

Oracle 
Business 

Intelligence 
Enterprise 

Edition 
(OBIEE)

Oracle 
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JDK
Oracle 
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Oracle 
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Data 

Service

Oracle 
Database Apex

IE 11.x

Firefox 
60.0ESR+ 

(OAS/
OBIEE)

Windows 
10 (64-bit)

Oracle 
Linux 7.4 
(64-bit) 

x86_64 WebLogic 
12.2.1.3

12.2.1.4 12.2.1.3 1.8.0
(201)+

12.3.0.1
18.1
19.1

3.0.6
18.3.0
19.2

12.2.0.1
18.3
19.3

18.2
19.1

AIX 7.2 
(64-bit)

POWER 
(64-bit)

WebLogic 
12.2.1.3

12.2.1.4 12.2.1.3 1.8.0
(201)+

12.3.0.1
18.1
19.1

3.0.6
18.3.0
19.2

12.2.0.1
18.3
19.3

18.2
19.1

Oracle 
Solaris 11.4 
(64-bit)

SPARC WebLogic 
12.2.1.3

12.2.1.4 12.2.1.3 1.8.0
(201)+

12.3.0.1
18.1
19.1

3.0.6
18.3.0
19.2

12.2.0.1
18.3
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Application Server Oracle Analytics Server 
(OAS) JDK
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Oracle Database Oracle GoldenGate Apex Oracle REST Data 
Service

12c 12.3.0.1 18.2 3.0.6

18c 18.1 18.2 18.3

19c 19.1 19.1 19.2

https://support.oracle.com/
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Additional Notes on Supported Platforms
Oracle Unbreakable Enterprise Kernel - This version of Oracle Utilities Analytics is 
supported on Oracle Unbreakable Enterprise Kernel.

Oracle VM Support - This version of Oracle Utilities Analytics is supported on Oracle VM 
Server for x86 3.3 for the supported releases of Oracle Linux operating system.

Oracle Support Policy on VMWare - Refer to My Oracle Support knowledge base article 
249212.1 for Oracle’s support policy on VMWare (https://support.oracle.com).   

Support for Software Patches and Upgrades
Due to the ongoing nature of software improvement, vendors periodically issue patches and 
service packs for the operating systems, application servers, and database servers on top of 
specific versions that Oracle products have already been tested against.

If it is necessary to apply an upgrade, it is recommended to do so in a test environment that is 
running on the same platform as your production environment prior to updating the production 
environment itself.

Always contact Oracle Support prior to applying vendor updates that do not guarantee backward 
compatibility.

https://support.oracle.com
https://support.oracle.com
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Chapter 3
Planning the Installation

This chapter provides information to plan an Oracle Utilities Analytics installation, including:

• Pre-requisite Software

• Supported Source Application Versions

• Deployment

• Installation Checklist
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Pre-requisite Software
Before you install Oracle Utilities Analytics, you are required to install the prerequisite software.

Refer to the respective installation documentation of the software for download and installation 
instructions.

Note: Ensure that the same operating system user is used to install all software 
prerequisites and Oracle Utilities Analytics components.

The list of prerequisite software required to install Oracle Utilities Analytics is as below: 

• Pre-requisite Software for Oracle Utilities Analytics Database

• Pre-requisite Software for Oracle Utilities Analytics Installer

• Pre-requisite Software for Oracle Data Integrator Based ELT Component

• Pre-requisite Software for Oracle Utilities Analytics Administration

• Pre-requisite Software for Oracle Utilities Analytics Dashboards

Pre-requisite Software for Oracle Utilities Analytics Database
The prerequisite software for the Oracle Utilities Analytics database component is as follows:

Oracle Database Server Enterprise Edition 18.3 - This Oracle Utilities Analytics release is 
supported on Oracle Database Server Standard Edition 18.3 when using ODI-based ELT 
component.

Pre-requisite Software for Oracle Utilities Analytics Installer
The prerequisite software for Oracle Utilities Analytics Installer is JDK 1.8.0(201)+.

Pre-requisite Software for Oracle Data Integrator Based ELT Component
The prerequisite software for ODI-based ELT component of Oracle Utilities Analytics is as 
follows: 

• JDK 1.8.0 (201)+
Download and install the latest version from Oracle Technology Network (https://
www.oracle.com/technetwork/java/javase/downloads/index.html). 

• Oracle Database Server Enterprise Edition 18.3 
Download and install from Oracle Software Delivery Cloud (https://edelivery.oracle.com/
osdc/faces/SoftwareDelivery). 

• Oracle Fusion Middleware Infrastructure and Oracle Data Integrator 12.2.1.3 
These components can be downloaded separately from Oracle Software Delivery Cloud 
(https://edelivery.oracle.com/osdc/faces/SoftwareDelivery). 

• Oracle GoldenGate 18.1 
Install Oracle GoldenGate on both source application as well target database servers. 
Download the latest version from Oracle Software Delivery Cloud.

Oracle GoldenGate Monitor Agent 12.2.1.2 on both source application as well as target 
database servers. Download the latest version from Oracle Software Delivery Cloud.

• Oracle Utilities Analytics Administration

https:// edelivery.oracle.com
https://www.oracle.com/technetwork/java/javase/downloads/index.html
https://www.oracle.com/technetwork/java/javase/downloads/index.html
https://edelivery.oracle.com/osdc/faces/SoftwareDelivery
https://edelivery.oracle.com/osdc/faces/SoftwareDelivery
https://edelivery.oracle.com/osdc/faces/SoftwareDelivery
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Pre-requisite Software for Oracle Utilities Analytics Administration
The prerequisite software for Oracle Utilities Analytics Administration component is as follows:

• Oracle Database Server Enterprise Edition 18.3 
Download and install from Oracle Software Delivery Cloud (https://edelivery.oracle.com/
osdc/faces/SoftwareDelivery). 

• Oracle Apex 18.2
Download and install Oracle Apex from Oracle Technology Network (https://
www.oracle.com/tools/downloads/apex-downloads.html). 

• Oracle Fusion Middleware Infrastructure 12.2.1.3 
Download and install from Oracle Software Delivery Cloud (https://edelivery.oracle.com/
osdc/faces/SoftwareDelivery). 

Pre-requisite Software for Oracle Utilities Analytics Dashboards
The prerequisite software for Oracle Utilities Analytics dashboard component is as follows:

• Oracle Fusion Middleware Infrastructure 12.2.1.3 and Oracle Business Intelligence 
Enterprise Edition 12.2.1.4 

Download Oracle Fusion Middleware Infrastructure 12.2.1.3 and Oracle Business 
Intelligence Enterprise Edition 12.2.1.4 separately from Oracle Software Delivery Cloud 
(https://edelivery.oracle.com/osdc/faces/SoftwareDelivery). 

Install the Oracle 18.3 client if OBIEE is not installed on the database server. If it is installed, 
then there is no need to install Oracle client. For installation instructions, refer to the 
Installing Oracle Utilities Analytics Dashboards Component section in Chapter 4: Installing 
Oracle Utilities Analytics - Initial Installation.

After installing OBIEE, save a snapshot of the last page of OBIEE installation that shows the 
details of BI Oracle Home, Instance Home, etc. These values are used during the Oracle Utilities 
Analytics installation.

Supported Source Application Versions
The following source application versions are supported in this Oracle Utilities Analytics release: 

Source Application Version

Oracle Utilities Customer Care and Billing 2.4.0.3
2.5.0.2
2.6.0.0
2.7.0.1

Oracle Utilities Network Management System 2.3.0.x
2.4.0.0

Oracle Utilities Work and Asset Management 2.1.1.0+
2.2.0.x

Oracle Utilities Meter Data Management 2.1.0.3+
2.2.0.x 

Oracle Utilities Mobile Workforce Management 2.2.0.3+
2.3.0.x 

https://www.oracle.com/tools/downloads/apex-downloads.html
https://www.oracle.com/tools/downloads/apex-downloads.html
https://edelivery.oracle.com/osdc/faces/SoftwareDelivery
https://edelivery.oracle.com/osdc/faces/SoftwareDelivery
https://edelivery.oracle.com/osdc/faces/SoftwareDelivery
https://edelivery.oracle.com/osdc/faces/SoftwareDelivery
https://edelivery.oracle.com/osdc/faces/SoftwareDelivery
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Note: For latest edge application version details, refer to the knowledge article 
“System Requirements and Supported Platforms for Oracle Utilities Analytics 
v2.7.0.1”available on My Oracle Support (https://support.oracle.com/). 

Deployment
A standard Oracle Utilities Analytics deployment consists of a database and an application server. 
ODI, OBIEE, and WebLogic installation for Oracle Utilities Analytics Administration are 
performed on the application server. Oracle GoldenGate is installed on both source, as well as 
target database servers.

The following figure shows a standard Oracle Utilities Analytics deployment.

Installation Checklist
The following checklist guides you through the Oracle Utilities Analytics installation process. The 
details for each step are provided in respective subsequent chapters.

1. Confirm that the recommended hardware is ready. Refer to Supported Platforms and 
Hardware Requirements for details.

2. Install prerequisite software. Refer to the Pre-requisite Software for more details.

3. Determine the installation type. Refer to Installation Types to determine the installation type 
for your scenario. 

4. Ensure that you have downloaded the Oracle Utilities Analytics v2.7.0.1 components.

Oracle Utilities Operational Device Management 2.1.1.0+
2.2.0.x 

Source Application Version

https://support.oracle.com/
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5. Perform the installation steps as applicable to the installation type.

• Initial Installation - For initial installation, follow the instructions mentioned in the 
Installing Oracle Utilities Analytics - Initial Installation chapter.

• Upgrade - To upgrade to v2.7.0.1, follow the instructions in Upgrading Oracle Utilities 
Analytics from v2.7.0.0.11.

• Demo Installation - For instructions to proceed with demo installation, refer to the 
Installing Demo Database chapter.

6. Configure Oracle Utilities Analytics. 
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Chapter 4
Installing Oracle Utilities Analytics - Initial

Installation

This chapter provides instructions for a new Oracle Utilities Analytics installation. It includes:

• Before You Install

• Installing Oracle Utilities Analytics Database

• Installing Oracle Data Integrator Based ELT Component

• Installing Oracle Utilities Analytics Administration Component

• Installing Oracle Utilities Analytics Dashboards Component
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Before You Install
Refer to My Oracle Support for up-to-date additional information about this Oracle Utilities 
Analytics release. 

Installing Oracle Utilities Analytics Database 
This section describes the steps to install Oracle Utilities Analytics Database on the database 
server, including: 

• Installing Prerequisite Software

• Copying and Decompressing Install Media

• Creating the Database

• Creating Users and Tablespaces

• Installing RELADM Schema

• Installing MDADM Schema

• Installing DWADM Schema

• Configuring Spatial Data

Installing Prerequisite Software
The prerequisite software has to be installed before you begin the component installation. Refer to 
Pre-requisite Software for Oracle Utilities Analytics Database for details. 

Copying and Decompressing Install Media
To copy and decompress install media, follow these steps:

1. Download Oracle Utilities Analytics v2.7.0.1 Oracle Database from the Oracle Utilities 
Analytics v2.7.0.1 Oracle Database Multiplatform.zip file. 

Download the zip from Oracle Software Delivery Cloud (https:// edelivery.oracle.com).

2. Create a temporary directory. 

For example: /OUA/temp for a Linux machine.

This directory (referred as <TEMPDIR> below) must be located outside any current working 
Oracle Utilities application environment. After successful installation, all files in this directory 
that are part of the installation can be deleted.

3. Unzip Oracle Utilities Analytics V2.7.0.1 Oracle Database Multiplatform.zip to 
<TEMPDIR> using any zip utility.

The installation media is decompressed successfully. Proceed with creating the database. 

Creating the Database
In an initial installation, it is recommended to use the Database Configuration Assistant (DBCA) 
utility to create the database.

Note: Refer to Oracle database documentation to know more about Database 
Configuration Assistant (DBCA). 

https:// edelivery.oracle.com
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Create the database with the following: 

• Same character set as the source database character set 

• Open cursor limit to 3000

• Processes to 1000

Creating Users and Tablespaces
To create the required users and tablespaces: 

1. Create required tablespaces and proceed with User creation. 

2. Create users in the database with the below names (without giving specific roles):

• DWADM - Contains star schema objects (such as facts and dimensions) containing the 
data of the data warehouse.

• DWUSER - User with read/write access to objects in DWADM schema.

• DWREAD - User with read only access to objects in DWADM schema.

• MDADM - A metadata schema consisting of database objects used for storing the 
Oracle Utilities Analytics metadata. 

• RELADM - A metadata schema consisting of database objects used to store the product 
version and component installation information.

• OUA_MASTER - ODI Master repository schema

• OUA_WORK - ODI Work repository schema

• DWSTAGE - The staging schema of data warehouse.

3. Create roles with the following names: 

• DW_USER - Assigned to DWUSER. It contains all grants for read/write access to 
objects in the DWADM schema.

• DW_READ - Assigned to DWREAD. It contains all grants for read only access to 
objects in the DWADM schema.

• DW_PRIVS_ROLE - Assigned to MDADM. It contains the privileges necessary for the 
proper functioning of Oracle Utilities Analytics.

• DW_REPLICATE - Assigned to various replication users that get created automatically 
during the source configuration. The privileges necessary for this role are automatically 
assigned by Oracle Utilities Analytics.

4. Connect to the database as sys user. 

Execute Usersgrants.sql in <TEMPDIR>/BI2701/Scripts/Usersgrants.sql. This SQL 
provides required grants to the users created in step 1.

The required users and tablespaces are created. 

Installing RELADM Schema 
The RELADM schema is a metadata schema consisting of database objects used to store the 
product version and component installation information.

This section describes initial installation of the RELADM schema, including: 

• Reviewing Storage.xml File

• Installation Procedure

• Generating Database Statistics
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Reviewing Storage.xml File
The storage.xml file (included in the package and is in <TEMPDIR>/BI2701/RELADM/Install- 
Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. 

If few tables or indexes outside of the default tablespace need to be allocated, it should be 
reflected in the storage.xml file by changing the tablespace name from the default value to a 
custom value.

Note: If the database does not have CISTS_01 tablespace or RELADM user 
does not have quota on CISTS_01 tablespace, edit the Storage.xml file to 
indicate the correct tablespace name on which RELADM has quota. 

Installation Procedure
To install the RELADM schema: 

Note: Make sure that OraDBI.jar (in the step below) is run using JDK Version 
8.0. 

Make sure to copy/paste the commands into Notepad. Check for any special 
characters and extra spaces. If any, delete them and enter the respective 
characters manually. This helps to avoid any errors at run time. 

In Unix:

1. Add Java 8 to the path variable. For example: 

export PATH=/scratch/softwares/jdk1.8.0_201/bin:$PATH

2. Set classpath pointing to OraDBI.jar and all dependency jars.

export CLASSPATH=<TEMPDIR>/BI2701/RELADM/Jarfiles/*

3. Navigate to <TEMPDIR>/BI2701/RELADM/Install-Upgrade folder.

4. Execute OraDBI.jar. 

java com.oracle.ouaf.oem.install.OraDBI -d 
jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/<ORACLE SERVICE 
NAME>,RELADM,<Password of RELADM User>,,,,,RELADM -l 1,2 -o -q true

The utility creates the RELADM schema and system data definitions. If an error occurs while 
executing a SQL or another utility, it logs and displays the error message and allows you to re-
execute the current step. 

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects. 

Connect to the database as sys user and execute the following command: 

execute DBMS_STATS.GATHER_SCHEMA_STATS('RELADM');

Installing MDADM Schema
The MDADM schema is a metadata schema that consists of the database objects used for storing 
the Oracle Utilities Analytics metadata. 

For example: ETL job execution status, target tables for ETL, Oracle GoldenGate configuration 
details, etc.
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This section describes initial installation of the MDADM schema, including: 

• Reviewing Storage.xml

• Installation Procedure

• Generating Database Statistics

Reviewing Storage.xml
The storage.xml file (included in the package located at <TEMPDIR>/BI2701/MDADM/
Install- Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. 

If few tables or indexes outside of the default tablespace need to be allocated, it should be 
reflected in the storage.xml file by changing the tablespace name from the default value to a 
custom value.

Note: If the database does not have CISTS_01 tablespace or MDADM user 
does not have quota on CISTS_01 tablespace, edit Storage.xml to indicate the 
correct tablespace name on which MDADM has quota.

Installation Procedure
To install the MDADM schema, follow these steps for Unix: 

Note: Make sure that OraDBI.jar (in the step below) is run using JDK Version 
8.0.

Make sure to copy/paste the commands into Notepad. Check for any special 
characters and extra spaces. If any, delete them and enter the respective 
characters manually. This helps to avoid any errors at run time.

In Unix:

1. Add Java 8 to the path variable. For example: 

export PATH=/scratch/softwares/jdk1.8.0_201/bin:$PATH

2. Set classpath pointing to OraDBI.jar and all dependency jars.

export CLASSPATH=<TEMPDIR>/BI2701/MDADM/Jarfiles/*

3. Navigate to the <TEMPDIR>/BI2701/MDADM/Install-Upgrade folder.

4. Execute OraDBI.jar. 

java com.oracle.ouaf.oem.install.OraDBI -d 
jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/<ORACLE SERVICE 
NAME>,MDADM,<Password of MDADM User>,,,,,MDADM -l 1,2 -o -q true

The utility creates the MDADM schema and system data definitions.If an error occurs while 
executing a SQL or another utility, it logs and displays the error message and allows you to re-
execute the current step.

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects:

Connect to the database as sys user and execute the following command:

execute DBMS_STATS.GATHER_SCHEMA_STATS('MDADM');
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Installing DWADM Schema 
The DWADM schema contains star schema objects (such as facts and dimensions) that contain 
the data of the data warehouse.

This section describes initial installation of the DWADM schema, including: 

• Reviewing Storage.xml

• Installation Procedure

• Generating Database Statistics

Reviewing Storage.xml
The storage.xml file (included in the package located at <TEMPDIR>/BI2701/DWADM/
Install- Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. 

If few tables or indexes outside of the default tablespace need to be allocated, it should be 
reflected in the storage.xml file by changing the tablespace name from the default value to a 
custom value.

Note: If the database does not have CISTS_01 tablespace or DWADM user 
does not have quota on CISTS_01 tablespace, edit Storage.xml to indicate the 
correct tablespace name on which DWADM has quota.

Installation Procedure
To install the DWADM schema, follow these steps in Unix: 

Note: Make sure that OraDBI.jar (in the step below) is run using JDK Version 
8.0.

Make sure to copy/paste the commands into Notepad. Check for any special 
characters and extra spaces. If any, delete them and enter the respective 
characters manually. This helps to avoid any errors at run time.

In Unix:

1. Add Java 8 to the path variable. For example: 

export PATH=/scratch/softwares/jdk1.8.0_201/bin:$PATH

2. Set classpath pointing to OraDBI.jar and all dependency jars.

export CLASSPATH=<TEMPDIR>/BI2701/DWADM/Jarfiles/*

3. Navigate to the <TEMPDIR>/BI2701/DWADM/Install-Upgrade folder.

4. Run OraDBI.jar. 

java com.oracle.ouaf.oem.install.OraDBI -d 
jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/<ORACLE SERVICE 
NAME>,DWADM,<Password of DWADM 
User>,DWUSER,DWREAD,DW_USER,DW_READ,DWADM -p <Password of 
DWUSER>,<Password of DWREAD> -l 1,2 -o -q true

The utility creates the DWADM schema and system data definitions. If an error occurs while 
executing an SQL or another utility, it logs and displays the error message and allows you to re-
execute the current step.
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Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects:

Connect to the data as sys user and execute the following command: 

execute DBMS_STATS.GATHER_SCHEMA_STATS('DWADM');

Configuring Spatial Data
Refer to Chapter 8: Configuring Spatial Data for details about spatial configuration. 

Installing Oracle Data Integrator Based ELT Component
This section describes the installation procedure of Oracle Data Integrator based ELT 
component. It includes:

• Installing Prerequisite Software

• Setting up Oracle GoldenGate

• Copying and Decompressing Install Media

• Starting the Installer

• Installation Steps

• Creating a Database Directory

• Creating WebLogic Domain for Oracle Data Integrator Agent

• Starting the WebLogic Admin Server

• Starting the Managed Server (ODI_server1)

Installing Prerequisite Software
The Oracle Data Integrator based ELT component is installed on the Oracle Utilities Analytics 
application server. Refer to Deployment for information about deploying Oracle Utilities 
Analytics.

To proceed with installing the ELT component, ensure the following are taken care: 

• The operating system user that is used to install all the related software is used to install the 
ELT component also. 

• Set up the source applications with required configurations before proceeding with the ELT 
component installation. This enables to successfully extract data from them into Oracle 
Utilities Analytics. 

• Verify that the prerequisite software mentioned in Pre-requisite Software for Oracle Data 
Integrator Based ELT Component is installed.

• While installing Oracle Data Integrator 12.2.1.3, select Enterprise Installation as the 
installation type.

• While running RCU for Oracle Data Integrator 12.2.1.3, on the Select Components page, 
unselect the Oracle Data Integrator check box.

Setting up Oracle GoldenGate
This section describes setting up Oracle GoldenGate to work with Oracle Utilities Analytics. 

• Setting up Oracle GoldenGate on Source Database Server

• Setting up Oracle GoldenGate on Target Database Server
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• Setting up Oracle GoldenGate Monitor JAgent on Target and Source Database Servers

• Recommended Oracle GoldenGate Parameter Settings 

Setting up Oracle GoldenGate on Source Database Server
To set up each source instance: 

1. Create a directory on the source database server and install Oracle GoldenGate there. It will 
be Oracle GoldenGate home (OGG_Home) on the source database server. 

For example: <path>/GoldenGate Home

Note: Make a note of this directory path; it is used in the Oracle Utilities 
Analytics installation.

2. Install Oracle GoldenGate. 

Download Oracle GoldenGate 18.1 from Oracle Software Delivery Cloud. 

For installation instructions, refer to the respective Oracle GoldenGate installation 
documentation. 

3. Open a command terminal/window and set the source ORACLE_SID and 
ORACLE_HOME variables.

4. Set LD_LIBRARY_PATH as follows: 

In Unix:

export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH

5. In the Command window, change the directory to Oracle GoldenGate Home directory, and 
then execute the command below: 

In Unix: 

./ggsci

The Oracle GoldenGate prompt is shown. 

6. At the Oracle GoldenGate prompt, execute the following commands in the order they are 
listed:

• create SUBDIRS

• start mgr 

This command starts the Oracle GoldenGate manager process. 

• info all

This command verifies if the manager process is running. 

• exit 

This command exits Oracle GoldenGate. 

7. Ensure that the source database is in the archivelog mode.

8. Connect to the source database as the sys user and execute the statements shown below:

alter database add supplemental log data (primary key) columns;
alter system set enable_goldengate_replication=TRUE scope=both;

10. In the Command window, navigate to the Oracle GoldenGate Home (OGG_Home) 
directory.
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11. Open the GLOBALS file in the directory and add the following command: 

EnableMonitoring

12. Navigate to the Oracle GoldenGate home (OGG_Home) directory. 

13. Connect to the database as sys user using SQL*Plus.

Ensure OGG_Home to be the current directory while invoking SQL*Plus. 

14. Create a new user.

For example: ODM01SRC

This user is the Oracle GoldenGate owner. Ensure to assign a tablespace to this user that is 
not assigned to any other user. 

Note: Ensure to note down the GoldenGate Owner Username; it will be used 
in the Oracle Utilities Analytics installation.

15. Connect to the source database with sys user. 

16. Execute the following commands: 

Note: Ensure to modify the GoldenGate owner placeholder with actual name 
of the database user created in step 14. 

grant CREATE SESSION,CONNECT,RESOURCE,ALTER SYSTEM to <GoldenGate 
Owner>; 
grant unlimited tablespace to <GoldenGate owner> with admin 
option;
EXECUTE dbms_goldengate_auth.grant_admin_privilege('<GoldenGate 
Owner>','capture'); 
grant unlimited tablespace to <GoldenGate Owner> with admin 
option;
Revoke dba from <GoldenGate Owner>; 
grant create any view to <GoldenGate Owner>;
grant select any dictionary to <GoldenGate Owner>;
GRANT CREATE ANY DIRECTORY TO <GoldenGate Owner>;
GRANT DROP ANY DIRECTORY TO <GoldenGate Owner>; 
GRANT EXP_FULL_DATABASE TO <GoldenGate Owner>; 
GRANT IMP_FULL_DATABASE TO <GoldenGate Owner>; 

17. Connect to the <source application>ADM schema (such as CISADM). Execute the 
following commands: 

For Oracle Utilities Customer Care and Billing source database, execute the following 
grants:

Grant select on F1_MST_CONFIG to <GoldenGate owner user created in 
step 16>
Grant select on F1_EXT_LOOKUP_VAL to <GoldenGate owner user created 
in step 16>
Grant select on F1_BKT_CONFIG to <GoldenGate owner user created in 
step 16>
Grant select on F1_BKT_CONFIG_VAL to <GoldenGate owner user created 
in step 16>

For Oracle Utilities Operational Device Management source database, execute the 
following grants:

Grant select on F1_MST_CONFIG to <GoldenGate owner user created in 
step 16>
Grant select on F1_EXT_LOOKUP_VAL to <GoldenGate owner user created 
in step 16>
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For Oracle Utilities Meter Data Management source database, execute the following 
grants:

Grant select on <application ADM Schema>.F1_MST_CONFIG to 
<GoldenGate Owner>;
Grant select on <application ADM Schema>.F1_EXT_LOOKUP_VAL to 
<GoldenGate Owner>;

For Oracle Utilities Work and Asset Management source database, execute the following 
grants:

Grant select on <application ADM Schema>. F1_EXT_LOOKUP_VAL to 
<GoldenGate Owner>;
Grant select on <application ADM Schema>.F1_MST_CONFIG to 
<GoldenGate Owner>;
Grant select on <application ADM Schema>. F1_BKT_CONFIG to 
<GoldenGate Owner>;
Grant select on <application ADM Schema>. F1_BKT_CONFIG_VAL to 
<GoldenGate Owner>;

Note: While executing SQL commands in steps 15, 16, and 17, provide the 
GoldenGate owner user (if prompted for). 

All the scripts mentioned below are located in GoldenGate Home directory and 
must be executed after connecting to the database as sys user.

18. Execute the following commands in the order listed below:  

@marker_setup.sql
@ddl_setup.sql
@role_setup.sql

19. Exit SQL*Plus.

20. Change directory to the Oracle GoldenGate Home directory and execute the following: 

a. Steps in Configuring Encrypting Data Using ENCKEYS Method. 

b. Steps in Generating Shared Secret Password. 

Note: Execute these steps before running the Oracle Utilities Analytics 
installer. See http://docs.oracle.com/goldengate/c1221/gg-winux/index.html 
for more details. 

Configuring Encrypting Data Using ENCKEYS Method
To configure for encrypting data with the ENCKEYS method, do the following: 

1. Execute the following command:

cd <OGG_HOME>
keygen <encryption key length (in bits)> [number of keys to 
generate]

The key value has to be copied to ENCKEYS file against a logical name.

2. For each key value generated above, provide a logical name (Logical name should not be the 
same for two different key values). Enter the logical name space and then key value in the 
ENCKEYS file. 

3. Repeat the step above for each key values generated. 

4. Save the file with name ‘ENCKEYS’ (upper case only) without any extension. 

Example: 

http://docs.oracle.com/goldengate/c1221/gg-winux/index.html
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cd $OGG_HOME
./keygen 128 1
0x8CE55035DD6893205A7BD6773FA8E670

5. Open a new ASCII ENCKEYS file if it does not exist for adding a new entry or open an 
existing ENCKEYS text file to append. 

6. Input the Logical name, space and key value generated.

Sample content of the ENCKEYS file: 

CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670

7. The source ENCKEYS file entry has to be appended to the intermediate server or target 
server which would be configured with the source system where target OGG is being 
configured.

Note: It is recommended to provide a logical key name after 
<context_code>KEY. 

For example: If context code is CCB1, it is recommended to name it as 
CCB1KEY.

Generating Shared Secret Password
To generate the shared secret password, follow these steps: 

1. Execute the following command:

cd <OGG_HOME>
ggsci
ENCRYPT PASSWORD <GG Owner password> <algorithm> ENCRYPTKEY 
<key_name>

Example: 

cd $OGG_HOME
./ggsci
GGSCI (hostname) 1> ENCRYPT PASSWORD CCB01SRC AES128 ENCRYPTKEY 
CCB1KEY
Encrypted password: 
AADAAAAAAAAAAAIAVGNHBFLGFCHBTCVBFJFHUEJGNCFAOAFEOFBALELISFOEIFWGRB
ZHCCMCYGYBDAZH
Algorithm used: AES128

2. Note the above generated ENCKEYS file logical name/key value, algorithm name used, and 
the generated encrypted password. 

Setting up Oracle GoldenGate on Target Database Server
To set up Oracle GoldenGate on the target database server: 

1. Create a directory on the target database server. 

For example: ../GoldenGateHome 

Oracle GoldenGate should be installed in this directory. It is Oracle GoldenGate home 
(OGG_Home) on the target Oracle Utilities Analytics database server.

Note: Ensure to note down the directory location; it will be used in the Oracle 
Utilities Analytics installation.

2. Install Oracle GoldenGate and provide the GoldenGate Home location as the directory 
location created in the step 1.
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3. In the Command window, set the target ORACLE_SID and ORACLE_HOME variables.

Set LD_LIBRARY_PATH using the following commands:

In Unix:

export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH

4. In the Command window, change the directory to GoldenGate Home and execute the 
following command: 

For Unix:

./ggsci

The Oracle GoldenGate prompt is shown. 

5. At the prompt, execute the following commands:

create SUBDIRS
start mgr
info all
exit

6. Connect to the target database as sys user and execute the command below: 

alter system set enable_goldengate_replication=TRUE scope=both;

7. In the Command window, navigate to the Oracle GoldenGate Home (OGG_Home) 
directory.

8. Edit the GLOBALS file in the <GG home> directory and add the following command.:

EnableMonitoring

9. Navigate to the Oracle GoldenGate home (OGG_Home) directory.

10. If the ENCKEYS file does not exist, follow these steps:

a. Create and open a new ASCII ENCKEYS file.

b. Add the key value/values that are generated on the sources to the ENCKEYS file in 
target OGG home. This is done for the context codes for which source is configured. 

A sample ENCKEYS file in target OGG home is as below: 

CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670

Setting up Oracle GoldenGate Monitor JAgent on Target and Source Database 
Servers

Set up Oracle GoldenGate Monitor (OGG) JAgent on Oracle Utilities Analytics GoldenGate 
server and on all the source application Oracle GoldenGate servers. The Oracle GoldenGate 
Monitor JAgent is used to automatically copy the generated Oracle GoldenGate scripts to both 
source and target Oracle GoldenGate Home directories, and to start the extract and replicate 
processes on source and target. 

To setup Oracle GoldenGate Monitor JAgent on both target and source database servers: 

1. Ensure Oracle GoldenGate is installed and Manager is running. 

2. Start the rmiregistry services using the following command: 

rmiregistry 5559 &

Ensure to note down the port on which RMI server is started. The port number specified 
here is 5559. If it is not specified, the default port 1099 will be used. 
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3. Download Oracle GoldenGate Monitor and Veridata 12.2.1.2.0 from Oracle Software 
Delivery Cloud (https://edelivery.oracle.com/osdc/faces/SoftwareDelivery). 

4. Run the Oracle GoldenGate Monitor and Veridata 12.2.1.2.0 installer. 

a. Choose installation type as Oracle GoldenGate Monitor Agent.

b. Apply patch 26982776 on top of Oracle GoldenGate Monitor agent home before 
creating monitor instance.

5. Edit the Config.properties file in the <Oracle GoldenGate Monitor home>/oggmon/
ogg_agent/cfg_templates and add/modify the below parameters. 

<ACTUAL>   : jagent.host=localhost
<CHANGE TO> : jagent.host=<<actual hostname on which OGG is 
installed>>

 
<ACTUAL>    : monitor.jmx.username=cmroot
<CHANGE TO> : monitor.jmx.username=jmx_src

<ACTUAL>   : jagent.username=root
<CHANGE TO> : jagent.username=<<OGG software installed OS user>>

<ACTUAL>    : jagent.rmi.port=5559
<CHANGE TO> : jagent.rmi.port=5557 or any free port other than the 
one on which the rmiregistry is started
 
<ACTUAL>    : agent.type.enabled=OGGMON
<CHANGE TO> : agent.type.enabled=OEM
<ACTUAL>    : jagent.backward.compatibility=true

   <CHANGE TO> : jagent.backward.compatibility=false

6. Add the following parameter:

jagent.ssl=false

7. Navigate to <Oracle GoldenGate Monitor home>/oggmon/ogg_agent directory and run 
the below command:

In Unix:

export JAVA_HOME=<JDK home>

./createMonitorAgentInstance.sh

a. You will be prompted to enter: 

• Oracle GoldenGate home directory

• Path to be used for Oracle GoldenGate Monitor Agent instance.

It is recommended to provide a path (such as <Oracle GoldenGate Monitor 
home>/Agents/OGGMonitorInstance). 

• A unique name to replace the timestamp in the name of the file used to start Oracle 
GoldenGate Monitor agent instance. 

Provide a unique name to be used for this Oracle GoldenGate Monitor instance. 

b. Execute the command below from <path used for Oracle GoldenGate Monitor instance 
provided in the step above>/bin. 

Example location: <Oracle GoldenGate Monitor home>/Agents/
OGGMonitorInstance/bin

https://edelivery.oracle.com/osdc/faces/SoftwareDelivery
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In Unix: 

export JAVA_HOME=<JDK home>
./pw_agent_util.sh -jagentonly

8. Enter the Oracle wallet password. 

This password has to be entered as the password for the JAGENT while running the installer 
(for target gg), and while running the source configuration (for source gg). 

Ensure to note the password and jagent.rmi.port value (JAgent Port). This information is 
required in subsequent installation. 

9. Create a folder with the Context_code name in <Oracle GoldenGate Home>/dirdat. 

For example: If WAM2 is created for the Oracle Utilities Work and Asset Management 
source, create a folder with name “WAM2” within the <Oracle GoldenGate Home>/dirdat/ 
folder. 

10. Create a folder with name <Oracle GoldenGate Home>/diroby. 

11. Navigate to <Oracle GoldenGate Home>/dirprm and edit jagent.prm file.

Replace COMMAND java with COMMAND <JDK Home>/bin/java.

This ensures that the correct version of java (1.8) is used while starting JAgent. 

12. Navigate to OGG_Home directory and go to the GoldenGate prompt:

ggsci

13. Start the jAgent process using the following command: 

start jagent 

Note: Export LIBPATH with jdk,OGG and RDBMS paths to start JAGENT 
in AIX environment. 

$JAVA_HOME/bin
$OGG_HOME
$RDBMS_HOME/lib

Example: 

export LIBPATH=/usr/java8_64/bin:/scratch/bi_oradata_01/
GG_18c_Home:/scratch/gbuora/app/gbuora/product/18.3/dbhome_2/
lib:$LIBPATH

The logs for JAgent are created at the following (example) location. 

<OGG Monitor home>/Agents/OGGMonitorInstance/logs

Recommended Oracle GoldenGate Parameter Settings
The recommended Oracle GoldenGate parameter settings are as follows: 

1. Update the source <Source GG Home>/dirprm/mgr.prm file as follows:

AUTORESTART EXTRACT <Context Code>*, RETRIES 5, WAITMINUTES 2, 
RESETMINUTES 
60 
PURGEOLDEXTRACTS dirdat/<Context Code>/*, USECHECKPOINTS, 
MINKEEPHOURS 4 
DOWNCRITICAL 
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2. Update the Target <Target GG Home>/dirprm/mgr.prm file with the following: 

AUTORESTART REPLICAT <Context Code>*, RETRIES 5, WAITMINUTES 2, 
RESETMINUTES
60 
PURGEOLDEXTRACTS dirdat/<Context Code>/*, USECHECKPOINTS, 
MINKEEPHOURS 4 
DOWNCRITICAL 

3. Restart the mgr process after the changes mentioned above are complete. 

The following parameters are optional and depend on the level of alerts required for the 
environment. 

For Oracle Utilities Network Management System sources: 

• DOWNREPORTMINUTES 2 - Report any downtime more that 2 minutes

• LAGCRITICALMINUTES 2 - Report any lag > 2 minutes as critical 

• LAGINFOSECONDS 30 - Report any lag > 30 seconds as warning 

• LAGREPORTMINUTES 1 - Log lag information every minute 

For other sources:

• DOWNREPORTMINUTES 10 - Report any downtime more that 10 minutes 

• LAGCRITICALMINUTES 10 - Report any lag > 10 minutes as critical 

• LAGINFOMINUTES 5 - Report any lag > 5 seconds as warning 

• LAGREPORTMINUTES 5 - Log lag information every 5 minutes 

Copying and Decompressing Install Media
To download and decompress the install media:

1. Download the Oracle Utilities Analytics v2.7.0.1 Multiplatform part (Oracle Utilities 
Analytics V2.7.0.1 Multiplatform.zip) from Oracle Software Delivery Cloud (https://
edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (referred to 
<TEMPDIR> below). This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation. 

3. Unzip Oracle Utilities Analytics V2.7.0.1 Multiplatform.zip to <TEMPDIR>. 

Starting the Installer
For an AIX operating system, set the following environment variable before starting the Oracle 
Utilities Analytics installation: 

export IBM_JAVA_OPTIONS=”-Xmx2g  -XX:PermSize=64m -
XX:MaxPermSize=3200m”

To start the Oracle Data Integrator Based ELT component:

1. Navigate to the temporary folder containing the installer. 

2. Run the following command from this folder: 

java -jar <TEMPDIR>/OUA_2.7.0.1.0_generic.jar -logLevel finest

Note: The minimum JDK required for running the Oracle Utilities Analytics 
installer is JDK 1.8. 

https://edelivery.oracle.com
https://edelivery.oracle.com
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3. On the Welcome page, review this information before you begin the installation. Click Next 
to continue with the installation. 

4. Complete the tasks on the navigation pane. 

Each item in the navigation pane represents a specific installer screen that prompts you for 
information required to install the software. 

• If you select Oracle Data Integrator Based ETL as an Installation Type, define the 
following:

• Database and Java Home Details

• Target Database Connection Details

• Oracle Data Integrator Home and Schema Details

• Oracle Data Integrator Agent and Repository Details

• Target Oracle GoldenGate Details

• Target JAgent Details

• If you select Dashboard as an Installation Type, define the following:

• Database and Java Home Details

• Target Database Connection Details

• OBIEE Home Details 

• If you select both Oracle Data Integrator Based ETL and Dashboard as an 
Installation Type, define the following:

• Database and Java Home Details

• Target Database Connection Details

• Oracle Data Integrator Home and Schema Details

• Oracle Data Integrator Agent and Repository Details

• Target Oracle GoldenGate Details

• Target JAgent Details

• OBIEE Home Details

Installation Steps
To install Oracle Data Integrator Based ETL: 

1. Run the Oracle Utilities Analytics Installer. The Welcome page appears.

2. Review the information before you begin the installation. Click Next to continue with the 
installation. 

3. Provide the inventory location on the Installation Inventory page. Click Next. 

4. On the Installation Location page, define the Installation Location and click Next. 

Note: The specified Oracle home directory must be an empty directory.

5. On the Languages Selection page, make sure “English” is selected. Click Next. 

6. On the Installation Type page, select ODI Based ETL and click Next. 

Note: Based on the selected installation type, the options on the left navigation 
panel change. 
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7. Select Oracle Data Integrator Based ETL as an Installation Type. Define the following:

• Database and Java Home Details

• Target Database Connection Details

• Oracle Data Integrator Home and Schema Details

• Oracle Data Integrator Agent and Repository Details

• Target GoldenGate Details

• Target Jagent Details

8. On the Database and Java Home Details page, enter the following details in the respective 
fields and click Next. 

9. On the Target Database Connection Details page, enter the following details in the 
respective fields and click Next. 

10. On ODI Home and Schema Details page, enter the following details in the respective 
fields. Click Next. 

Field Name Description Value

Database Client Home Database client home location Example: /u01/app/product/
18.3.0/dbhome_1

Java Home JDK home location Provide location of JDK 1.8

Example: /u01/jdk_1.8.0_201

Field Name Description Value

Host Host name of the server 
where the database resides

Oracle Utilities Analytics 
Database Server

Port Database port number on the 
database server used for 
connecting to the database

Oracle Utilities Analytics 
Database Port. The default value 
is 1521.

Service Name Service name for the database

Target Schema 
Password

Password for the target 
schema (DWADM)

Confirm Target 
Schema Password 

Confirm password for the 
target schema (DWADM)

Metadata Schema 
Password

Password for the metadata 
schema (MDADM)

Confirm Metadata 
Schema Password

Confirm password for the 
metadata (MDADM) schema

Field Name Description Value

ODI Home Directory where Oracle Data 
Integrator (ODI) is installed

Example:

/u01/Middleware/
FMW_12213_home/
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11. On the ODI Agent and Details page, enter the following details in the respective fields. 
Click Next.

12. On the Target GoldenGate Details page, enter the following details in the respective fields. 
Click Next. 

Supervisor User Name of the Oracle Data 
Integrator Supervisor

SUPERVISOR 

Supervisor Password Password of the Oracle Data 
Integrator Supervisor

SUPERVISOR user password

Confirm Supervisor 
Password

Confirm password of the 
Supervisor 

Master Repository 
Schema Name

Oracle Data Integrator master 
repository schema name

OUA_MASTER

Master Repository 
Schema Password

Password of the master 
repository schema

OUA_MASTER user's password

Confirm Master 
Repository Schema 
Password

Confirm password of the 
Oracle Data Integrator master 
repository schema 

Work Repository 
Schema Name

Oracle Data Integrator work 
repository schema name

OUA_WORK

Work Repository 
Schema Password

Work repository schema 
password

OUA_WORK user's password

Confirm Work 
Repository Schema 
Password

Confirm password of Oracle 
Data Integrator work 
repository schema

Field Name Description Value

ODI Agent Host Host where Oracle Data 
Integrator WebLogic Domain 
is created

Oracle Data Integrator Server 
host name.

ODI Agent Port Port on which Oracle Data 
Integrator WebLogic agent is 
configured to run. 

This is the Oracle Data 
Integrator WebLogic 
Managed Server port.

Provide available port and ensure 
to use the same port while 
creating Oracle Data Integrator 
managed server.

Field Name Description Value

GoldenGate Host Oracle GoldenGate Manager 
host

GoldenGate Home Location where Oracle 
GoldenGate is installed

Example:

/opt/local/ggs_18.1

Field Name Description Value
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13. On the Target JAgent Details page, enter the target server JAgent details in the respective 
fields. Click Next. 

Target Database Home Location where database 
home is installed on the target 
database server. 

If GoldenGate for target is 
not installed on the Oracle 
Utilities Analytics database 
server, provide oracle client 
home location on the server 
on which GoldenGate is 
installed.

Example: 

/u00/oracle/app/oracle/
product/18.3/dbhome_1

GoldenGate Manager 
Port

The port number on which 
Oracle GoldenGate Manager 
is running on the GoldenGate 
host.

The default value is 7830. 

GoldenGate Algorithm The algorithm configured in 
Oracle GoldenGate on the 
target database server.

The default value is BLOWFISH.

GoldenGate 
Encryptkey

The Encrypt Key configured 
in Oracle GoldenGate on the 
target database server. 

The default value is 
“DEFAULT”.

GoldenGate Shared 
Secret

Shared secret key configured 
in Oracle GoldenGate on the 
target database server.

Go to the Oracle GoldenGate 
prompt and run the command: 
encrypt password <password of 
MDADM user>, encryptkey 
DEFAULT 

Provide the result of above 
command as the value.

Field Name Description Value

JAgent Host Oracle GoldenGate Monitor 
JAgent host

JAgent GoldenGate Oracle GoldenGate installed 
location where GoldenGate 
Monitor JAgent is running

Example: 

/opt/local/ggs_18.1

JAgent Port Use the JAgent RMI port 
(5557) defined in the config 
properties file

JAgent User OS user used to configure 
JAgent

JAgent Wallet Password JAgent Wallet password

Field Name Description Value
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14. On the Java Home Location page, provide the JavaHome details provided earlier. Click 
Next. 

15. On the Installation Summary page, verify the installation options selected.

16. Click Install to begin the installation. 

To change any configurations before starting the installation, use the navigation pane and 
select the topic to edit. 

The Installation Progress page appears displaying the progress of the installation. 
Operations being performed as a part of the installation are logged to the terminal from 
which the installer was run. The detailed logs of the installation are also available in the logs/
system directory under the installation location.

To quit before the installation is complete, click Cancel. Doing so will result in a partial 
installation; the portion of the software that was installed on your system before you click 
Cancel will remain on your system, and you will have to remove it manually.

17. On the Installation Completed page, click Finish to close the installer.

The Oracle Data Integrator based ETL is now installed.

Note: To configure source, refer to the Chapter 5: Configuring Oracle 
Utilities Analytics in Oracle Utilities Analytics Administration Guide. 

Creating a Database Directory
Create a database directory 'B1_DATA_DUMP_DIR' on the target database, as well as on each 
source database. This directory is used for logging the export import task used during the initial 
ELT load. 

The following is a sample SQL that creates the database directory pointing to the file system path 
/scratch/file_data: 

CREATE DIRECTORY B1_DATA_DUMP_DIR AS '/scratch/file_data';

Configuring Oracle Data Integrator Repository Creation Utility (RCU)
To configure the Oracle Data Integrator Repository Creation Utility: 

1. Ensure RCU for ODI is run and the required schemas are created in the target database.

ODI_ORACLE_HOME is an Oracle Home path used as Oracle Home while installing 
FMW Infrastructure and Oracle Data Integrator (ODI).

2. Set or export JAVA_HOME variable to the 1.8.0_201+ installed directory. 

3. Navigate to $ODI_ORACLE_HOME/oracle_common/bin. 

4. Execute the RCU utility.

For example:

export JAVA_HOME=/scratch/bi_oradata_01/jdk1.8.0_201
cd  /scratch/bi_oradata_01/Middleware_ODI_12.2.1.3_EE/Oracle_Home/
oracle_common/bin
./rcu

Confirm JAgent Wallet   
Password

Re enter JAgent Wallet 
password to confirm

Field Name Description Value
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5. In the Repository Creation Utility, select Create Repository > System Load and Product 
Load option.

6. On the page, provide the database connection details. 

7. On the Select Components page, the options are shown as below. Unselect the Oracle Data 
Integrator component.  

8. In the next page, make a note of or remember the password given. It will be required while 
creating the Oracle Data Integrator domain. 

Note that a new script to create the ODI domain is described in the Creating WebLogic 
Domain for Oracle Data Integrator Agent section. This utility assumes that the same 
password is used for all RCU schemas. The assumption was made to keep the inputs to the 
domain creation script simple. 

It is not required to create the Oracle Data Integrator domain at this stage. It should be done after 
running the Oracle Utilities Analytics installer and before running source configuration tool.

Creating WebLogic Domain for Oracle Data Integrator Agent
Create the WebLogic Domain to bring up the WebLogic Agent (ODI Agent) to complete the 
steps. In this product release, ODI Domain creation is automated, and creation of both clustered 
and non-clustered domain is supported. 

• Creating a Non-Clustered Domain

• Creating a Clustered Domain

Note: The following procedures assume that the pre-requisite Java 8/bin is in 
the PATH variable. 

Creating a Non-Clustered Domain
To create a non-clustered domain:

Note: The password fields’ values 
(RCUSCHEMAPWD,WEBLOGIC_PASSWORD) will be cleared from 
ODI_CONFIG.properties after executing createDomain.sh or 
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createMachine.sh. Ensure these fields are updated for each invocation of 
createDomain.sh or createMachine.sh. 

1. Navigate to the <OUA Environment>/etc directory and provide the following properties in 
the ODI_CONFIG.properties file. 

2. Navigate to the <OUA Environment>/bin directory and invoke the createDomain.sh 
script.

Refer to the sections Starting the WebLogic Admin Server and Starting the Managed Server 
(ODI_server1) to start the Admin server and Managed server.

Creating a Clustered Domain
Important! The scope of the domain creation scripts for clustered domain is 
limited to creating a 2-node cluster with managed servers running on the same 
machine but on different ports. If your cluster needs more than two managed 
servers or if the managed servers run on different machines, the clustered 
domain should be created manually using ODI documentation as reference. 

To create a clustered domain: 

Note: The password fields’ values 
(RCUSCHEMAPWD,WEBLOGIC_PASSWORD) will be cleared from 
ODI_CONFIG.properties after executing createDomain.sh or 

Property Description

                                  Mandatory fields

DOMAIN_PATH For example: 
/u01/odi12.2.1/odi12.2.1_home/user_projects/domains/
odi_domain5

RCUPREFIX Repository prefix created in the Configuring Oracle Data 
Integrator Repository Creation Utility (RCU) section. 

RCUSCHEMAPWD Repository schema password provided in the Configuring Oracle 
Data Integrator Repository Creation Utility (RCU) section. 

WEBLOGIC_
USERNAME

WebLogic user name for ODI domain

WEBLOGIC_
PASSWORD

WebLogic password for ODI domain

ODI_DBSERVER ODI database server name (target database server)

ODI_DBPORT ODI database port (target database port)

ODI_DBNAME ODI database name (target database name)

ADMIN_PORT ODI domain admin port

ODI_DOMAIN_
HOSTNAME

Host name on which the ODI domain is created

                                       Optional fields

NONSSL_PORT If not specified, default port 7001 will be assigned.

MANAGED_SERVER_
PORT

If not specified, default port 15101 will be assigned.
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createMachine.sh. Ensure these fields are updated for each invocation of 
createDomain.sh or createMachine.sh. 

1. Navigate to the <OUA Environment>/etc directory and provide the following properties in 
the ODI_CONFIG.properties file. 

2. Navigate to the <OUA Environment>/bin directory and invoke the createDomain.sh 
script. 
This creates an ODI domain with an Admin server and a Managed server (as ‘ODI_server1’) 
and assigned to the cluster. 

Refer to the Starting the WebLogic Admin Server and Starting the Managed Server 
(ODI_server1) sections to start the Admin server and Managed server.

To create another managed server and add it to the cluster: 

1. Bring up the Admin server. 

2. Navigate to the <OUA Environment>/etc directory and provide the following mandatory 
properties in the ODI_CONFIG.properties file: 

• MANAGED_SERVER_NAME

• MANAGED_SERVER_PORT

3. Provide the following optional properties in the ODI_CONFIG.properties file: 

• MACHINE_NAME 

• MACHINE_PORT

Property Description

                                  Mandatory fields

DOMAIN_PATH For example: /u01/odi12.2.1/odi12.2.1_home/user_projects/
domains/odi_domain5

RCUPREFIX Repository prefix created in the Configuring Oracle Data 
Integrator Repository Creation Utility (RCU) section. 

RCUSCHEMAPWD Repository schema password provided in the Configuring Oracle 
Data Integrator Repository Creation Utility (RCU) section. 

WEBLOGIC_
USERNAME

WebLogic user name for ODI domain

WEBLOGIC_
PASSWORD

WebLogic password for ODI domain

ODI_DBSERVER ODI database server name (target database server)

ODI_DBPORT ODI database port (target database port)

ODI_DBNAME ODI database name (target database name)

ADMIN_PORT ODI domain admin port

ODI_DOMAIN_
HOSTNAME

Host name on which the ODI domain is created

CLUSTER_NAME Additional mandatory field for clustered domain
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4. Navigate to <OUA_Environment>/bin and invoke createMachine.sh. 

A new managed server is created with the specified name and assigned to the cluster.

Refer to the sections Starting the WebLogic Admin Server and Starting the Managed Server 
(ODI_server1) to start the Admin server and Managed server. 

Starting the WebLogic Admin Server 
To start the WebLogic Admin server, perform the following steps: 

1. In the command shell, change the directory to the directory of the WLS Home. 

<MW_HOME>/user_projects/domains/<ODI_DOMAIN_NAME>/bin

2. Modify startweblogic.sh script before execution. Follow these steps: 

a. Make sure to take a backup of startweblogic.sh script. 

b. Edit the startweblogic.sh script in the editor. 

c. Add the following code after the # START WEBLOGIC pattern. 

export CONFIG_JVM_ARGS=”-Djava.security.egd=file:/dev/./urandom 
-Dweblogic.security.SSL.enableJSSE=true -
Dweblogic.security.SSL.ignoreHostnameVerification=true -
Dweblogic.security.TrustKeyStore=DemoTrust -
Dweblogic.security.CustomTrustKeyStoreType=JKS”

d. Insert the following code after the pattern:

Djava.security.policy=${WLS_POLICY_FILE}

Note: Insert at all the three places where the pattern occurs

-Djava.security.egd=file:/dev/./urandom -
Dweblogic.security.SSL.enableJSSE=true -
Dweblogic.security.SSL.ignoreHostnameVerification=true -
Dweblogic.security.TrustKeyStore=DemoTrust -
Dweblogic.security.CustomTrustKeyStoreType=JKS 

Example: 

Before inserting:

${JAVA_HOME}/bin/java ${JAVA_VM} ${MEM_ARGS} ${LAUNCH_ARGS} -
Dweblogic.Name=${SERVER_NAME} -
Djava.security.policy=${WLS_POLICY_FILE} ${JAVA_OPTIONS} 
${PROXY_SETTINGS} ${SERVER_CLASS}

After inserting:

${JAVA_HOME}/bin/java ${JAVA_VM} ${MEM_ARGS} ${LAUNCH_ARGS} -
Dweblogic.Name=${SERVER_NAME} -
Djava.security.policy=${WLS_POLICY_FILE} -
Djava.security.egd=file:/dev/./urandom -
Dweblogic.security.SSL.enableJSSE=true -
Dweblogic.security.SSL.ignoreHostnameVerification=true -
Dweblogic.security.TrustKeyStore=DemoTrust -
Dweblogic.security.CustomTrustKeyStoreType=JKS  ${JAVA_OPTIONS} 
${PROXY_SETTINGS} ${SERVER_CLASS}



Starting the Managed Server (ODI_server1)

Installing Oracle Utilities Analytics - Initial Installation 4-25
Oracle Utilities Analytics Installation Guide

3. Execute the startweblogic.sh command. 

Unix: 

nohup ./startWebLogic.sh > startWebLogic.log 2>&1 &

Starting the Managed Server (ODI_server1)
To start the ODI_server1 managed server:

1. Change to <MW_HOME>/user_projects/domains/<ODI_DOMAIN_NAME>/servers/ 
ODI_server1/security/. 

2. Create boot.properties file. Enter the username and password in the respective fields in the  
file. Save the file.

Below is an example of the boot.properties file:

username=<weblogic username>
password=<weblogic password>

3. Change the directory to WLS Home to start ODI_server1: 

In Unix: 

<MW_HOME>/user_projects/domains/<ODI_DOMAIN_NAME>/bin
nohup ./startManagedWebLogic.sh ODI_server1 > 
StartManagedWeblogic.log 2>&1 &

Note: Oracle Data Integrator Studio 12.2.1.3 is not supported in AIX and 
Solaris operating systems. Install Oracle Data Integrator Studio client in either 
Linux or Windows machines to connect to the target database. 

4. In the Oracle Data Integrator Studio, navigate to Topology > Agents > OracleDIAgent.

5. Right-click OracleDIAgent and click Test to test the connectivity of the configured Oracle 
Data Integrator Java EE agent. 

Installing Oracle Utilities Analytics Administration Component
Oracle Utilities Analytics Administration Tool is an Oracle Application Express (APEX) based 
configuration tool used to configure Oracle Utilities Analytics.

This section describes how to install the tool to configure Oracle Utilities Analytics and change 
the default password of the Admin user.

• Installation Steps

• Changing Default Password of the Admin User

Note: Install Oracle Utilities Analytics Administration component on the 
Oracle Utilities Analytics database server.

Installation Steps
To install the Oracle Utilities Analytics Administration Tool: 

1. Download Apex 18.2 to the database server under the /temp directory. Unzip the file.

cd /temp/apex

2. Connect to the Oracle Utilities Analytics database as the sys user and execute the following 
commands: 
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@apxrtins.sql <Tablespace name> <Tablespace name> <Temp Tablespace 
name> /i/

Example: @apxrtins.sql CISTS_01 CISTS_01 TEMP /i/

@apxchpwd.sql
ALTER USER APEX_PUBLIC_USER ACCOUNT UNLOCK;
ALTER USER APEX_PUBLIC_USER IDENTIFIED BY APEX_PUBLIC_USER;
@apex_rest_config.sql

Note: Ensure to note down the passwords for APEX_Listener user and 
APEX_REST_PUBLIC_USER.

3. Import the tool to configure Oracle Data Integrator: 

a. Unzip the Oracle Utilities Analytics V2.7.0.1 Multiplatform.zip file. The file includes 
the AdminTool folder. 

b. Create the ../AdminTool directory on the database server and copy the contents of the 
AdminTool directory (from the zip file) to this directory. 

c. Navigate to the ../AdminTool directory. (cd ../AdminTool). 

d. Connect as the sys user and execute the following scripts:

• To create workspace and configure the users: 
@CreateAppWorkspace.sql

• To import application: 
@DeployAdminApp.sql

• To deploy supporting objects: 
@DeploySupportingObjects.sql

4. Download Apex 18.2 to the server where you want to set up the tool (under /scratch/
bi_oradata_01/Softwares/apex_18.2 directory).

Note: Create /scratch/bi_oradata_01/Softwares/apex_18.2 directory if it does 
not exist.

5. Download Oracle Rest Data service 18.3.0 to the server where you want to set up the 
Administration Tool (under /scratch/bi_oradata_01/Softwares/apex_listner directory).

Note: Create /scratch/bi_oradata_01/Softwares/apex_listner directory if it 
does not exist.

6. Navigate to the scratch/bi_oradata_01/Softwares/apex_listner directory and unzip the ords-
18.3.0.270.1456.zip file. 

cd /scratch/bi_oradata_01/Softwares/apex_listner

7. Create a directory on the server to configure Apex. 

For example: mkdir/scratch/bi_oradata_01/apex_configuration

8. Navigate to the /scratch/bi_oradata_01/Softwares/apex_listner directory:

cd /scratch/bi_oradata_01/Softwares/apex_listner

9. Execute the following command: 

java -jar ords.war install advanced

Note: Use JDK1.8 to execute the command.
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Provide the necessary inputs as shown below:

10. Navigate to the /scratch/bi_oradata_01/Softwares/apex_listner directory: 

cd /scratch/bi_oradata_01/Softwares/apex_listner

11. Execute the following command: 

java -jar ords.war static /scratch/bi_oradata_01/Softwares/
apex_5.0.4/apex/images

Note: The command creates i.war file. 

12. Create the WebLogic domain.

a. Navigate to <Middleware Home>/Weblogic_12.2.1.3_Home/oracle_common/
common/bin. 

cd <Middleware Home>/Weblogic_12.2.1.3_Home/oracle_common/
common/bin

b. Execute the following command: 

./config.sh

The Fusion Middleware Configuration Wizard window appears. 
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a. Select Create a new WebLogic domain and click Next. 

b. Provide the domain name.

Ensure you do not change the domain location. 

Click Next.
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c. Provide the WebLogic User Password. Ensure you make a note of the password. 

Click Next. 

d. Select jdk1.8 and click Next. 

e. On the Advanced Configuration tab, select Administration Server and Topology 
options. Click Next. 
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f. On the Administration Server tab, provide the available port as Listen Port. Click 
Next. 

i. On the Managed Servers tab, click Add and provide values as shown below. Click 
Next. 

j. Click Next on the Clusters, Server Templates, Machines, Virtual Targets and 
Partitions tabs respectively. There are no changes to these pages. 

k. On the Configuration Summary page, click Create.

13. Create the boot.properties file. 

14. Start the Admin and Managed server.



Installation Steps

Installing Oracle Utilities Analytics - Initial Installation 4-31
Oracle Utilities Analytics Installation Guide

15. Login to WebLogic console and click Lock & Edit.

16. Click Install.

17. Enter the following path and then select the ords.war file.

/scratch/bi_oradata_01/Softwares/apex_listner

18. Click Next. 

19. Select the apex server check box and click Next.
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20. Select the options as shown in the figure below: 

21. Select the options as shown in the figure below:

22. Click Activate Changes.

23. Repeat the steps 13 to 20 to deploy the i.war file. 

24. Login to the WebLogic console and navigate to Deployment > Monitoring. 
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25. Select i and ords. Click Start > Servicing All Requests.

26. Click Yes.

27. Restart the Admin and Managed servers.

28. Access the Administration Tool from the following URL. 

http://<hostname>:<managed server port no>/ords/f?p=104

The credentials to access the tool are: 

User ID: Admin
Password: Admin_123

Changing Default Password of the Admin User
This section describes the APEX API used to change the password of the admin user. The script 
should be run after connecting to the database as user SYSTEM.

Replace the string 'New password' with the new password for the admin account before running 
the script. 

http://<hostname>:<managed server port no>/ords/f?p=104
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begin
  
wwv_flow_api.set_security_group_id(p_security_group_id=>nvl(wwv_fl
ow_application_install.get_workspace_id,2090606133849294));
end;
/
begin
apex_util.edit_user(
p_user_id      => '2090514487849294',
p_user_name => 'ADMIN',
p_web_password => 'New password',
p_new_password => 'New password'
);
end;
/

commit;
/

Note: It is strongly recommended to change the default password after logging 
in.

Installing Oracle Utilities Analytics Dashboards Component
Note: Ensure that the same Operating System (OS) user to install the 
prerequisite software is used to install the Oracle Utilities Analytics Dashboards 
component as well. 

The Oracle Utilities Analytics Dashboards component is installed on the Oracle Utilities Analytics 
application server. This section describes how to install the dashboards component of Oracle 
Utilities Analytics. 

Make sure you have already run the RCU and created and configured domain before proceeding 
with running the installer.

Note: Install OBIEE with samples during installation and during domain 
creation, select Oracle Sample Application (SampleAppLite) on the Initial 
Application panel. 

• Copying and Decompressing Install Media

• Starting the Installer

• Installation Steps

• Deploying the Repository (RPD) File

• Deploying Web Catalog

• Configuring and Deploying the MapViewer

• Updating MapViewer Configuration

• Enabling WriteBack

• Enabling Auto Complete Feature in OBIEE

Copying and Decompressing Install Media
To download and decompress the install media:

1. Download the Oracle Utilities Analytics Dashboards component v2.7.0.1 (Oracle Utilities 
Analytics V2.7.0.1 Multiplatform.zip) from the Oracle Software Delivery Cloud (https://
edelivery.oracle.com).

https://edelivery.oracle.com
https://edelivery.oracle.com
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2. Create a temporary directory, such as /OUA/temp (referred to <TEMPDIR> below). 

This directory must be located outside any current working Oracle Utilities application 
environment. All files that are placed in this directory as a part of the installation can be 
deleted after completing a successful installation. 

3. Unzip Oracle Utilities Analytics V2.7.0.1 Multiplatform.zip to <TEMPDIR>. 

Starting the Installer
For an AIX Operating System, set the following environment variable before starting the Oracle 
Utilities Analytics installation: 

export IBM_JAVA_OPTIONS=”-Xmx2g  -XX:PermSize=64m -
XX:MaxPermSize=3200m”

To start the installer: 

1. Navigate to the temporary folder where you downloaded the install. Run the following 
command from the folder: 

java -jar <TEMPDIR>/OUA_2.7.0.1.0_generic.jar -logLevel finest

Note: The minimum JDK required for running the Oracle Utilities Analytics 
installer is JDK 1.8. 

2. On the Welcome page, review the information before you begin the installation.

3. Click Next to continue with the installation. 

4. Complete the installation by following the tasks on the navigation pane. 

Each item in the navigation pane represents a specific installer screen that prompts you for 
the information required to install the software. 

Installation Steps
To install the Dashboards component: 

1. Run the Oracle Utilities Analytics Installer. 

2. On the Welcome page, review the available information before you begin the installation.

3. On the Installation Inventory page, provide the inventory location. Click Next. 

4. On the Languages Selection page, make sure to select “English”. Click Next to proceed.

5. On the Installation Location page, define the Installation Location and click Next. 

Note: The specified Oracle home directory must be an empty directory or a 
directory where the OUA ODI ETL 2.7.0.1 component was installed 
successfully.

6. On the Installation Type page, select Dashboards and click Next. 

Note: Based on the selected installation type, the options on the left navigation 
panel change. When you select Dashboard as an Installation Type, you need 
to define Database and Java Home Details, Target Database Connection 
Details and OBIEE Home Details. 
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7. On the Database and Java Home Details page, enter the following details in the respective 
fields and click Next. 

8. On the Target Database Connection Details page, enter the following details in the 
respective fields and click Next. 

9. On the OBIEE Home Details page, enter the following details in the respective fields and 
click Next. 

Field Name Description Value

Database Client Home Database client home location Example:

/u01/app/product/18.3/
dbhome_1

Java Home JDK home location JDK 1.8 location
Example:

/u01/jdk_1.8.0_201

Field Name Description Value

Host The host name of the server 
where the database resides.

Oracle Utilities Analytics 
Database Server

Port The database port number on 
the database server used for 
connecting to the database.

Oracle Utilities Analytics 
Database Port. The default value 
is 1521.

Service Name The service name for the 
database

Target Schema 
Password

The password for the target 
schema (DWADM).

Confirm Target 
Schema Password 

Confirm the password for the 
target schema (DWADM) 
here.

Metadata Schema 
Password

The password for the 
metadata schema (MDADM).

Confirm Metadata 
Schema Password

Confirm the password for the 
metadata (MDADM) schema 
here.

Field Name Description Value

BI Home The location on the disk 
where OBIEE is installed.

Example:

/u01/ Middleware/
FMW_12.2.1.3_Home/
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Note: You will be prompted for the Weblogic user’s password after installation. 

10. On the Java Home Location page, provide the same Java Home details provided earlier. 
Click Next. 

11. On the Installation Summary page, verify the installation options and click Install to begin 
the installation. 

For any changes to the configuration before starting the installation, use the navigation pane 
and select the topic to edit. 

12. The Installation Progress page appears allowing you to see the progress of the installation. 
Operations being performed as part of the installation are logged to the terminal from which 
the installer was run. Detailed logs of the installation are also available in the logs/system 
directory under the installation location.

To quit before the installation is complete, click Cancel. It results in a partial installation; the 
portion of the software that was installed on the system before clicking Cancel will remain on 
the system and it needs to be deleted manually. 

13. On the Installation Completed page, click Finish to close the installer. 

The Dashboards component is installed successfully. 

Deploying Web Catalog
Take the backup of existing BI Publisher reports from the catalog location. After the deployBAR 
step is completed successfully, copy the BI Publisher reports (for which backup was taken) to the 
location of the catalog. 

To deploy the web catalog: 

1. Go to the <DOMAIN_HOME>/bidata/service_instances/ssi/metadata/content/catalog/
root/shared directory. 

BI Domain Home The domain Home location 
under the directory where 
OBIEE is installed.

Example:

/u01/ Middleware/ 
FMW_12.2.1.3_Home/
user_projects/domains/
bifoundation_domain

WebLogic Host The hostname on which 
WebLogic server for OBIEE 
is running.

WebLogic Port 
Number

A unique port number within 
the system that is assigned to 
the HTTP port. 

This port number is used as a 
part of the client URL request 
to connect to the host. It is 
the OBIEE WebLogic 
console admin port number. 

Example: 9500

WebLogic User WebLogic domain login user 
name. 

Field Name Description Value
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2. Delete the existing catalogs (if any) that were delivered out of the box with Oracle Utilities 
Analytics in the previous release. 

Ensure any custom catalog related files in this directory are backed up in a separate location 
before running deployBar.sh.

If Oracle Utilities Network Management System BI Publisher reports were deployed they 
should be retained. 

3. Follow the steps as below for UNIX:

a. Navigate to <Install_Dir>/bin directory. 

cd <Install_Dir>/bin

b. Add Java 8 to the path variable as shown in example below. 

export PATH=/scratch/softwares/jdk1.8.0_201/bin:$PATH

c. Run ksh ./deployBAR.sh.

The web catalog is successfully deployed. 

For an AIX operating system, after the deployBAR.sh is completed successfully, execute the 
following command: 

cp -r ../writeback/wbtemplates/* $DOMAIN_HOME/bidata/
service_instances/ssi/metadata/content/msgdb/l_en/customMessages

Deploying the Repository (RPD) File
Take the RPD file from the following location, where <install_dir> is the Oracle Utilities 
Analytics Dashboard Component installation directory:

<install_dir>/Reports/rpd/ UtilitiesBusinessAnalytics.rpd

Note: If you are using the default Oracle Utilities Analytics repository, you 
must change the default password the first time you open it in the 
Administration Tool. 

To deploy the RPD file: 

1. Ensure Oracle Business Intelligence Developer Client Tool (12.2.1.4.0) is installed on the 
Windows machine before proceeding. 

2. Click Start > Programs > Oracle Business Intelligence > Administration. 

3. Click File > Open > Offline... to open the RPD in offline mode.

4. Provide the RPD password. The default password is “oracle123”. 
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5. Double-click the Connection Pools to edit them. 

• In the Init Block Connection Pool group, enter the following: 

Datasource name = BI Database name

User name = DWREAD

Password = DWREAD User password

• In the Init Block Pool - MDM group, provide the following (only for Oracle Utilities 
Meter Data Management): 

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

• In the Materialized Views Connection group, enter the following:

Datasource name = BI Database name

User name =DWREAD

Password = DWREAD User password 

• In the MDM Database Connection group, provide the following (only for Oracle 
Utilities Meter Data Management): 

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

• In the NMS Replication Tables group, provide the following (only for Oracle Utilities 
Network Management System): 

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password
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Note: The default schema name is NMS1REP. If the replication schema name is 
different, then rename.

• In the ODIDEV Connection Pool group, provide the following: 

Datasource name = BI database name

User name = DWUSER

Password = DWUSER User password

• In the OUBI Database Connection group, provide the following: 

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password

6. Click Save. 

Note: Click Yes when you see the prompt 'Do you wish to check global consistency?' 
and ignore any warnings that appear after consistency check is complete. 

7. Copy the modified RPD back to the <install dir>/Reports/rpd/
UtilitiesBusinessAnalytics.rpd where <install_dir> is the Oracle Utilities Analytics Dashboard 
Component installation directory.

8. Login to the server where OBIEE is installed. 

9. Navigate to <OBIEE DOMAIN>/bitools/bin.

10. Run the following command to deploy the RPD: 

In Unix: 
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./datamodel.sh uploadrpd -I <OUA home>/Reports/rpd/
UtilitiesBusinessAnalytics.rpd -W <rpd password, default 
password is oracle123> -U <Weblogic user name of OBIEE domain> -
P <Weblogic password of OBIEE domain> -SI ssi 

11. Run the following commands from <OBIEE DOMAIN>/bitools/bin directory to stop and 
start the OBIEE domain services respectively. 

./stop.sh 

./start.sh 

Configuring and Deploying the MapViewer 
Configuring and deploying the MapViewer involves the following tasks: 

• Configuring the MapViewer

• Modifying instanceconfig.xml

• Updating MapViewer Configuration

Configuring the MapViewer 
To configure the Mapviewer: 

1. Login to the WebLogic console. 

2. Create the 'MAP_DS' datasource. 

3. Lock and edit it. 

4. Navigate to Services > Data Sources. 

5. Select New > Generic Data Source and provide the following: 

Name = MAP_DS

JNDI Name = MAP_DS 

Database Type = oracle

6. Click Next.

7. Enter the following: 
Database Driver = *Oracle’s Driver (Thin) for Service connections; Versions:Any

8. Click Next. 

9. On the next page, do not change any values. Click Next.

10. Enter the following connection properties: 

• Database Name: BI Database Name 

• Host Name: Database host 

• Port: Database port

• Database User Name: dwadm

• Password: dwadm password

11. Click Next.

12. On the next page, click Test Configuration. After the successful test, click Next again. 

13. On the Select Target page, select AdminServer under Servers and bi_cluster under 
Clusters. Click Finish. 

14. Click Activate Changes. 
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15. Update the mapViewerConfig file with the tags mentioned below: 

File location: <Install Dir> 
/user_projects/domains/<obiee_domain>/config/fmwconfig/mapviewer/conf 

File: mapViewerConfig.xml 

16. If there is a proxy used, insert the list of host names for all the third-party service providers in 
the security_config node. 

<proxy_enabled_hosts>
elocation.oracle.com
</proxy_enabled_hosts>

17. Add the following ns_data_provider node: 

<ns_data_provider id=”obieeNsdp" 
class="com.oracle.utilities.birdseye.BirdseyeNSDP” />

18. Add the current map_tile_server with the following map_tile_server node: 

<map_tile_server>
<tile_storage default_root_path=”/mytilecache/”/>
</map_tile_server>

Modifying instanceconfig.xml 
Ensure you take a backup before updating the instanceconfig.xml file. Run the following 
commands in UNIX to go to the directory containing the instanceconfig.xml file. 

In Unix: 

<OBIEE_INSTALL_DIR>/user_projects/domains/<obiee_domain>/config/
fmwconfig/biconfig/OBIPS

Perform the following changes to the instanceconfig.xml file: 

1. Update the security node with the following values. If the security node is not present, add 
the following code before </Serverinstance>: 

<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies>
<CookieDomain />
<CookiePath>/</CookiePath>
</Security>

2. Update the following <ServerInstance> element:

<LightWriteback>true</LightWriteback>

3. Add the following code between the <ServerInstance> </ServerInstance> tags. 

<Prompts> 
<MaxDropDownValues>256</MaxDropDownValues> 
<AutoApplyDashboardPromptValues>true</AutoApplyDashboardPromptValues> 
<AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox> 
<AutoCompletePromptDropDowns> 
<SupportAutoComplete>true</SupportAutoComplete> 
<CaseInsensitive>true</CaseInsensitive> 
<MatchingLevel>MatchAll</MatchingLevel> 
<ResultsLimit>50</ResultsLimit> 
</AutoCompletePromptDropDowns> 
</Prompts>
<SpatialMaps>
<MapViewerAPIV2Enabled>false</MapViewerAPIV2Enabled>
</SpatialMaps>
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Updating MapViewer Configuration
Important! Note that the Mapviewer URL is not accessible in an AIX environment as it is not 
supported. Skip this step in AIX platforms. 

To update the MapViewer configuration: 

1. Login to MapViewer. 

http://<Server>:<port>/mapviewer 

2. To update the MapViewer configuration, navigate to MapViewer > Administration > 
Configuration. 

3. Login to the Mapviewer at this location: 

http://<HOST>:<MANAGERPORT>/mapviewer

4. Add the below code in the mapViewerConfig.xml with the appropriate values: 

<map_data_source name=”mapconn”
jdbc_host=”<DB server name>”
jdbc_sid=”//<DB Service name>”
jdbc_port=”1521”
jdbc_user=”DWADM”
jdbc_password=”!<DWADM user password>” 
jdbc_mode=”thin”
number_of_mappers=”32”
allow_jdbc_theme_based_foi=”true”
/>

5. Click Save and restart.

Enabling WriteBack
To enable the Write Back:

1. Login to Analytics and navigate to Administration > Manage Privileges > WriteBack > 
Write Back to Database. 

2. Click Denied:Authenticated User and select the Granted permission. 

Enabling Auto Complete Feature in OBIEE 
To enable the auto complete feature on OBIEE: 

1. Restart the OBIEE services. 

Note: Refer to OBIEE documentation for detailed instructions on how to start 
and stop OBIEE services.

2. Login to Analytics. 

3. Click WebLogic User (top-most-right section of the page). 

4. From the drop-down menu, select My Account. 

5. On the Preferences tab, set Prompt Auto Complete to ON.

6. Click OK. 

http://<Server>:<port>/mapviewer
http://<Server>:<port>/mapviewer
http://<Server>:<port>/mapviewer
http://<HOST>:<MANAGERPORT>/mapviewer
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Chapter 5
Upgrading Oracle Utilities Analytics from

v2.7.0.0.11

Oracle Utilities Analytics v2.7.0.1 release supports the direct upgrade path from v2.7.0.0.11 to 
v2.7.0.1. This chapter is applicable only to customers upgrading from Oracle Utilities Analytics 
v2.7.0.0.11 to v2.7.0.1. 

To upgrade to Oracle Utilities Analytics v2.7.0.1, you must first upgrade to Oracle Utilities 
Analytics v2.7.0.0.11 if on an earlier version. Ensure all pre-requisites (JDK and ODI) are met 
before beginning the upgrade process.

This chapter describes the procedure to upgrade to Oracle Utilities Analytics v2.7.0.1, including: 

• Pre-requisites

• Upgrading Oracle Utilities Analytics Database Component

• Upgrading Oracle Data Integrator Based ELT Component

• Upgrading Oracle Utilities Analytics Administration Tool Component

• Upgrading Oracle Utilities Analytics Dashboards Component
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Pre-requisites
Upgrading Oracle Utilities Analytics from v2.7.0.0.11 to v2.7.0.1 includes upgrading Oracle Data 
Integrator based source applications (Oracle Utilities Customer Care and Billing, Oracle Utilities 
Work and Asset Management, Oracle Utilities Network Management System, Oracle Utilities 
Mobile Workforce Management, and Oracle Utilities Meter Data Management). 

This section describes the steps to configure Oracle Data Integrator based source applications.

Ensure the required JDK 1.8.0(201) and Oracle Data Integrator 12.2.1.3.0.0 (both infrastructure 
and ODI) are installed on Oracle Data Integrator server. Also, the target OBIEE applications 
should be down.

Follow these steps as part of prerequisites: 

1. Login to Oracle Utilities Analytics ODI server and start the ODI client. 

Note: Oracle Data Integrator Studio 12.2.1.3 is not supported in the AIX and 
Solaris operating systems. Install Oracle Data Integrator Studio client in either 
Linux or Windows machines to connect to the target database. 

cd $ODI_HOME/odi/studio
./odi.sh

2. Stop BI_RUN_ALL. Follow these steps: 

a. Login to Oracle Database Integrator Studio. 

b. Double-click Global/WLS_AGENT and select Inactive.

c. Save the changes. 

3. On the Studio, navigate to the Topology tab. Right-click OracleDIAgent and select 
Upgrade Schedule. 

4. Execute the following query to check if all jobs are complete. 

Note that this is applicable if the source system is Oracle Utilities Customer Care Billing, 
Oracle Utilities Operational Device Management, or Oracle Utilities Network Management 
System. 
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SELECT
*
FROM mdadm.b1_jobs_vw
WHERE status_flg NOT IN ('D', 'E', 'RP');

Note: No rows should be returned from the query mentioned above. If any 
rows are returned, that means jobs are not yet completed. Wait until all the jobs 
are completed.

5. Stop the Oracle Data Integrator admin and managed servers. 

6. Sync all the Oracle GoldenGate processes. 

a. Connect to MDADM schema in the Oracle Utilities Analytics database.

b. Execute the SQL mentioned below to get all the context codes. 

Select CONTEXT_CD from b1_prod_instance where CONTEXT_CD<>'B1';

c. For each context returned by the query, perform the following steps.

a. Connect to the source database corresponding to the context code as sys user.

b. Execute the following command: 

alter system switch logfile

c. Connect to MDADM schema in the Oracle Utilities Analytics database.

d. Execute the SQL mentioned below to get source GoldenGate server and Oracle 
GoldenGate Home on source server. 

select DS_HOST,DS_HOME from b1_server_cfg where 
CONTEXT_CD='<Context_code>'

e. Ensure that the pump processes transfer all the changes to the target server. Lag at 
the Chkpt and Time Since Chkpt should be 0. 

f. On the Oracle Utilities Analytics database server, ensure the replicate processes 
apply all changes for the context code.

• Connect to the MDADM schema in Oracle Utilities Analytics database and 
execute the query below to get the target server and GoldenGate Home details 
on the target server. 

select DS_HOST,DS_HOME, DS_FLAG from b1_server_cfg where 
CONTEXT_CD='B1';

• Connect to the target server and login to the GoldenGate prompt. Execute the 
following commands:

cd <GG_Home >
./ggsci
dblogin userid MDADM,password <MDADM user password> Send 
replicat <Context_codeXX>,status

The current status will be at EOF.

g. Check this for each ‘replicat’ process of the context code. 

h. Ensure all extracts and replicates of all sources are in sync. 

i. Stop replicate processes in the target server. 
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Upgrading Source Applications to be Compatible with Oracle Utilities          
Analytics v2.7.0.1 

The source applications’ databases must be in archive log mode during their upgrade. Oracle 
GoldenGate processes should be up and running on both source and target during the source 
application(s) upgrade. 

Note: After a successful upgrade, do not release the source applications to end 
users. Ensure to stop the source applications, but the source databases should 
be up and accessible. 

Perform the following steps to cleanup the Oracle GoldenGate processes: 

1. Connect to MDADM schema in the Oracle Utilities Analytics database. Execute the SQL 
below to get all the context codes. 

Select CONTEXT_CD from b1_prod_instance where CONTEXT_CD<>'B1';

2. For each context returned by the query:

a. Connect to MDADM schema in the Oracle Utilities Analytics database. Execute the 
SQL below to get the source GoldenGate db server, SID and Oracle GoldenGate host, 
home on source server: 

Select DS_HOST,DS_SID,DS_HOME,CONTEXT_CD,DS_FLAG from 
b1_server_cfg where CONTEXT_CD='<Context_code>'

b. Connect to the source database corresponding to context code as sys user and execute 
the following command: 

alter system switch logfile

c. Ensure that the pump processes transfer all the changes to the target server. Lag at the 
Chkpt and Time Since Chkpt should be zero. 

d. On the source database server, drop all the GoldenGate processes by following these 
steps:

a. Connect to MDADM schema in the Oracle Utilities Analytics database.

b. Execute the following query to get GoldenGate Owner name in the source 
database. 

select SCHEMA_NAME
from MDADM.B1_CONTEXT_CFG_VW
where LSCHEMA_NAME = 'Journal'
and CONTEXT_CD = '<Context_code>';

c. Login to source GoldenGate prompt.

cd <GG_Home>
./ggsci

d. Execute the following commands:

dblogin userid < GoldenGate Owner >,PASSWORD < GoldenGate 
Owner password>
stop <Context_code>*

For example: 
stop CCB1*
delete <Context_code>*

delete CCB1*
Stop mgr



Pre-requisites

Upgrading Oracle Utilities Analytics from v2.7.0.0.11 5-5
Oracle Utilities Analytics Installation Guide

Execute the below commands to unregister extracts from database: 

unregister extract <Context_code>*X database

For example: 

unregister extract CCB1AAX database

Similarly, unregister all model extracts.

Note: Note down the source Oracle GoldenGate context_codes of each 
source and source Oracle GoldenGate Owner info. They will be used to 
configure the existing sources with same context during the upgrade. 

e. Connect as a sys user to the source database server. Execute the following command: 

<GG_Home>/ddl_disable.sql

f. Rename the existing source Oracle GoldenGate Home on the source server. 

Note the GoldenGate manager port number and source GoldenGate home before 
renaming it. 

For example: mv <GG_Home> <GG_Home>.bkp

g. On the Oracle Utilities Analytics database server, ensure the replicate processes apply all 
changes for the context code. 

a. Connect to MDADM schema in the Oracle Utilities Analytics database. Execute the 
below query to get the target server and GoldenGate Home details on the target 
server. 

select DS_HOST,DS_HOME,DS_FLAG from b1_server_cfg where 
CONTEXT_CD='B1';

b. Connect to the target server and login to the GoldenGate prompt. Execute the 
following commands:

cd <GG_Home >

./ggsci
Dblogin userid MDADM,password <MDADM user password> 

c. Check each replicate process for the context code and ensure replicate processes 
completed writing all the changes. 

d. After checking the current status and each replicate process for the context code, 
execute the following commands: 

Stop <Context_code>*

Example:

stop CCB1*

Delete <Context_code>*

Example:

delete CCB1*

3. After all source applications’ changes are in sync in the Oracle Utilities Analytics database, 
execute the following command after connecting to the target GoldenGate Home prompt. 

./ggsci
Stop mgr

4. Rename the existing target GoldenGate Home directory. 
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Note the GoldenGate manager port number and target GoldenGate Home before renaming 
it.

5. Upgrade the source application databases. 

If the source database version is prior to 11.2.0.4, then upgrade to 11.2.0.4 or a later version.

To summarize, a successful Oracle Data Integrator installation involves installing/applying the 
following: 

• JDK1.8.0(201) 

• Oracle Fusion Middleware Infrastructure 12.2.1.3

• Oracle Data Integrator 12.2.1.3

Installing Oracle Fusion Middleware Infrastructure
Note that the Oracle Home path provided in the Installation Location page is used while 
installing the Oracle Data Integrator.

The infrastructure installation type is ‘Fusion Middleware Infrastructure’. 

During the Oracle Data Integrator 12.2.1.3 installation, provide the same ‘Oracle Home’ path 
used as Oracle Home while installing Oracle Fusion Middleware Infrastructure. Select Enterprise 
Installation on the Installation Type page. 

Upgrading Oracle Utilities Analytics Database Component 
This section describes the steps included to upgrade the Oracle Utilities Analytics database 
component: 

• Copying and Decompressing the Install Media

• Creating Users and Tablespaces

• Installing RELADM Schema

• Installing MDADM Schema

• Installing DWADM Schema

Before proceeding with upgrading the Oracle Utilities Analytics Database component, ensure the 
following are complete: 

• Upgrading Oracle Utilities Analytics database to v18.3 

• Installing Oracle GoldenGate 18.1 on Oracle Utilities Analytics database server. 

Copying and Decompressing the Install Media
To copy and decompress the install media: 

1. Download Oracle Utilities Analytics v2.7.0.1 Oracle Database part (Oracle Utilities 
Analytics V2.7.0.1 Oracle Database Multiplatform.zip) from Oracle Software Delivery 
Cloud (https:// edelivery.oracle.com). 

2. Create a temporary directory (such as /OUA/temp for a Linux machine). 

This directory (referred to as <TEMPDIR> below) must be located outside any current 
working Oracle Utilities application environment. All files that are placed in this directory as a 
part of the installation can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Analytics V2.7.0.1 Oracle Database Multiplatform.zip to 
<TEMPDIR> using any zip utility. 

https:// edelivery.oracle.com
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Creating Users and Tablespaces
To create users and tablespaces follow these steps: 

1. Ensure to create users in the database with the following names without giving specific roles 
(if these do not exist already): 

DWADM, DWUSER, DWREAD, MDADM, RELADM, OUA_MASTER, OUA_WORK 
and DWSTAGE

2. Connect as sys user and revoke the DBA privilege from the following users (if the DBA 
privilege has been granted to them): 

DWADM,MDADM,RELADM,OUA_MASTER, OUA_WORK and DWSTAGE

3. Ensure to create roles with the following names (if these do not exist already). 
 
DW_USER, DW_READ, DW_REPLICATE and DW_PRIVS_ROLE 

4. Connect as sys user and execute the Usersgrants.sql in <TEMPDIR>/BI2701/Scripts/
Usersgrants.sql. 

Note: <TEMPDIR> is the location where the database contents are unzipped.

This SQL provides the required grants to the created users.

Installing RELADM Schema 
The RELADM schema is a metadata schema that consists of the database objects used for storing 
the product version and component installation information.

This section describes the RELADM schema initial installation, including: 

• Reviewing the Storage.xml file

• Installation Steps

• Generating Database Statistics

Reviewing the Storage.xml file
The storage.xml file (that comes with the product and is in location <TEMPDIR>/BI2701/
RELADM/Install- Upgrade) allocates all the base tables and indexes to the default tablespace 
CISTS_01. 

If you decide to allocate some tables or indexes outside of the default tablespace, then this has to 
be reflected in the storage.xml file by changing the tablespace name from the default value to a 
custom value. 

Note: If database does not have CISTS_01 tablespace or the RELADM user 
does not have quota on CISTS_01 tablespace, edit the Storage.xml file to 
indicate the correct tablespace name on which RELADM has quota.

Installation Steps
Note: Ensure to copy/paste the commands into Notepad. Check for any 
special characters and extra spaces. If any, delete them and enter the respective 
characters manually. This helps to avoid any errors at run time.

In Unix: 

1. Add Java 8 to the path variable as shown in example below: 

export PATH=/scratch/softwares/jdk1.8.0_201/bin:$PATH
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2. Set classpath pointing to OraDBI.jar and all dependency jars.

export CLASSPATH=<TEMPDIR>/BI2701/RELADM/Jarfiles/*

3. Run OraDBI.jar as shown below: 

java com.oracle.ouaf.oem.install.OraDBI -d 
jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/<ORACLE SERVICE 
NAME>,RELADM,<Password of RELADM User>,,,,,RELADM -l 1,2 -o -q true

The utility creates the RELADM schema and system data definitions. If an error occurs while 
executing an SQL or another utility, it logs and displays the error message and allows you to re-
execute the current step.

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects:

Connect as sys user and execute the following command: 

execute DBMS_STATS.GATHER_SCHEMA_STATS('RELADM');

Installing MDADM Schema
The MDADM schema is a metadata schema that consists of the database objects used for storing 
the metadata of Oracle Utilities Analytics. 

For example: ETL job execution status, target tables for ETL, Oracle GoldenGate configuration 
details, etc.

This section describes the MDADM schema initial installation, including: 

• Reviewing Storage.xml File

• Installation Steps

• Generating the Database Statistics

Reviewing Storage.xml File 
The storage.xml file (comes with the product and is in location <TEMPDIR>/BI2701/
MDADM/Install- Upgrade) allocates all the base tables and indexes to the default tablespace 
CISTS_01. If you decide to allocate some tables or indexes outside of the default tablespace, then 
this has to be reflected in the storage.xml file by changing the tablespace name from the default 
value to a custom value.

Note: If the database does not have CISTS_01 tablespace or the MDADM 
user does not have quota on CISTS_01 tablespace, you must edit the 
Storage.xml file to indicate the correct tablespace name on which MDADM has 
quota.

Installation Steps
Important! Make sure to copy/paste the commands into Notepad. Check for any special 
characters and extra spaces. If any, delete them and enter the respective characters manually. This 
helps to avoid any errors at run time. 

To install the MDADM schema: 

• In Unix: 

1. Add Java 8 to the path variable as shown in example below: 

export PATH=/scratch/softwares/jdk1.8.0_201/bin:$PATH



Installing DWADM Schema

Upgrading Oracle Utilities Analytics from v2.7.0.0.11 5-9
Oracle Utilities Analytics Installation Guide

2. Set classpath pointing to OraDBI.jar and all dependency jars.

export CLASSPATH=<TEMPDIR>/BI2701/MDADM/Jarfiles/*

3. Run OraDBI.jar as shown below: 

java com.oracle.ouaf.oem.install.OraDBI -d 
jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/<ORACLE 
SERVICE NAME>,MDADM,<Password of MDADM User>,,,,,MDADM -l 1,2 -
o -q true

The utility creates the MDADM schema and system data definitions.

If an error occurs while executing an SQL or another utility, it logs and displays the error message 
and allows you to re-execute the current step.

Generating the Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects. 

Connect as sys user and execute the following command: 

execute DBMS_STATS.GATHER_SCHEMA_STATS('MDADM');

Installing DWADM Schema 
The DWADM schema contains star schema objects (such as facts and dimensions) that include 
entire data in the data warehouse. 

This section describes the DWADM schema initial installation, including: 

• Reviewing Storage.xml File

• Installation Steps

• Generating Database Statistics

Reviewing Storage.xml File
The storage.xml file (comes with the product and is in location <TEMPDIR>/BI2701/
DWADM/Install-Upgrade) allocates all the base tables and indexes to the default tablespace 
CISTS_01. If you decide to allocate tables or indexes outside of the default tablespace, then this 
has to be reflected in the storage.xml file by changing the tablespace name from the default value 
to a custom value.

Note: If the database does not have CISTS_01 tablespace or the DWADM 
user does not have quota on CISTS_01 tablespace, you must edit the 
Storage.xml file to indicate the correct tablespace name on which DWADM has 
quota.

Installation Steps
Important! Make sure to copy/paste the commands into Notepad. Check for any special 
characters and extra spaces. If any, delete them and enter the respective characters manually. This 
helps to avoid any errors at run time. 

To install the DWADM schema: 

• In Unix: 

1. Add Java 8 to the path variable as shown in example below: 

export PATH=/scratch/softwares/jdk1.8.0_201/bin:$PATH
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2. Set classpath pointing to OraDBI.jar and all dependency jars.

export CLASSPATH=<TEMPDIR>/BI2701/DWADM/Jarfiles/*

3. Run OraDBI.jar. 

java com.oracle.ouaf.oem.install.OraDBI -d 
jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/<ORACLE 
SERVICE NAME>,DWADM,<Password of DWADM 
User>,DWUSER,DWREAD,DW_USER,DW_READ,DWADM -p <Password of 
DWUSER>,<Password of DWREAD> -l 1,2 -o -q true

The utility creates the DWADM schema and system data definitions. 

If an error occurs while executing an SQL or another utility, it logs and displays the error message 
and allows you to re-execute the current step.

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects. 

Connect as sys user and execute the command: 

execute DBMS_STATS.GATHER_SCHEMA_STATS('DWADM');

Upgrading Oracle Data Integrator Based ELT Component
This section describes the steps included to upgrade the Oracle Data Integrator based ELT 
component: 

• Prerequisites for Running Oracle Utilities Analytics Installer

• Setting up Oracle GoldenGate

• Copying and Decompressing Install Media

• Starting the Installer

• Upgrade Steps

• Configuring Source Applications

• Upgrading Oracle Utilities Analytics Administration Tool Component

Before proceeding with upgrading the Oracle Utilities Analytics based ELT component, ensure 
the following are complete: 

• Installing JDK1.8.0(201)

• Installing Oracle Data Integrator 12.2.1.3.0.0 (both infrastructure and ODI) 

Prerequisites for Running Oracle Utilities Analytics Installer 
Before running the Oracle Utilities Analytics installer, take a backup of the customized views and 
recreate them manually after upgrading Oracle Utilities Analytics to v2.7.0.1. 

Setting up Oracle GoldenGate
This section describes the following: 

• Setting up Oracle GoldenGate on Source Database Server

• Setting up Oracle GoldenGate on Target Database Server

• Setting up Oracle GoldenGate Monitor JAgent on Target and Source Database Servers
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Setting up Oracle GoldenGate on Source Database Server
Before proceeding, start the source database and ensure it is accessible. Bring down the source 
application server. 

To set up each source instance: 

1. Create a directory on the source database server. (For example: ../GoldenGate Home). and 
install Oracle GoldenGate in that directory. It is Oracle GoldenGate home (OGG_Home) on 
the source database server.

Note: Note this directory location; it is used during the Oracle Utilities 
Analytics installation.

2. Install Oracle GoldenGate. 

Download Oracle GoldenGate 18.1 from Oracle Software Delivery Cloud (https:// 
edelivery.oracle.com). 

For installation instructions, refer to the respective installation documentation at https://
docs.oracle.com/en/middleware/goldengate/core/18.1/index.html. 

3. Provide the Oracle GoldenGate Home location as the directory location created in the step 1.

4. Open a command terminal or window, and set the source ORACLE_SID and 
ORACLE_HOME variables. 

5. Set the LD_LIBRARY_PATH. 

In Unix: 

export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH

6. In the Command window, change directory to the Oracle GoldenGate home directory, and 
execute the following command: 

In Unix: 

./ggsci

The Oracle GoldenGate prompt is shown. 

7. At the Oracle GoldenGate prompt, execute the following commands in the order listed:

• create SUBDIRS

• start mgr - Starts the Oracle GoldenGate manager process.

• info all - Verifies if the manager process is running. 

• exit - Exits Oracle GoldenGate. 

8. Ensure that the source database is in the archivelog mode.

9. Connect to the source database as sys user and execute the following statements: 

alter database add supplemental log data (primary key) columns; 
alter system set enable_goldengate_replication=TRUE scope=both;

10. In the Command window, navigate to the Oracle GoldenGate home (OGG_Home) 
directory. 

11. Open the GOBALS file in the directory and add the below command: 

EnableMonitoring

12. Navigate to the Oracle GoldenGate home (OGG_Home) directory. 

https:// edelivery.oracle.com
https:// edelivery.oracle.com
http:// docs.oracle.com/goldengate/1212/gg-winux/index.html
http:// docs.oracle.com/goldengate/1212/gg-winux/index.html
http:// docs.oracle.com/goldengate/1212/gg-winux/index.html
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13. Connect to the database as sys user using SQL*Plus. 

Ensure OGG_Home to be the current directory while invoking SQL*Plus. 

14. Create a new user. 

For example: ODM01SRC 

This user is the Oracle GoldenGate owner. Ensure to assign a tablespace to this user that is 
not assigned to any other user. 

Note: Ensure to note down the Oracle GoldenGate Owner Username. It is 
used in the Oracle Utilities Analytics installation.

15. Connect to the source database as sys user. 

16. Execute the following commands: 

Note: Ensure to modify the GoldenGate owner placeholder with actual name 
of the database user created in step 14. 

grant CREATE SESSION,CONNECT,RESOURCE,ALTER SYSTEM to <GoldenGate 
Owner>;
grant unlimited tablespace to <GoldenGate owner> with admin option;
EXECUTE dbms_goldengate_auth.grant_admin_privilege('<GoldenGate 
Owner>','capture');
grant unlimited tablespace to <GoldenGate Owner> with admin option;
Revoke dba from <GoldenGate Owner>;
grant create any view to <GoldenGate Owner>; grant select any 
dictionary to <GoldenGate Owner>; GRANT CREATE ANY DIRECTORY TO 
<GoldenGate Owner>; GRANT DROP ANY DIRECTORY TO <GoldenGate Owner>;
GRANT EXP_FULL_DATABASE TO <GoldenGate Owner>; GRANT 
IMP_FULL_DATABASE TO <GoldenGate Owner>;

17. Connect to the <source application>ADM schema (such as CISADM). Execute the 
following commands: 

For Oracle Utilities Customer Care and Billing source database, execute the following 
grants:

Grant select on F1_MST_CONFIG to <GoldenGate owner user created in 
step 16>
Grant select on F1_EXT_LOOKUP_VAL to <GoldenGate owner user created 
in step 16>
Grant select on F1_BKT_CONFIG to <GoldenGate owner user created in 
step 16>
Grant select on F1_BKT_CONFIG_VAL to <GoldenGate owner user created 
in step 16>

For Oracle Utilities Operational Device Management source database, execute the 
following grants:

Grant select on F1_MST_CONFIG to <GoldenGate owner user created in 
step 16>
Grant select on F1_EXT_LOOKUP_VAL to <GoldenGate owner user created 
in step 16>

For Oracle Utilities Meter Data Management source database, execute the following 
grants:

Grant select on <application ADM Schema>.F1_MST_CONFIG to 
<GoldenGate Owner>;
Grant select on <application ADM Schema>.F1_EXT_LOOKUP_VAL to 
<GoldenGate Owner>;
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For Oracle Utilities Work and Asset Management source database, execute the following 
grants:

Grant select on <application ADM Schema>. F1_EXT_LOOKUP_VAL to 
<GoldenGate Owner>;
Grant select on <application ADM Schema>.F1_MST_CONFIG to 
<GoldenGate Owner>;
Grant select on <application ADM Schema>. F1_BKT_CONFIG to 
<GoldenGate Owner>;
Grant select on <application ADM Schema>. F1_BKT_CONFIG_VAL to 
<GoldenGate Owner>;

Note: While executing SQL commands in steps 15, 16, and 17, provide the 
GoldenGate owner user (if prompted for). 

All the scripts mentioned below are located in GoldenGate Home directory and 
must be executed after connecting to the database as sys user.

18. Execute the following commands in the order listed below: 

@marker_setup.sql
@ddl_setup.sql
@role_setup.sql

19. Exit SQL*Plus. 

20. In the Command window, create a directory “diroby” in the OGG_Home directory.

21. Change directory to the Oracle GoldenGate Home directory, and execute the following: 

a. Steps in Configuring Encrypting Data Using ENCKEYS Method. 

b. Steps in Generating Shared Secret Password. 

Configuring Encrypting Data Using ENCKEYS Method
To configure for encrypting data using the ENCKEYS method: 

1. Execute the following command:

cd <OGG_HOME>
KEYGEN key_length n

The above command generates the key value based on the value specified in the parameter 
“n”. The key value has to be copied to ENCKEYS file against a logical name.

2. For each key value generated above, provide a logical name (Logical name should not be the 
same for two different key values). Enter the logical name space and then key value in the 
ENCKEYS file. 

3. Repeat the step above for each key values generated. 

4. Save the file with name ENCKEYS (Upper case only) without any extension. 

For example: 

cd $OGG_HOME
./keygen 128 1
0x8CE55035DD6893205A7BD6773FA8E670

5. Open a new ASCII ENCKEYS file if it does not exist for adding a new entry or open an 
existing ENCKEYS text file to append. 

6. Input the Logical name, space and key value generated.

Sample content of file ENCKEYS: 

CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670
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7. The source ENCKEYS file entry has to be appended to the intermediate server or target 
server which would be configured with the source system where target OGG is being 
configured.

Note: It is recommended to name Logical key name after 
<context_code>KEY. 

For example: If context code is CCB1, it is recommended to name it as 
CCB1KEY.

Generating Shared Secret Password
To generate the shared secret password: 

1. Execute the following command:

cd <OGG_HOME>
ggsci
ENCRYPT PASSWORD <GG Owner password> <algorithm> ENCRYPTKEY 
<key_name>

For example: 

cd $OGG_HOME
./ggsci
GGSCI (hostname) 1> ENCRYPT PASSWORD CCB01SRC AES128 ENCRYPTKEY 
CCB1KEY
Encrypted password: 
AADAAAAAAAAAAAIAVGNHBFLGFCHBTCVBFJFHUEJGNCFAOAFEOFBALELISFOEIFWGRB
ZHCCMCYGYBDAZH
Algorithm used: AES128

2. Note the above generated ENCKEYS file logical name/key value, algorithm name used, and 
the generated encrypted password. 

Setting up Oracle GoldenGate on Target Database Server
To set up Oracle GoldenGate on the target database server: 

1. Create a directory on the target database server. 

For example: ../GoldenGateHome 
Oracle GoldenGate should be installed in this directory. It is Oracle GoldenGate home 
(OGG_Home) on the target Oracle Utilities Analytics database server. 

Note: Ensure to note the directory location; it will be used in the Oracle 
Utilities Analytics installation.

2. Install Oracle GoldenGate and provide the GoldenGate Home location as the directory 
location created in the step 1.

3. In the Command window, set the target ORACLE_SID and ORACLE_HOME variables.

Set LD_LIBRARY_PATH using the following commands: 

In Unix:

export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH

4. In the Command window, change the directory to the GoldenGate home directory and 
execute the below command: 

For Unix: 

./ggsci
The Oracle GoldenGate prompt is shown. 
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5. At the prompt, execute the following commands in the order listed below: 

• create SUBDIRS

• start mgr - Starts the Oracle GoldenGate manager process. 

• info all - Verifies if the manager process is running. 

• exit

6. Create a directory “diroby” in the OGG_Home  directory. 

7. Connect to the target database as sys user and execute the below query: 

alter system set enable_goldengate_replication=TRUE scope=both;

8. In the Command window, navigate to the Oracle GoldenGate Home (OGG_Home) 
directory.

9. Edit the GLOBALS file in the <GG home> directory and add the following command.:

EnableMonitoring

10. Navigate to the Oracle GoldenGate home (OGG_Home) directory.

11. If the ENCKEYS file does not exist:

a. Create and open a new ASCII ENCKEYS file.

b. Add the key value/values that are generated on the sources to the ENCKEYS file in 
target OGG home. This is done for the context codes for which source is configured. 

A sample ENCKEYS file in target OGG home is as below: 

CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670

Setting up Oracle GoldenGate Monitor JAgent on Target and Source Database 
Servers

Set up Oracle GoldenGate Monitor JAgent on Oracle Utilities Analytics GoldenGate server and 
on all the source application Oracle GoldenGate servers. The Oracle GoldenGate Monitor JAgent 
is used to automatically copy the generated Oracle GoldenGate scripts to both source and target 
Oracle GoldenGate GoldenGate Home directories, and to start the extract and replicate processes 
on source and target. 

To setup Oracle GoldenGate Monitor JAgent on both target and source database servers: 

1. Ensure Oracle GoldenGate is installed and manager is running. 

2. Start the rmiregistry services using the following command: 

rmiregistry 5559 &

Ensure to note down the port on which RMI server is started. The port number specified 
here is 5559. If it is not specified, the default port 1099 will be used. 

3. Download Oracle GoldenGate Monitor and Veridata 12.2.1.2.0 from Oracle Software 
Delivery Cloud (https://edelivery.oracle.com/osdc/faces/SoftwareDelivery). 

4. Run the Oracle GoldenGate Monitor and Veridata 12.2.1.2.0 installer. 

a. Select the installation type as Oracle GoldenGate Monitor Agent. 

b. Apply patch 26982776 on top of Oracle GoldenGate Monitor agent home before 
creating monitor instance.

5. Edit the Config.properties file in the <Oracle GoldenGate Monitor home>/oggmon/
ogg_agent/cfg_templates and add/modify the below parameters. 

<ACTUAL>   : jagent.host=localhost

https://edelivery.oracle.com/osdc/faces/SoftwareDelivery
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<CHANGE TO> : jagent.host=<<actual hostname on which OGG is 
installed>>

 
<ACTUAL>    : monitor.jmx.username=cmroot
<CHANGE TO> : monitor.jmx.username=jmx_src

<ACTUAL>   : jagent.username=root
<CHANGE TO> : jagent.username=<<OGG software installed OS user>>

<ACTUAL>    : jagent.rmi.port=5559
<CHANGE TO> : jagent.rmi.port=5557 or any free port other than the 
one on which the rmiregistry is started
 
<ACTUAL>    : agent.type.enabled=OGGMON
<CHANGE TO> : agent.type.enabled=OEM
<ACTUAL>    : jagent.backward.compatibility=true

   <CHANGE TO> : jagent.backward.compatibility=false

6. Add the following parameter:

jagent.ssl=false

7. Navigate to <Oracle GoldenGate Monitor home>/oggmon/ogg_agent directory and run 
the following command:

In Unix:

export JAVA_HOME=<JDK home>

./createMonitorAgentInstance.sh

a. You will be prompted to enter: 

• Oracle GoldenGate Home directory. 

• Path to be used for Oracle GoldenGate Monitor Agent instance. 

It is recommended to provide a path (such as <Oracle GoldenGate Monitor 
home>/Agents/OGGMonitorInstance). 

• A unique name to replace the timestamp in the name of the file used to start Oracle 
GoldenGate Monitor agent instance. 

Provide a unique name to be used for this Oracle GoldenGate Monitor instance. 

b. Execute the command below from <path used for Oracle GoldenGate Monitor instance 
provided in the step above>/bin. 

Example location: <OGG Monitor home>/Agents/OGGMonitorInstance/bin

In Unix: 

export JAVA_HOME=<JDK home>
./pw_agent_util.sh -jagentonly

8. Enter the Oracle wallet password. 

This password has to be entered as the password for the JAGENT while running the installer 
(for target gg), and while running the source configuration (for source gg). 

Ensure to note the password and jagent.rmi.port value (JAgent Port). This information is 
required in subsequent installation. 
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9. Create a folder with the Context_code name in <GG Home>/dirdat. 

For example: If WAM2 is created for the WAM source, then create a folder with name 
“WAM2” within the <GG Home>/dirdat/ folder. 

10. Navigate to <GG Home>/dirprm and edit jagent.prm file.

Replace COMMAND java with COMMAND <JDK Home>/bin/java.

This ensures that the correct version of java (1.8) is used while starting JAgent. 

11. Navigate to OGG_Home directory and run the following command at the Oracle 
GoldenGate prompt: 

ggsci

12. Start the jAgent process.

start jagent

Note: Export LIBPATH with jdk,OGG and RDBMS paths to start JAGENT 
in the AIX environment. 

$JAVA_HOME/bin
$OGG_HOME
$RDBMS_HOME/lib

Example:

export LIBPATH=/usr/java8_64/bin:/scratch/bi_oradata_01/
GG_18c_Home:/scratch/gbuora/app/gbuora/product/18.3/dbhome_2/
lib:$LIBPATH

The logs for JAgent are created at the following (example) location. 

<OGG Monitor home>/Agents/OGGMonitorInstance/logs

Copying and Decompressing Install Media
To download and decompress the install media:

1. Download the Oracle Utilities Analytics v2.7.0.1 Multiplatform part (Oracle Utilities 
Analytics V2.7.0.1 Multiplatform.zip) from Oracle Software Delivery Cloud (https://
edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (referred to 
<TEMPDIR> below). This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation. 

3. Unzip Oracle Utilities Analytics V2.7.0.1 Multiplatform.zip to <TEMPDIR>. 

Starting the Installer
For an AIX operating system, set the following environment variable before starting the Oracle 
Utilities Analytics installation: 

export IBM_JAVA_OPTIONS=”-Xmx2g  -XX:PermSize=64m -
XX:MaxPermSize=3200m”

https://edelivery.oracle.com
https://edelivery.oracle.com


Copying and Decompressing Install Media

Upgrading Oracle Utilities Analytics from v2.7.0.0.11 5-18
Oracle Utilities Analytics Installation Guide

To start the Oracle Data Integrator Based ELT component:

1. Navigate to the temporary folder containing the installer. 

2. Run the following command from this folder: 

java -jar <TEMPDIR>/OUA_2.7.0.1_generic.jar -logLevel finest

Note: The minimum JDK required for running the Oracle Utilities Analytics 
installer is JDK 1.8. 

The Welcome page appears. 

3. Review this information before you begin the installation. Click Next to continue with the 
installation. 

4. Complete the tasks on the navigation pane. 

Each item in the navigation pane represents a specific installer screen that prompts you for 
information required to install the software. 

• If you select Oracle Data Integrator Based ETL as an Installation Type, define the 
following:

• Database and Java Home Details

• Target Database Connection Details

• Oracle Data Integrator Home and Schema Details

• Oracle Data Integrator Agent and Repository Details

• Target GoldenGate Details

• Target JAgent Details

Upgrade Steps 
To install Oracle Data Integrator Based ETL: 

1. Run the Oracle Utilities Analytics Installer. Review the information on the Welcome page 
before you begin the installation. 

2. Click Next to continue with the installation. 

3. On the Installation Inventory page, provide the inventory location. Click Next. 

4. On the Installation Location page define an installation location/directory and click Next.

5. On the Languages Selection page, make sure to select “English”. Click Next.

6. On the Select Installation Type page, select ODI Based ETL. Click Next.

Note that the options on the left navigation pane change based on the selected installation 
type. 

7. Select Oracle Data Integrator Based ETL as the Installation Type.

8. Define the following and click Next. 

• Database and Java Home Details

• Target Database Connection Details

• Oracle Data Integrator Home and Schema Details

• Oracle Data Integrator Agent and Repository Details

• Target GoldenGate Details

• Target Jagent Details
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9. On the Database and Java Home Details page, enter the following in the respective fields. 
Click Next.

10. On the Target Database Connection Details page, enter the following in the respective 
fields. Click Next:

11. On the ODI Home and Schema Details page, enter the following in the respective fields. 
Click Next:

Field Name Description Value

Database Client Home The database client home 
location.

Example:
/u01/app/product/18.3/
dbhome_1

Java Home The JDK home location. Provide location of JDK 1.8.

Example: /u01/jdk_1.8.0_201

Field Name Description Value

Host Host name of the server 
where the database resides.

Oracle Utilities Analytics 
Database Server

Port Database port number on the 
database server used for 
connecting to the database.

Oracle Utilities Analytics 
Database Port. The default value 
is 1521.

Service Name Service name for the database

Target Schema 
Password

Password for the target 
schema (DWADM)

Confirm Target 
Schema Password 

Confirm the password for the 
target schema (DWADM) 
here.

Metadata Schema 
Password

Password for the metadata 
schema (MDADM)

Confirm Metadata 
Schema Password

Confirm the password for the 
metadata (MDADM) schema 
here

Field Name Description Value

ODI Home Directory where Oracle Data 
Integrator (ODI) has been 
installed.

Example:
/u01/
12.2.1_FMW_infrastucture_home

Supervisor User Name of the Oracle Data 
Integrator Supervisor.

SUPERVISOR 

Supervisor Password Password of the Oracle Data 
Integrator Supervisor.

SUPERVISOR user password

Confirm Supervisor 
Password

Confirm the password of the 
Supervisor here.
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12. On the ODI Agent and Details page, enter the following details in the respective fields. 
Click Next:

13. On the Target GoldenGate Details page, enter the following details in the respective fields. 
Click Next:

Master Repository 
Schema Name

Oracle Data Integrator master 
repository schema name.

OUA_MASTER

Master Repository 
Schema Password

Password of the master 
repository schema.

OUA_MASTER user's password

Confirm Master 
Repository Schema 
Password

Confirm the password of the 
Oracle Data Integrator master 
repository schema here.

Work Repository 
Schema Name

Oracle Data Integrator work 
repository schema name.

OUA_WORK

Work Repository 
Schema Password

Password of the work 
repository schema.

OUA_WORK user's password

Confirm Work 
Repository Schema 
Password

Confirm the password of the 
Oracle Data Integrator work 
repository schema here.

Field Name Description Value

ODI Agent Host Host on which Oracle Data 
Integrator WebLogic domain 
is created.

Oracle Data Integrator server 
host name.

ODI Agent Port Port on which Oracle Data 
Integrator WebLogic agent is 
configured to run. This is the 
port of Oracle Data 
Integrator WebLogic 
Managed Server Port.

Provide available port and ensure 
to use the same port while 
creating Oracle Data Integrator 
managed server. 

Field Name Description Value

GoldenGate Host Host on the Oracle 
GoldenGate Manager.

GoldenGate Home This is the Oracle 
GoldenGate installed 
location. 

Example: 
/opt/local/ggs_18.1

Field Name Description Value
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14. On the Target JAgent Details page, enter the following details in the respective fields. Click 
Next.

Target Database Home The database home installed 
location on the target database 
server. 

In case Oracle GoldenGate 
for target is not installed on 
the OUA database server, 
provide oracle client home 
location on the server on 
which Oracle GoldenGate is 
installed.

Example: 
/u00/oracle/app/oracle/
product/18.3/dbhome_1

GoldenGate Manager 
Port

Port number on which Oracle 
GoldenGate Manager is 
running on the Oracle 
GoldenGate host.

The default value is 7830

GoldenGate Algorithm Algorithm configured in 
Oracle GoldenGate on the 
target database server.

The default value is BLOWFISH.

GoldenGate 
Encryptkey

The Encrypt Key configured 
in Oracle GoldenGate on the 
target database server. 

The default value is 
“DEFAULT”.

GoldenGate Shared 
Secret

The shared secret key 
configured in Oracle 
GoldenGate on the target 
database server.

Go to the Oracle GoldenGate 
prompt and run the command:

encrypt password 
<password of MDADM 
user>, encryptkey 
DEFAULT 

Provide the result as the value.

Field Name Description Value

JAgent Host The host of Oracle 
GoldenGate Monitor JAgent.

JAgent GoldenGate The Oracle GoldenGate 
installed location where 
Oracle GoldenGate Monitor 
JAgent is running.

Example: 
/opt/local/ggs_18.1

JAgent Port Use the JAgent RMI port 
which is defined in the config 
properties file.

JAgent User OS user used to configure 
JAgent

JAgent Wallet Password JAgent Wallet password

Field Name Description Value
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15. On the Java Home Location page, provide the Java Home details that were provided earlier. 
Click Next. 

16. On the Installation Summary page, verify the installation options you selected. 

17. Click Install to begin the installation. 

To change any configurations before starting the installation, use the navigation pane and 
select the topic to edit. 

The Installation Progress page displays the progress of the installation. Operations being 
performed as a part of the installation are logged to the terminal from which the installer was 
run. The detailed logs of the installation are also available in the logs/system directory under 
the installation location.

To quit before the installation is complete, click Cancel. Doing so will result in a partial 
installation; the portion of the software that was installed on your system before you click 
Cancel will remain on your system, and you will have to remove it manually.

18. On the Installation Completed page, click Finish to close the installer.

The Oracle Data Integrator based ETL is now installed. 

Executing Post-Upgrade Script
Execute the B1_DROP_NMS_WAM_MVS_270012 scenario if either Oracle Utilities Network 
Management System or Oracle Utilities Work and Asset Management source is configured. 

1. Login to ODI Client and navigate to Designer > Load Plans and Scenario folders.

2. Expand Framework > Data correction > B1_DROP_NMS_WAM_MVS_270012.

3. Right-click B1_DROP_NMS_WAM_MVS_270012 and click Run. 

4. Select the appropriate context (Oracle Utilities Network Management System or Oracle 
Utilities Work and Asset Management). 

5. Click OK. 

Creating a Database Directory
Create a database directory 'B1_DATA_DUMP_DIR' on the target database, as well as on each 
source database. This directory is used for logging the export import task used during the initial 
ELT load. 

The following sample SQL creates a database directory pointing to the file system path /scratch/
file_data: 

CREATE DIRECTORY B1_DATA_DUMP_DIR AS '/scratch/file_data';

Configuring Source Applications
This section describes the instructions to be followed to configure source applications.

• Prerequisites

• Configuration Steps

Bring down the source application server, and ensure the source applications are stopped but 
source databases are up and accessible. 

Confirm JAgent Wallet   
Password

Re-enter JAgent Wallet 
password to confirm.

Field Name Description Value
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Prerequisites
Before running the source configuration tool, ensure to do the following: 

• Create the Oracle Data Integrator domain.

• Check if admin and managed servers are running and accessible. 

Configuration Steps
To configure the source applications:

1. Register a source application. 

For instructions to register a source, refer to the Registering a Source section in Chapter 5: 
Configuring Oracle Utilities Analytics in Oracle Utilities Analytics Administration Guide.

2. Ensure to use the same context_codes to configure the existing sources during the upgrade.

3. Run the B1_INITIAL_SETUP_PKG package.

Note: It is recommended to run B1_INITIAL_SETUP_PKG only once (after 
all the sources have been configured or after at least one source is configured). 

a. Login to Oracle Data Integrator Studio. 

b. Navigate to Designer > Load Plans and Scenarios > Framework. 

c. Right-click B1_INITIAL_SETUP_PKG, select GLOBAL context code, and then 
select Run.

4. Start all Oracle GoldenGate processes on source and target: 

a. Login to each source application GoldenGate server.

b. Navigate to the respective Oracle GoldenGate Home directory. 

c. Start manager, JAgent, and all respective context extract processes.

d. Login to the target (Oracle Utilities Analytics) GoldenGate server. 

e. Navigate to the Oracle GoldenGate Home directory. 

f. Start manager, jagent and all respective context extract processes.

Upgrading Oracle Utilities Analytics Administration Tool Component
Oracle Utilities Analytics Administration Tool is an Oracle Application Express (APEX) based 
configuration tool used to configure Oracle Utilities Analytics.

This section describes how to install the tool to configure Oracle Utilities Analytics and change 
the default password of the Admin user. 

• Prerequisites

• Installation Steps

• Changing Default Password of Admin User

Note: Install Oracle Utilities Analytics Administration component on the 
Oracle Utilities Analytics database server. 

Prerequisites
To remove the previously created Apex workspace from database: 

1. Connect to the database as SYSTEM user. 

2. Execute the following PL/SQL procedure. 
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BEGIN 
APEX_INSTANCE_ADMIN.REMOVE_WORKSPACE('OBIU_ADM');
END;
/

3. Make sure no workspace with “OBIU” exists in the database. 

select WORKSPACE from APEX_WORKSPACES where WORKSPACE like 
'%OBIU%';

Note: No rows should be returned from this query. 

4. Uninstall ords from the database. 

5. Remove ords and i.war apps from APEX WebLogic console.

a. Login to APEX WebLogic console. 

b. Navigate to Deployments > Control. 

c. Click Stop and select Force Stop Now. 

d. Click Yes. 

e. On the Configuration tab, click Lock and Edit. 

f. Under Deployments, select both i and ords. 

g. Click Delete. 

h. Confirm deletion and click Activate Changes to activate the changes. 

6. Unistall the existing ords.war from the database.

7. Navigate to the ords.war (ords.3.0.6.178.08.46) file location in server. 

Example: 

cd /scratch/bi_oradata_01/apex_setup/apex_listener 

8. Execute the following command: 

java -jar ords.war uninstall

Note: Use JDK1.8 to execute the command.

Provide the necessary inputs. 

Installation Steps
To install the Oracle Utilities Analytics Administration Tool: 

1. Download Apex 18.2. Copy it to the server where you want to set it up under the /scratch/
bi_oradata_01/Softwares/apex_18.2 directory. 

2. Connect to the Oracle Utilities Analytics database as the sys user and execute the following 
commands: 

EXEC DBMS_XDB.SETHTTPPORT(0);
SELECT DBMS_XDB.GETHTTPPORT FROM DUAL;

This query should result in zero(0).

3. Navigate to the Apex unzipped path and execute the following scripts. Connect to Oracle 
Utilities Analytics database as a sys user. 

@apexins.sql <Tablespace name> <Tablespace name> <Temp Tablespace 
name> /i/
(for example: @apexins.sql CISTS_01 CISTS_01 TEMP /i/)
@apxchpwd.sql
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ALTER USER APEX_PUBLIC_USER ACCOUNT UNLOCK;
ALTER USER APEX_PUBLIC_USER IDENTIFIED BY APEX_PUBLIC_USER;
@apex_rest_config.sql

Make sure to note the password for these two users: APEX_Listener user and 
APEX_REST_PUBLIC_USER. 

4. Import the Admin Tool to configure Oracle Data Integrator. 

a. Unzip the Oracle Utilities Analytics v2.7.0.1 Multiplatform.zip file. The file includes the 
AdminTool folder. 

b. Create ../AdminTool directory on the database server and copy the contents of the 
AdminTool directory (from the zip file) to this directory. 

c. Navigate to the ../AdminTool directory (cd ../AdminTool)

d. Connect as the system user. Execute the following scripts: 

a. Create workspace and configure the users.

@CreateAppWorkspace.sql 

b. Import the application.

@DeployAdminApp.sql 

c. Deploy supporting objects.

@DeploySupportingObjects.sql
5. Download Oracle Rest Data service. Copy it to the server where you want to set it up under 

the ords-18.3.0.270.1456.zip directory.

6. Navigate to the scratch/bi_oradata_01/Softwares/apex_listner directory. Unzip the 
ords.3.0.6.176.08.46.zip file. 

7. Create a directory on the server to configure Apex. 

For example: mkdir/scratch/bi_oradata_01/apex_configuration

8. Navigate to the /scratch/bi_oradata_01/Softwares/apex_listner directory. 

cd /scratch/bi_oradata_01/Softwares/apex_listner

9. Execute the following command: 

java -jar ords.war install advanced

Note: Use JDK1.8 or later to execute this command. 

10. Navigate to the /scratch/bi_oradata_01/Softwares/apex_listner directory: 

cd /scratch/bi_oradata_01/Softwares/apex_listner

11. Execute the following command: 

java -jar ords.war static <apex18.2 unzipped path>/apex/images

For example: java -jar ords.war static /scratch/bi_oradata_01/Softwares/ apex_18.2/apex/
images

Note: The command creates the i.war file. 

12. Install WebLogic 12.2.1.3 with jdk 1.8.0+. 

13. Create the WebLogic domain. 

a. Go to <12.2.1.3_weblogic_home>oracle_common/common/bin directory. 



Upgrading Oracle Utilities Analytics Administration Tool Component

Upgrading Oracle Utilities Analytics from v2.7.0.0.11 5-26
Oracle Utilities Analytics Installation Guide

b. Execute the following command: 

./config.sh

The Fusion Middleware Configuration Wizard window appears. 

a. On the Create Domain tab, select Create a new domain. Click Next.
Do not change the domain location. 

b. On the Template tab, select the template category. Click Next. 

c. On the Administrator Account tab, provide the WebLogic username and password. 
Ensure to note the same. Click Next. 

d. On the Domain Mode and JDK tab, select jdk1.8 and click Next. 
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e. On the Advanced Configuration tab, select Administration Server and Topology 
options. Click Next. 

f. On the Administration Server tab, provide the available ports as Listen Port. Click 
Next. 
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g. On the Managed Servers tab, click Add and provide values as shown below. Click 
Next. 

h. Click Next on the Clusters, Server Templates, Machines, Virtual Targets and 
Partitions tabs respectively. There are no changes to these pages. 

i. On the Configuration Summary tab, click Create to create the domain. 

14. Create boot.properties file. 

15. Start the Admin and Managed server.

16. Login to WebLogic console and click Lock & Edit.

17. Click Install.
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18. Enter the following path and then select the ords.war file.

/scratch/bi_oradata_01/Softwares/apex_listner 

Click Next. 

19. Select the Apex server check box and click Next.

20. Select the options as shown below: 
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21. Select the options as shown below:

22. Click Activate Changes.

23. Repeat the steps 14 to 20 to deploy the i.war file. 

24. Login to the WebLogic console and navigate to Deployment > Monitoring. 

25. Select i and ords. Click Start > Servicing All Requests.
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26. Click Yes.

27. Restart the Admin and Managed servers.

28. Go to the following URL to access the Administration Tool: 

http://<hostname>:<managed server port no>/ords/f?p=104

The credentials to access the tool are: 

User ID: Admin
Password: Admin_123

Changing Default Password of Admin User
This section describes the APEX API used to change the password of the admin user. The script 
should be run after connecting to the database as user SYSTEM.

Replace the string 'New password' with the new password for the admin account before running 
the script. 

begin
wwv_flow_api.set_security_group_id(p_security_group_id=>nvl(wwv_fl
ow_application_install.get_workspace_id,2090606133849294));
end;
/

begin
apex_util.edit_user(
p_user_id      => '2090514487849294',
p_user_name => 'ADMIN',
p_web_password => 'New password',
p_new_password => 'New password'
);
end;
/

commit;
/

Note: It is strongly recommended to change the default password after logging 
in.

http://<hostname>:<managed server port no>/ords/f?p=104
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Upgrading Oracle Utilities Analytics Dashboards Component
Ensure that the same operating system user used to install the prerequisite software is used to 
install the Oracle Utilities Analytics Dashboards component as well. 

The Oracle Utilities Analytics Dashboards component is installed on the Oracle Utilities Analytics 
application server. 

This section describes how to install the dashboards component of Oracle Utilities Analytics. 

• Prerequisites

• Copying and Decompressing Install Media

• Starting the Installer

• Upgrade Steps

• Deploying Web Catalog

• Deploying Repository (RPD) File

• Enabling WriteBack

• Enabling Auto Complete Feature in OBIEE 

Prerequisites
Oracle Utilities Analytics Dashboard component v2.7.0.1 requires Oracle Business Intelligence 
Enterprise Edition version 12.2.1.4.

Note: OBIEE 12.2.1.3 should be upgraded to 12.2.1.4 before proceeding with 
Oracle Utilities Analytics Dashboard component upgrade. 

Refer to OBIEE documentation for details about the upgrade from 12.2.1.3 to 
12.2.1.4. 

Copying and Decompressing Install Media
To download and decompress the install media: 

1. Download the Oracle Utilities Analytics Dashboards component v2.7.0.1 (Oracle Utilities 
Analytics V2.7.0.1 Multiplatform.zip) from the Oracle Software Delivery Cloud (https://
edelivery.oracle.com). 

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (referred to 
<TEMPDIR> below). 

This directory must be located outside any current working Oracle Utilities application 
environment. All files that are placed in this directory as a part of the installation can be 
deleted after completing a successful installation. 

3. Unzip Oracle Utilities Analytics V2.7.0.1 Multiplatform.zip to <TEMPDIR>.

Starting the Installer
For an AIX operating system, set the following environment variable before starting the Oracle 
Utilities Analytics installation. 

export IBM_JAVA_OPTIONS=”-Xmx2g  -XX:PermSize=64m -
XX:MaxPermSize=3200m”

https://edelivery.oracle.com
https://edelivery.oracle.com
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To start the installer: 

1. Navigate to the temporary folder where you downloaded the install. Run the following 
command from the folder: 

java -jar <TEMPDIR>/OUA_2.7.0.1_generic.jar -logLevel finest

Note: The minimum JDK required for running the Oracle Utilities Analytics 
installer is JDK 1.8. 

2. On the Welcome page, review the information before you begin the installation. 

3. Click Next to continue with the installation. 

4. Complete the installation by following the tasks on the navigation pane. 

Each item in the navigation pane represents a specific installer screen that prompts you for 
the information required to install the software. 

Upgrade Steps
To install the Dashboards component: 

1. Run the Oracle Utilities Analytics Installer. 

2. On the Welcome page, review the available information before you begin the installation.

3. On the Installation Inventory page, provide the inventory location. Click Next. 

4. On the Languages Selection page, make sure “English” is selected. Click Next. 

5. On the Installation Location page, provide the installation location and click Next. 

Note: The specified Oracle home directory must be an empty directory or a 
directory where the OUA ODI ETL 2.7.0.1 component was installed 
successfully.

6. On the Installation Type page, select Dashboards and click Next. Enter the following 
details in the respective fields and click Next. 

Note: Based on the selected installation type, the options on the left navigation 
panel change. When you select Dashboard as an Installation Type, you need 
to define Database and Java Home Details, Target Database Connection 
Details and OBIEE Home Details.  

7. On the Target Database Connection Details page, enter the following details in the 
respective fields and click Next. 

Field Name Description Value

Database Client Home Database client home location Example:

/u01/app/product/12.1.0/
dbhome_1

Java Home JDK home location JDK 1.8 location
Example:

/u01/jdk_1.8.0_201

Field Name Description Value

Host The host name of the server 
where the database resides.

Oracle Utilities Analytics 
Database Server
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8. On the OBIEE Home Details page, enter the following details in the respective fields and 
click Next. 

Note: You will be prompted for the Weblogic user’s password after installation. 

9. On the Java Home Location page provide the Java Home details that were provided earlier. 
Click Next. 

Port The database port number on 
the database server used for 
connecting to the database.

Oracle Utilities Analytics 
Database Port. The default value 
is 1521.

Service Name The service name for the 
database

Target Schema 
Password

The password for the target 
schema (DWADM).

Confirm Target 
Schema Password 

Confirm the password for the 
target schema (DWADM) 
here.

Metadata Schema 
Password

The password for the 
metadata schema (MDADM).

Confirm Metadata 
Schema Password

Confirm the password for the 
metadata (MDADM) schema 
here.

Field Name Description Value

BI Home The location on the disk 
where OBIEE is installed.

Example:

/u01/ Middleware/Oracle_BI1

BI Domain Home The domain Home location 
under the directory where 
OBIEE is installed.

Example:

/u01/ Middleware/
user_projects/domains/
bifoundation_domain

WebLogic Host The hostname on which 
WebLogic server for OBIEE 
is running.

WebLogic Port 
Number

A unique port number within 
the system that is assigned to 
the HTTP port. 

This port number is used as a 
part of the client URL request 
to connect to the host. It is 
the OBIEE WebLogic 
console admin port number. 

Example: 7001

WebLogic User WebLogic domain login user 
name. 

Field Name Description Value
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10. On the Installation Summary page, verify the installation options and click Install to begin 
the installation. 

For any changes to the configuration before starting the installation, use the navigation pane 
and select the topic to edit. 

11. The Installation Progress page allows you to view the progress of the installation. 
Operations being performed as part of the installation are logged to the terminal from which 
the installer was run. Detailed logs of the installation are also available in the logs/system 
directory under the installation location.

To quit before the installation is complete, click Cancel. Doing so will result in a partial 
installation; the portion of the software that was installed on your system before you click 
Cancel will remain on your system, and it needs to be deleted manually. 

12. On the Installation Completed page, click Finish to close the installer. 

The Dashboards component is installed successfully. 

Deploying Web Catalog
Take the backup of existing BI Publisher reports from the catalog location. After the deployBAR 
step is completed successfully, copy the BI Publisher reports (for which backup was taken) to the 
location of the catalog. 

To deploy the web catalogs: 

1. Go to the <DOMAIN_HOME>/bidata/service_instances/ssi/metadata/content/catalog/
root/shared directory.

2. Delete the existing catalogs (if any) that were delivered out-of-the-box with Oracle Utilities 
Analytics in the previous release. 

Ensure any custom catalog related files in this directory are backed up in a separate location 
before running deployBar.sh.

If Oracle Utilities Network Management System BI Publisher reports were deployed, they 
should be retained. 

3. Login to the Enterprise Manager.

4. Navigate to Coreapplication > Deployment > Repository for viewing the catalog 
location. 

5. Go to the <Catalog location>/root/system directory and remove the spatialmetadata 
directory and spatialmetadata.atr file.

6. Follow the steps as below for UNIX:

a. Navigate to <Install_Dir>/bin directory. 

cd <Install_Dir>/bin

b. Add Java 8 to the path variable as shown in example below: 

export PATH=/scratch/softwares/jdk1.8.0_201/bin:$PATH

c. Run ksh ./deployBAR.sh.

The Web catalog is successfully deployed.

Note: If there are any customizations on rpd, ensure to backup the rpd before 
executing deployBAR.sh to deploy the catalog. After deploying the catalog 
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follow the instructions in Deploying Repository (RPD) File section to deploy 
RPD files. 

For an AIX operating system, after the deployBAR.sh is completed successfully, execute the 
following command: 

cp -r ../writeback/wbtemplates/* $DOMAIN_HOME/bidata/
service_instances/ssi/metadata/content/msgdb/l_en/customMessages

Deploying Repository (RPD) File
If no changes are made to the deployed RPD, then take the RPD file from the following location, 
where <install_dir> is the Oracle Utilities Analytics Dashboard Component installation directory:

<install_dir>/Reports/rpd/ UtilitiesBusinessAnalytics.rpd

Note: If you are using the default Oracle Utilities Analytics repository, you 
must change the default password the first time you open it in the 
Administration Tool. 

If it was merged, do the required database changes with the merged RPD. Copy this RPD file to 
the Windows machine on which Oracle Business Intelligence Developer Client Tool (12.2.1.4.0) is 
installed. 

To deploy the RPD file: 

1. Ensure Oracle Business Intelligence Developer Client Tool (12.2.1.4.0) is installed on the 
Windows machine before proceeding. 

2. Click Start > Programs > Oracle Business Intelligence > Administration. 

3. Click File > Open > Offline... to open the RPD in offline mode.

4. Provide the RPD password. The default password is “oracle123”. 

5. Double-click the Connection Pools to edit them. 

• In the Init Block Connection Pool group, enter the following: 

Datasource name = BI Database name

User name = DWREAD
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Password = DWREAD User password

• In the Init Block Pool - MDM group, provide the following (only for Oracle Utilities 
Meter Data Management): 

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

• In the Init Block Pool - NMS Replication group, provide the following (only for 
Oracle Utilities Network Management System): 

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password

• In the Materialized Views Connection group, enter the following:

Datasource name = BI Database name

User name =DWREAD

Password = DWREAD User password 

• In the MDM Database Connection group, provide the following (only for Oracle 
Utilities Meter Data Management): 

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

• In the NMS Replication Tables group, provide the following (only for Oracle Utilities 
Network Management System): 

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password 

Note: The default schema name is NMS1REP. If the replication schema name is 
different, then rename it. 

• In the ODIDEV Connection Pool group, provide the following: 

Datasource name = BI database name

User name = DWUSER

Password = DWUSER User password

• In the OUBI Database Connection group, provide the following: 

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password
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6. Click Save. 

Note: Click Yes when you see the prompt 'Do you wish to check global consistency?' 
and ignore any warnings that appear after consistency check is complete. 

7. Copy the modified RPD back to the <install dir>/Reports/rpd/
UtilitiesBusinessAnalytics.rpd where <install_dir> is the Oracle Utilities Analytics Dashboard 
Component installation directory.

8. Login to the server where OBIEE is installed. 

9. Navigate to <OBIEE DOMAIN>/bitools/bin.

10. Run the following command to deploy the RPD: 

In Unix: 

./datamodel.sh uploadrpd -I <OUA home>/Reports/rpd/
UtilitiesBusinessAnalytics.rpd -W <rpd password, default 
password is oracle123> -U <Weblogic user name of OBIEE domain> -
P <Weblogic password of OBIEE domain> -SI ssi 

11. Run the following commands from <OBIEE DOMAIN>/bitools/bin directory to stop and 
start the OBIEE domain services respectively. 

./stop.sh 

./start.sh 

Note: Since OBIEE 12.2.1.4 Mapviewer is not supported on AIX platforms, 
the Mapviewer URL is not accessible. 
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Enabling WriteBack
To enable the Write Back: 

1. Login to Analytics and navigate to Administration > Manage Privileges > WriteBack > 
Write Back to Database. 

2. Click Denied:Authenticated User and select the Granted permission. 

Enabling Auto Complete Feature in OBIEE
To enable the auto complete feature on OBIEE: 

1. Restart the OBIEE services. 

Note: Refer to OBIEE documentation for detailed instructions on how to start 
and stop OBIEE services.

2. Login to Analytics.

http://<Server>:<port>/analytics

3. Click WebLogic User (top-most-right section of the page). 

4. From the drop-down menu, select My Account. 

5. On the Preferences tab, set Prompt Auto Complete to ON.

6. Click OK. 

http://<Server>:<port>/analytics
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Chapter 6
Upgrading Oracle Utilities Analytics from

v2.6.0.0.10

Oracle Utilities Analytics v2.7.0.1 supports the direct upgrade path from v2.6.0.0.10 to v2.7.0.1. 

Important! This chapter is applicable only to customers upgrading from Oracle Utilities 
Analytics v2.6.0.0.10 to v2.7.0.1. 

To upgrade to Oracle Utilities Analytics v2.7.0.1, you must first upgrade to Oracle Utilities 
Analytics v2.6.0.0.10 if on an earlier version. Ensure all pre-requisites (JDK and ODI) are 
followed before beginning the upgrade process.

This chapter describes the procedure to upgrade to Oracle Utilities Analytics v2.7.0.1, including: 

• Pre-requisites

• Upgrading Oracle Utilities Analytics Database Component

• Upgrading Oracle Data Integrator Based ELT Component

• Upgrading Oracle Utilities Analytics Administration Tool Component

• Upgrading Oracle Utilities Analytics Dashboards Component 
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Pre-requisites
Upgrading Oracle Utilities Analytics from v2.6.0.0.10 to v2.7.0.1 includes upgrading Oracle Data 
Integrator based source applications (Oracle Utilities Customer Care and Billing, Oracle Utilities 
Work and Asset Management, Oracle Utilities Network Management System, Oracle Utilities 
Mobile Workforce Management, and Oracle Utilities Meter Data Management). 

Make sure the required JDK 1.8.0(251) and Oracle Data Integrator 12.2.1.3.0 (both infrastructure 
and ODI) are installed on Oracle Data Integrator server. Also, the target OBIEE applications 
should be down. 

Follow these steps as part of prerequisites: 

1. Login to Oracle Utilities Analytics ODI server and start the ODI client. 

Note: Oracle Data Integrator Studio 12.2.1.3 is not supported in the AIX and 
Solaris operating systems. Install Oracle Data Integrator Studio client in either 
Linux or Windows machines to connect to the work repository. 

cd $ODI_HOME/odi/studio
./odi.sh

2. Stop BI_RUN_ALL. Follow these steps: 

a. Login to Oracle Database Integrator Studio. 

b. Double-click Global/WLS_AGENT and select Inactive. 

c. Save the changes. 

d. On the Studio, navigate to the Topology tab. Right-click OracleDIAgent and select 
Update Schedule. 

3. Execute the following query to check if all jobs are complete. No rows should be returned 
from the query mentioned above. If any rows are returned, that means jobs are not yet 
completed. Wait until all the jobs are completed. 

Note that this is applicable if the source system is Oracle Utilities Customer Care Billing, 
Oracle Utilities Operational Device Management, or Oracle Utilities Network Management 
System.

SELECT
*
FROM mdadm.b1_jobs_vw
WHERE status_flg NOT IN ('D', 'E', 'RP');

4. Stop the Oracle Data Integrator admin and managed servers. Navigate to the ODI domain 
bin location and execute stop scripts. 

Example:

cd /scratch/ouacicd/domains/odi_domain/bin
./stopManagedWebLogic.sh ODI_server1
./stopWebLogic.sh 

5. Sync all the Oracle GoldenGate processes. 

a. Connect to MDADM schema in the Oracle Utilities Analytics database. 

b. Execute the SQL mentioned below to get all the context codes. 

Select CONTEXT_CD from b1_prod_instance where CONTEXT_CD<>'B1';
 

c. For each context returned by the query: 

a. Connect to the source database corresponding to the context code as sys user. 
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b. Execute the following command: 

alter system switch logfile 

c. Connect to MDADM schema in the Oracle Utilities Analytics database. 

d. Execute the SQL mentioned below to get source GoldenGate server and Oracle 
GoldenGate Home on source server. 

select DS_HOST,DS_HOME from b1_server_cfg where 
CONTEXT_CD='<Context_code>' 

e. Make sure that the pump processes transfer all the changes to the target server. Lag 
at the Chkpt and Time Since Chkpt should be 0. 

f. On the Oracle Utilities Analytics database server, ensure the replicate processes 
apply all changes for the context code. 

• Connect to the MDADM schema in Oracle Utilities Analytics database and 
execute the query below to get the target server and GoldenGate Home details 
on the target server. 

select DS_HOST,DS_HOME, DS_FLAG from b1_server_cfg where 
CONTEXT_CD='B1'; 

• Connect to the target server and login to the GoldenGate prompt. Execute the 
following commands:  

cd <GG_Home >
./ggsci
dblogin userid MDADM,password <MDADM user password> Send 
replicat <Context_codeXX>,status

Make sure you see the current status to be at EOF. 

g. Check this for each 'replicat' process of the context code. 

h. Make sure all extracts and replicates of all sources are in sync. 

i. Stop replicate processes in the target server. 

ODI Related Settings
Login to the Oracle Utilities Analytics ODI server and perform the following steps: 

1. Navigate Load Plan and Scenario. 

2. Make sure to take a backup of all scenarios. 

3. Delete all scenarios starting with B1_% and present outside the load plan and scenarios out-
of-the-box folder. 

4. Delete the Accelerators and Framework Scenario from Load Plan and Scenarios. 

Note: In Oracle Utilities Analytics v2.7.0.1, the Oracle Utilities Application 
Framework folder structure was modified. Hence while upgrading from 
2.6.0.0.10 to 2.7.0.1.0 you need to remove Mentioned scenario folder from 
Load Plan and Scenario section.
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Upgrading Source Applications to be Compatible with Oracle Utilities Analytics 
v2.7.0.1

If the existing source application version is certified with Oracle Utilities Analytics v2.7.0.1.0, this 
section can be ignored. 

If existing source application version is not certified with Oracle Utilities Analytics v2.7.0.1.0 or if 
you want to upgrade to higher supported source version, perform the following steps before 
upgrading Oracle Utilities Analytics. 

• The source applications' databases must be in archive log mode during their upgrade. Oracle 
GoldenGate processes should be up and running on both source and target during the source 
application(s) upgrade. 

• Upgrade the source application databases. If the source database version is prior to 11.2.0.4, 
then upgrade to 11.2.0.4 or a later version.

Note: After a successful upgrade, do not release the source applications to end 
users. make sure to stop the source applications, but the source databases 
should be up and accessible. 

Perform the following steps to cleanup the Oracle GoldenGate processes: 

1. Connect to MDADM schema in the Oracle Utilities Analytics database. Execute the SQL 
below to get all the context codes. 

Select CONTEXT_CD from b1_prod_instance where CONTEXT_CD<>'B1';

2. For each context returned by the query: 

a. Connect to MDADM schema in the Oracle Utilities Analytics database. Execute the 
SQL below to get the source GoldenGate db server, SID and Oracle GoldenGate host, 
home on source server: 

Select DS_HOST,DS_SID,DS_HOME,CONTEXT_CD,DS_FLAG from
b1_server_cfg where CONTEXT_CD='<Context_code>'

b. Connect to the source database corresponding to context code as sys user and execute 
the following command: 

alter system switch logfile

c. Make sure that the pump processes transfer all the changes to the target server. Lag at 
the Chkpt and Time Since Chkpt should be zero. 

d. On the source database server, drop all the GoldenGate processes. 

a. Connect to MDADM schema in the Oracle Utilities Analytics database. 

b. Execute the following query to get GoldenGate Owner name in the source 
database. 

select SCHEMA_NAME
from MDADM.B1_CONTEXT_CFG_VW
where LSCHEMA_NAME = 'Journal'
and CONTEXT_CD = '<Context_code>'; 

c. Login to source GoldenGate prompt.

cd <GG_Home>
./ggsci

d. Execute the following commands: cleanup and delete the process extract/replicat 
process. 
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dblogin userid < GoldenGate Owner >,PASSWORD < GoldenGate 
Owner password>
stop <Context_code>*

For example:

stop CCB1*
delete <Context_code>*

delete CCB1* Stop mgr

e. Execute the below commands to unregister extracts from database:

unregister extract <Context_code>*X database

For example:

unregister extract CCB1AAX database

f. Similarly, unregister all model extracts.

Note: Note down the source Oracle GoldenGate context_codes of each 
source and source Oracle GoldenGate Owner info. They will be used to 
configure the existing sources with same context during the upgrade.

e. Connect as a sys user to the source database server. Execute the following command:

<GG_Home>/ddl_disable.sql

f. Rename the existing source Oracle GoldenGate Home on the source server. 

Note the GoldenGate manager port number and source GoldenGate home before 
renaming it.

For example: mv <GG_Home> <GG_Home>.bkp

g. On the Oracle Utilities Analytics database server, ensure the replicate processes apply all 
changes for the context code. 

a. Connect to MDADM schema in the Oracle Utilities Analytics database. Execute the 
below query to get the target server and GoldenGate Home details on the target 
server.

select DS_HOST,DS_HOME,DS_FLAG from b1_server_cfg where 
CONTEXT_CD='B1';

b. Connect to the target server and login to the GoldenGate prompt. Execute the 
following commands:

cd <GG_Home >
./ggsci
Dblogin userid MDADM,password <MDADM user password>

c. Check each replicate process for the context code and ensure replicate processes 
completed writing all the changes. 

d. After checking the current status and each replicate process for the context code, 
execute the following commands:

Stop <Context_code>*

Example:

stop CCB1*
Delete <Context_code>*
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Example:

delete CCB1*

3. After all source applications' changes are in sync in the Oracle Utilities Analytics database, 
execute the following command after connecting to the target GoldenGate Home prompt. 

./ggsci Stop mgr

4. Rename the existing target GoldenGate Home directory. 

Note the GoldenGate manager port number and target GoldenGate Home before renaming 
it.

Upgrading Oracle Utilities Analytics Database Component
For steps to upgrade the Oracle Utilities Analytics database component, refer to the Upgrading 
Oracle Utilities Analytics Database Component section in Chapter 5: Upgrading Oracle Utilities 
Analytics from v2.7.0.0.11. 

Before proceeding with upgrading the Oracle Utilities Analytics Database component make sure 
the following are complete:

• Upgrading Oracle Utilities Analytics database to 19.7.

• Installing Oracle GoldenGate 19.1 on Oracle Utilities Analytics database server. 

Upgrading Oracle Data Integrator Based ELT Component
This section describes the steps to upgrade the Oracle Data Integrator based ELT component: 

1. Prerequisites for Running Oracle Utilities Analytics Installer

2. Setting Up Oracle GoldenGate

3. Copying and Decompressing Install Media 

4. Starting the Installer 

5. Upgrade Steps

6. Configuring Source Applications

7. Upgrading Oracle Utilities Analytics Administration Tool Component

Before proceeding with upgrading the Oracle Utilities Analytics based ELT component, ensure 
the following are complete: 

8. Installing JDK1.8.0(251) 

9. Installing Oracle Fusion Middleware Infrastructure

Note that the Oracle Home path provided in the Installation Location page is used while installing 
the Oracle Data Integrator.

The infrastructure installation type is 'Fusion Middleware Infrastructure'.

During the Oracle Data Integrator 12.2.1.3 installation, provide the same 'Oracle Home' path used 
as Oracle Home while installing Oracle Fusion Middleware Infrastructure. Select Enterprise 
Installation on the Installation Type page.

10. Installing Oracle Data Integrator 12.2.1.3.0.0 (both infrastructure and ODI)
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Prerequisites for Running Oracle Utilities Analytics Installer
Before running the Oracle Utilities Analytics installer, take a backup of the customized views and 
recreate them manually after upgrading Oracle Utilities Analytics to v2.7.0.1. 

Setting Up Oracle GoldenGate
This section describes the following: 

• Setting up Oracle GoldenGate on Source Database Server

• Setting up Oracle GoldenGate on Target Database Server

• Setting up Oracle GoldenGate Monitor JAgent on Target and Source Database Servers

Setting up Oracle GoldenGate on Source Database Server
Before proceeding, start the source database and ensure it is accessible. Bring down the source 
application server.

To set up each source instance: 

1. Create a directory on the source database server. (Example: ../GoldenGate Home) and install 
Oracle GoldenGate in that directory. It is Oracle GoldenGate Home (OGG_Home) on the 
source database server. 

Note this directory location; it is used during the Oracle Utilities Analytics installation. 

2. Install Oracle GoldenGate. 

Download Oracle GoldenGate 19.1 from Oracle Software Delivery Cloud (https:// 
edelivery.oracle.com). 

For installation instructions, refer to the Oracle GoldenGate 18.1 documentation at https://
docs.oracle.com/en/middleware/goldengate/core/18.1/index.html.  

3. Provide the Oracle GoldenGate Home location as the directory location created in the step 1.

4. Open a command terminal or window, and set the source ORACLE_SID and 
ORACLE_HOME variables. 

5. Set the LD_LIBRARY_PATH. 

In UNIX: 

export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH

6. In the Command window, change directory to the Oracle GoldenGate home directory, and 
execute the following command: 

In UNIX:

./ggsci

The Oracle GoldenGate prompt is shown.

7. At the Oracle GoldenGate prompt, execute the following commands in the order listed: 

• create SUBDIRS

• start mgr - Starts the Oracle GoldenGate manager process

• info all - Verifies if the manager process is running

• exit - Exits Oracle GoldenGate

8. Ensure that the source database is in the archivelog mode. 
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9. In the Command window, navigate to the Oracle GoldenGate home (OGG_Home) 
directory. 

10. Open the GLOBALS file in the directory and add the below command: 

EnableMonitoring

11. In the Command window, create a directory “diroby” in the OGG_Home directory. 

12. Change directory to the Oracle GoldenGate Home directory. Execute the following: 

a. Steps in Configuring Encrypting Data Using ENCKEYS Method. 

b. Steps in Generating Shared Secret Password. 

Configuring Encrypting Data Using ENCKEYS Method
To configure for encrypting data using the ENCKEYS method: 

1. Execute the following command:

cd <OGG_HOME>
KEYGEN key_length n

The above command generates the key value based on the value specified in the parameter 
“n”. The key value has to be copied to ENCKEYS file against a logical name.

2. For each key value generated above, provide a logical name (Logical name should not be the 
same for two different key values). Enter the logical name space and then key value in the 
ENCKEYS file. 

3. Repeat the step above for each key values generated. 

4. Save the file with name ENCKEYS (Upper case only) without any extension. 

For example: 

cd $OGG_HOME
./keygen 128 1
0x8CE55035DD6893205A7BD6773FA8E670

5. Open a new ASCII ENCKEYS file if it does not exist for adding a new entry or open an 
existing ENCKEYS text file to append. 

6. Input the Logical name, space and key value generated.

Sample content of file ENCKEYS: 

CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670
7. The source ENCKEYS file entry has to be appended to the intermediate server or target 

server which would be configured with the source system where target OGG is being 
configured.

Note: It is recommended to name Logical key name after 
<context_code>KEY. 

For example: If context code is CCB1, it is recommended to name it as 
CCB1KEY.

Generating Shared Secret Password
To generate the shared secret password: 

1. Execute the following command:

cd <OGG_HOME>
ggsci
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ENCRYPT PASSWORD <GG Owner password> <algorithm> ENCRYPTKEY 
<key_name>

For example: 

cd $OGG_HOME
./ggsci
GGSCI (hostname) 1> ENCRYPT PASSWORD CCB01SRC AES128 ENCRYPTKEY 
CCB1KEY
Encrypted password: 
AADAAAAAAAAAAAIAVGNHBFLGFCHBTCVBFJFHUEJGNCFAOAFEOFBALELISFOEIFWGRB
ZHCCMCYGYBDAZH
Algorithm used: AES128

2. Note the above generated ENCKEYS file logical name/key value, algorithm name used, and 
the generated encrypted password. 

Setting up Oracle GoldenGate on Target Database Server
To set up Oracle GoldenGate on the target database server: 

To set up Oracle GoldenGate on the target database server: 

1. Create a directory on the target database server. 

For example: ../GoldenGateHome 
Oracle GoldenGate should be installed in this directory. It is Oracle GoldenGate home 
(OGG_Home) on the target Oracle Utilities Analytics database server. 

Note: Ensure to note the directory location; it will be used in the Oracle 
Utilities Analytics installation.

2. Install Oracle GoldenGate and provide the GoldenGate Home location as the directory 
location created in the step 1.

3. In the Command window, set the target ORACLE_SID and ORACLE_HOME variables.

Set LD_LIBRARY_PATH using the following commands: 

In Unix:

export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH

4. In the Command window, change the directory to the GoldenGate home directory and 
execute the below command: 

For Unix: 

./ggsci

The Oracle GoldenGate prompt is shown. 

5. At the prompt, execute the following commands in the order listed below: 

• create SUBDIRS

• start mgr - Starts the Oracle GoldenGate manager process. 

• info all - Verifies if the manager process is running. 

• exit

6. Create a directory “diroby” in the OGG_Home  directory. 

7. In the Command window, navigate to the Oracle GoldenGate Home (OGG_Home) 
directory.
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8. Edit the GLOBALS file in the <GG home> directory and add the following command.:

EnableMonitoring

9. Navigate to the Oracle GoldenGate home (OGG_Home) directory.

10. If the ENCKEYS file does not exist:

a. Create and open a new ASCII ENCKEYS file.

b. Add the key value/values that are generated on the sources to the ENCKEYS file in 
target OGG home. This is done for the context codes for which source is configured. 

A sample ENCKEYS file in target OGG home is as below: 

CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670

Setting up Oracle GoldenGate Monitor JAgent on Target and Source Database 
Servers

Set up Oracle GoldenGate Monitor JAgent on Oracle Utilities Analytics GoldenGate server and 
on all the source application Oracle GoldenGate servers. The Oracle GoldenGate Monitor JAgent 
is used to automatically copy the generated Oracle GoldenGate scripts to both source and target 
Oracle GoldenGate GoldenGate Home directories, and to start the extract and replicate processes 
on source and target. 

To setup Oracle GoldenGate Monitor JAgent on both target and source database servers: 

1. Ensure Oracle GoldenGate is installed and manager is running. 

2. Start the rmiregistry services using the following command: 

rmiregistry 5559 &

Make sure to note down the port on which RMI server is started. The port number specified 
here is 5559. If it is not specified, the default port 1099 will be used. 

3. Download Oracle GoldenGate Monitor and Veridata 12.2.1.2.0 from Oracle Software 
Delivery Cloud (https://edelivery.oracle.com/osdc/faces/SoftwareDelivery). 

4. Run the Oracle GoldenGate Monitor and Veridata 12.2.1.2.0 installer. 

a. Select the installation type as Oracle GoldenGate Monitor Agent. 

b. Apply patch 26982776 on top of Oracle GoldenGate Monitor agent home before 
creating monitor instance.

5. Edit the Config.properties file in the <Oracle GoldenGate Monitor home>/oggmon/
ogg_agent/cfg_templates and add/modify the below parameters. 

<ACTUAL>   : jagent.host=localhost
<CHANGE TO> : jagent.host=<<actual hostname on which OGG is 
installed>>

 
<ACTUAL>    : monitor.jmx.username=cmroot
<CHANGE TO> : monitor.jmx.username=jmx_src

<ACTUAL>   : jagent.username=root
<CHANGE TO> : jagent.username=<<OGG software installed OS user>>

<ACTUAL>    : jagent.rmi.port=5559
<CHANGE TO> : jagent.rmi.port=5557 or any free port other than the 
one on which the rmiregistry is started
 
<ACTUAL>    : agent.type.enabled=OGGMON
<CHANGE TO> : agent.type.enabled=OEM
<ACTUAL>    : jagent.backward.compatibility=true

https://edelivery.oracle.com/osdc/faces/SoftwareDelivery
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   <CHANGE TO> : jagent.backward.compatibility=false

6. Add the following parameter:

jagent.ssl=false

7. Navigate to <Oracle GoldenGate Monitor home>/oggmon/ogg_agent directory and run 
the following command: 

In Unix:

export JAVA_HOME=<JDK home>

./createMonitorAgentInstance.sh

a. You will be prompted to enter: 

• Oracle GoldenGate Home directory. 

• Path to be used for Oracle GoldenGate Monitor Agent instance. 

It is recommended to provide a path (such as <Oracle GoldenGate Monitor 
home>/Agents/OGGMonitorInstance). 

• A unique name to replace the timestamp in the name of the file used to start Oracle 
GoldenGate Monitor agent instance. 

Provide a unique name to be used for this Oracle GoldenGate Monitor instance. 

b. Execute the command below from <path used for Oracle GoldenGate Monitor instance 
provided in the step above>/bin. 

Example location: <OGG Monitor home>/Agents/OGGMonitorInstance/bin

In Unix: 

export JAVA_HOME=<JDK home>
./pw_agent_util.sh -jagentonly

8. Enter the Oracle wallet password. 

This password has to be entered as the password for the JAGENT while running the installer 
(for target gg), and while running the source configuration (for source gg). 

Ensure to note the password and jagent.rmi.port value (JAgent Port). This information is 
required in subsequent installation. 

9. Create a folder with the Context_code name in <GG Home>/dirdat. 

For example: If WAM2 is created for the WAM source, then create a folder with name 
“WAM2” within the <GG Home>/dirdat/ folder. 

10. Navigate to <GG Home>/dirprm and edit jagent.prm file.

Replace COMMAND java with COMMAND <JDK Home>/bin/java.

This ensures that the correct version of java (1.8) is used while starting JAgent. 

11. Navigate to OGG_Home directory and run the following command at the Oracle 
GoldenGate prompt: 

ggsci

12. Start the jAgent process.



Copying and Decompressing Install Media

Upgrading Oracle Utilities Analytics from v2.6.0.0.10 6-12
Oracle Utilities Analytics Installation Guide

start jagent

Note: Export LIBPATH with jdk,OGG and RDBMS paths to start JAGENT 
in the AIX environment. 

$JAVA_HOME/bin
$OGG_HOME
$RDBMS_HOME/lib

Example: 

export LIBPATH=/usr/java8_64/bin:/scratch/bi_oradata_01/
GG_18c_Home:/scratch/gbuora/app/gbuora/product/18.3/dbhome_2/
lib:$LIBPATH 

The logs for JAgent are created at the following (example) location. 

<OGG Monitor home>/Agents/OGGMonitorInstance/logs

Copying and Decompressing Install Media
To download and decompress the install media:

1. Download the Oracle Utilities Analytics v2.7.0.1 Multiplatform part (Oracle Utilities 
Analytics V2.7.0.1 Multiplatform.zip) from Oracle Software Delivery Cloud (https://
edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (referred to 
<TEMPDIR> below). This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation. 

3. Unzip Oracle Utilities Analytics V2.7.0.1 Multiplatform.zip to <TEMPDIR>. 

Starting the Installer
For an AIX operating system, set the following environment variable before starting the Oracle 
Utilities Analytics installation: 

export IBM_JAVA_OPTIONS=”-Xmx2g  -XX:PermSize=64m -
XX:MaxPermSize=3200m”

To start the Oracle Data Integrator Based ELT component:

1. Navigate to the temporary folder containing the installer. 

2. Run the following command from this folder: 

java -jar <TEMPDIR>/OUA_2.7.0.1_generic.jar -logLevel finest

Note: The minimum JDK required for running the Oracle Utilities Analytics 
installer is JDK 1.8. 

The Welcome page appears. 

3. Review this information before you begin the installation. Click Next to continue with the 
installation. 

4. Complete the tasks on the navigation pane. 

Each item in the navigation pane represents a specific installer screen that prompts you for 
information required to install the software. 

• If you select Oracle Data Integrator Based ETL as an Installation Type, define the 
following:

https://edelivery.oracle.com
https://edelivery.oracle.com
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• Database and Java Home Details

• Target Database Connection Details

• Oracle Data Integrator Home and Schema Details

• Oracle Data Integrator Agent and Repository Details

• Target GoldenGate Details

• Target JAgent Details

Upgrade Steps
To install Oracle Data Integrator Based ETL: 

1. Run the Oracle Utilities Analytics Installer. Review the information on the Welcome page 
before you begin the installation. 

2. Click Next to continue with the installation. 

3. On the Installation Inventory page, provide the inventory location. Click Next. 

4. On the Installation Location page define an installation location/directory and click Next.

5. On the Languages Selection page, make sure to select “English”. Click Next.

6. On the Select Installation Type page, select ODI Based ETL. Click Next.

Note that the options on the left navigation pane change based on the selected installation 
type. 

7. Select Oracle Data Integrator Based ETL as the Installation Type.

8. Define the following and click Next. 

• Database and Java Home Details

• Target Database Connection Details

• Oracle Data Integrator Home and Schema Details

• Oracle Data Integrator Agent and Repository Details

• Target GoldenGate Details

• Target Jagent Details

9. On the Database and Java Home Details page, enter the following in the respective fields. 
Click Next.

Field Name Description Value

Database Client Home The database client home 
location.

Example: 
/u01/app/product/19.7/ 
dbhome_1

Java Home The JDK home location. Provide location of JDK 1.8

Example: /u01/jdk_1.8.0_251
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10. On the Target Database Connection Details page, enter the following in the respective 
fields. Click Next:

11. On the ODI Home and Schema Details page, enter the following in the respective fields. 
Click Next:

Field Name Description Value

Host Host name of the server 
where the database resides.

Oracle Utilities Analytics 
Database Server

Port Database port number on the 
database server used for 
connecting to the database.

Oracle Utilities Analytics 
Database Port. The default value 
is 1521.

Service Name Service name for the database

Target Schema 
Password

Password for the target 
schema (DWADM)

Confirm Target 
Schema Password 

Confirm the password for the 
target schema (DWADM) 
here.

Metadata Schema 
Password

Password for the metadata 
schema (MDADM)

Confirm Metadata 
Schema Password

Confirm the password for the 
metadata (MDADM) schema 
here

Field Name Description Value

ODI Home Directory where Oracle Data 
Integrator (ODI) has been 
installed.

Example: /u01/Middleware

Supervisor User Name of the Oracle Data 
Integrator Supervisor

SUPERVISOR 

Supervisor Password Password of the Oracle Data 
Integrator Supervisor

SUPERVISOR user password

Confirm Supervisor 
Password

Confirm the password of the 
Supervisor here

Master Repository 
Schema Name

Oracle Data Integrator master 
repository schema name

OUA_MASTER

Master Repository 
Schema Password

Password of the master 
repository schema

OUA_MASTER user's password

Confirm Master 
Repository Schema 
Password

Confirm the password of the 
Oracle Data Integrator master 
repository schema here

Work Repository 
Schema Name

Oracle Data Integrator work 
repository schema name

OUA_WORK
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12. On the ODI Agent and Details page, enter the following details in the respective fields. 
Click Next:

13. On the Target GoldenGate Details page, enter the following details in the respective fields. 
Click Next. 

Work Repository 
Schema Password

Password of the work 
repository schema

OUA_WORK user's password

Confirm Work 
Repository Schema 
Password

Confirm the password of the 
Oracle Data Integrator work 
repository schema here

Field Name Description Value

ODI Agent Host Host on which Oracle Data 
Integrator WebLogic domain 
is created.

Oracle Data Integrator server 
host name

ODI Agent Port Port on which Oracle Data 
Integrator WebLogic agent is 
configured to run. This is the 
port of Oracle Data 
Integrator WebLogic 
Managed Server Port.

Provide available port and ensure 
to use the same port while 
creating Oracle Data Integrator 
managed server. 

Field Name Description Value

GoldenGate Host Host on the Oracle 
GoldenGate Manager.

GoldenGate Home This is the Oracle 
GoldenGate installed 
location. 

Example: 
/opt/local/ggs_18.1

Target Database Home The database home installed 
location on the target database 
server. 

In case Oracle GoldenGate 
for target is not installed on 
the OUA database server, 
provide oracle client home 
location on the server on 
which Oracle GoldenGate is 
installed.

Example: 
/u00/oracle/app/oracle/ 
product/19.7/dbhome_1

GoldenGate Manager 
Port

Port number on which Oracle 
GoldenGate Manager is 
running on the Oracle 
GoldenGate host.

The default value is 7830

GoldenGate Algorithm Algorithm configured in 
Oracle GoldenGate on the 
target database server.

The default value is BLOWFISH.

Field Name Description Value
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14. On the Target JAgent Details page, enter the following details in the respective fields. Click 
Next.

15. On the Java Home Location page, provide the Java Home details that were provided earlier. 
Click Next. 

16. On the Installation Summary page, verify the installation options you selected. 

17. Click Install to begin the installation. 

To change any configurations before starting the installation, use the navigation pane and 
select the topic to edit. 

The Installation Progress page displays the progress of the installation. Operations being 
performed as a part of the installation are logged to the terminal from which the installer was 
run. The detailed logs of the installation are also available in the logs/system directory under 
the installation location.

To quit before the installation is complete, click Cancel. Doing so will result in a partial 
installation; the portion of the software that was installed on your system before you click 
Cancel will remain on your system, and you will have to remove it manually.

GoldenGate 
Encryptkey

The Encrypt Key configured 
in Oracle GoldenGate on the 
target database server. 

The default value is 
“DEFAULT”.

GoldenGate Shared 
Secret

The shared secret key 
configured in Oracle 
GoldenGate on the target 
database server.

Go to the Oracle GoldenGate 
prompt and run the command:

encrypt password 
<password of MDADM 
user>, encryptkey 
DEFAULT 

Provide the result as the value.

Field Name Description Value

JAgent Host The host of Oracle 
GoldenGate Monitor JAgent.

JAgent GoldenGate The Oracle GoldenGate 
installed location where 
Oracle GoldenGate Monitor 
JAgent is running.

Example:
/opt/local/ggs_19.1

JAgent Port Use the JAgent RMI port 
which is defined in the config 
properties file.

JAgent User OS user used to configure 
JAgent

JAgent Wallet Password JAgent Wallet password

Confirm JAgent Wallet   
Password

Re-enter JAgent Wallet 
password to confirm.

Field Name Description Value
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18. On the Installation Completed page, click Finish to close the installer.

The Oracle Data Integrator based ETL is now installed. 

Executing Post-Upgrade Script
Execute the B1_DROP_NMS_WAM_MVS_270012 scenario if either Oracle Utilities Network 
Management System or Oracle Utilities Work and Asset Management source is configured. 

1. Login to ODI Client and navigate to Designer > Load Plans and Scenario folders. 

2. Expand Framework > Data correction. Perform the following steps manually execute the 
B1_MDFIX_#### and B1_DATAFIX_##### in global context in a *sequence as 
mentioned below. 

• B1_MDFIX_27000 

• B1_MDFIX_27003

• B1_MDFIX_27004 

• B1_MDFIX_27005

• B1_MDFIX_27006

• B1_MDFIX_27007

• B1_MDFIX_27010 

• B1_DATAFIX_270 

• B1_DATAFIX_27009 

• B1_DATAFIX_27010 

• B1_DATAFIX_270010 

• B1_DATAFIX_27000

You can find all the above mentioned scenario in below location. 

Note: There may be an error message “SnpScen.getScenarioLastVersion: SnpScen does not 
exist” while executing B1_DATAFIX_27000 scenario. Ignore this error and proceed further. 
This is because some older objects existing deprecated as of the latest 2.7.0.1 release. So 
except for a single step with an obsolete reference, all necessary steps in that scenario would 
have been executed successfully. 

3. The following instructions are specific for Oracle Utilities Customer Care and Billing 
product. 

• Make sure that ERR_CF_PA_SNAP table should not have any record. If there are, 
please reprocess those errors after syncing their respective missing dimension data. After 
reprocess, drop ERR_CF_PA_SNAP table from staging schema. 

• Follow the steps 1 to 2 for the other two facts: CF_RECENT_TD_ENTRY and 
CF_TD_ENTRY. 
Error table name: ERR_CF_RECENT_TD_ENTRY and ERR_CF_TD_ENTRY

4. Expand Framework > Data correction > B1_DROP_NMS_WAM_MVS_270012. 

5. Right-click B1_DROP_NMS_WAM_MVS_270012 and click Run. 

6. Select the appropriate context (Oracle Utilities Network Management System or Oracle 
Utilities Work and Asset Management). 

7. Click OK. 
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Configuring Source Applications
This section describes the instructions to be followed to configure source applications.

• Prerequisites

• Configuration Steps

Prerequisites 
Before running the source configuration tool, make sure to check for the following: 

• Missing constraints at target side before running the source configuration

• Oracle GoldenGate abended process after the source application upgrade at target side

• Cleanup context at source

Missing constraints at target side before running the source configuration

1. Make sure that the primary keys of all replication tables are present. Use the following query 
to retrieve the tables that have the primary key missing. 

SELECT *
FROM
MDADM.B1_SOURCE_TABLE S
WHERE PROD_FLG = '<configured source product value>'
AND BASE_REPLICATE_FLG ='Y'
AND NOT EXISTS (SELECT 1 FROM ALL_CONSTRAINTS C
WHERE CONSTRAINT_TYPE ='P'
AND OWNER='<replication schema name for configured source>'
AND S.TBL_NAME=C.TABLE_NAME);

Example: Oracle Utilities Customer Care and Billing 

SQL> SELECT *
FROM
MDADM.B1_SOURCE_TABLE S
WHERE PROD_FLG = 'CCB'
AND BASE_REPLICATE_FLG ='Y'
AND NOT EXISTS (SELECT 1 FROM ALL_CONSTRAINTS C
WHERE CONSTRAINT_TYPE ='P'
AND OWNER='CCB1REP'
AND S.TBL_NAME=C.TABLE_NAME);  

In case the primary keys are not present, the same could be recreated using the following 
steps. Please note that these steps need to be performed only if the primary keys of the tables 
are missing.

2. Retrieve the keys for the tables using the following query from the Source side. 

SELECT
ST.TABLE_NAME , SC.COL_NAME, rank() OVER (PARTITION BY 

ST.TABLE_NAME ORDER BY SKC.POS DESC) KEY_POS
FROM
<work repository schema>.SNP_KEY_COL SKC,
<work repository schema>.SNP_KEY SK,
<work repository schema>.SNP_TABLE ST,
<work repository schema>.SNP_COL SC,
<work repository schema>.SNP_MODEL SM,
(SELECT
TBL_NAME
FROM
MDADM.B1_SOURCE_TABLE S
WHERE PROD_FLG = '<configured source product value>'
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AND BASE_REPLICATE_FLG ='Y'
AND NOT EXISTS (SELECT 1 FROM ALL_CONSTRAINTS C
WHERE CONSTRAINT_TYPE ='P'
AND OWNER='<replication schema name for product configured>'
AND S.TBL_NAME=C.TABLE_NAME)) TAB_LIST
WHERE SKC.I_KEY =SK.I_KEY
AND SK.I_TABLE=ST.I_TABLE
AND SKC.I_COL=SC.I_COL
AND ST.I_MOD=SM.I_MOD
AND SM.COD_MOD LIKE '%REP%'
AND ST.TABLE_NAME= TAB_LIST.TBL_NAME AND SK.CONS_TYPE='PK';

For example:

SELECT
ST.TABLE_NAME , SC.COL_NAME, rank() OVER (PARTITION BY 

ST.TABLE_NAME ORDER BY SKC.POS DESC) KEY_POS
FROM
OUA_WORK.SNP_KEY_COL SKC,
OUA_WORK.SNP_KEY SK,
OUA_WORK.SNP_TABLE ST,
OUA_WORK.SNP_COL SC,
OUA_WORK.SNP_MODEL SM,
(SELECT
TBL_NAME
FROM
MDADM.B1_SOURCE_TABLE S
WHERE PROD_FLG = 'CCB'
AND BASE_REPLICATE_FLG ='Y'
AND NOT EXISTS (SELECT 1 FROM ALL_CONSTRAINTS C
WHERE CONSTRAINT_TYPE ='P'
AND OWNER='CCB1REP'
AND S.TBL_NAME=C.TABLE_NAME)) TAB_LIST
WHERE SKC.I_KEY =SK.I_KEY
AND SK.I_TABLE=ST.I_TABLE
AND SKC.I_COL=SC.I_COL
AND ST.I_MOD=SM.I_MOD
AND SM.COD_MOD LIKE '%REP%'
AND ST.TABLE_NAME= TAB_LIST.TBL_NAME AND SK.CONS_TYPE='PK';

3. After getting the table list using the query, create the primary key. 

ALTER TABLE <replication schema name>.<table name>
ADD CONSTRAINT <constraint name> PRIMARY KEY (<column list 
separated by comma>);

Example: 

SQL> ALTER TABLE CCB1REP.C1_USAGE ADD CONSTRAINT SYS_C0021279 
PRIMARY KEY (USAGE_ID);
Table altered.

Oracle GoldenGate abended process after the source application upgrade at target side

1. If Oracle GoldenGate replicate gets abended during the DDL replication while source 
upgrade, check the following select query that lists tables whose columns position is not in 
order - (MDADM schema). 

select 
OBJ_NAME, 
OBJ_OWNER, 
MODEL_CD, 
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CONTEXT_CD 
from  b1_ggs_ddl_log where context_cd = 'CCB1' and SQL_TEXT like 
'%ADD%' and STATUS_FLG = 'PREP' ;

Note: The output shows the tables for which DDL is not in sync (table column 
order is not in proper order).

The STATUS_FLG COLUMN WILL WILL BE "PREP"

2. Run the below script to check all tables based on context code provided as input for all the 
tables (from MDADM schema). 

begin
for x in ( 
select 
OBJ_NAME, 
OBJ_OWNER, 
MODEL_CD, 
CONTEXT_CD 
from  b1_ggs_ddl_log where context_cd = 'CCB1' and SQL_TEXT like 
'%ADD%' and STATUS_FLG = 'PREP' )
Loop
b1_redef_replication(x.CONTEXT_CD, x.MODEL_CD, x.OBJ_NAME, 
x.OBJ_OWNER);
End loop;
end;
/

3. After successful execution of this script start the replicate process. 

Note that the context code used here is: CCB1 which may change as per the source and context 
code. 

Cleanup context at source

Delete records from B1_OGG_SYNC_LOG before configuring sources with same context. 
Connect to journal schema and execute below SQL statements to delete Oracle GoldenGate sync 
log. 

select OGG_MODEL_CD FROM <<journal schema>>.B1_OGG_SYNC_LOG
WHERE OGG_MODEL_CD like '<<Context Code>>%';

DELETE FROM <<journal SCHEMA>>.b1_ogg_sync_log WHERE ogg_model_cd 
LIKE '<<Context Code>>%';
commit;

Example for Oracle Utilities Customer Care and Billing as source: 

select OGG_MODEL_CD FROM CCB01SRC.B1_OGG_SYNC_LOG WHERE 
OGG_MODEL_CD like 'CCB1%';
DELETE FROM CCB01SRC.b1_ogg_sync_log WHERE ogg_model_cd LIKE 
'CCB1%';
commit;

Configuration Steps
To configure the source applications:

1. Register a source application. 
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For instructions to register a source, refer to the Registering a Source section in Chapter 5: 
Configuring Oracle Utilities Analytics in Oracle Utilities Analytics Administration Guide.

2. Ensure to use the same context_codes to configure the existing sources during the upgrade.

3. Run the B1_INITIAL_SETUP_PKG package.

Note: It is recommended to run B1_INITIAL_SETUP_PKG only once (after 
all the sources have been configured or after at least one source is configured). 

a. Login to Oracle Data Integrator Studio. 

b. Navigate to Designer > Load Plans and Scenarios > Framework. 

c. Right-click B1_INITIAL_SETUP_PKG, select GLOBAL context code, and then 
select Run.

4. Start all Oracle GoldenGate processes on source and target: 

a. Login to each source application GoldenGate server.

b. Navigate to the respective Oracle GoldenGate Home directory. 

c. Start manager, JAgent, and all respective context extract processes.

d. Login to the target (Oracle Utilities Analytics) GoldenGate server. 

e. Navigate to the Oracle GoldenGate Home directory. 

f. Start manager, jagent and all respective context extract processes.

Upgrading Oracle Utilities Analytics Administration Tool Compo-
nent

Oracle Utilities Analytics Administration Tool is an Oracle Application Express (APEX) based 
configuration tool used to configure Oracle Utilities Analytics. 

This section describes how to install the tool to configure Oracle Utilities Analytics and change 
the default password of the Admin user. 

• Prerequisites

• Installation Steps

• Changing Default Password of Admin User

Note: Install Oracle Utilities Analytics Administration component on the 
Oracle Utilities Analytics database server. 

Prerequisites
To remove the previously created Apex workspace from database: 

1. Connect to the database as SYSTEM user. 

2. Execute the following PL/SQL procedure. 

BEGIN 
APEX_INSTANCE_ADMIN.REMOVE_WORKSPACE('OBIU_ADM');
END;
/

3. Make sure no workspace with “OBIU” exists in the database. 

select WORKSPACE from APEX_WORKSPACES where WORKSPACE like 
'%OBIU%';
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Note: No rows should be returned from this query. 

4. Uninstall ords from the database. 

5. Remove ords and i.war apps from APEX WebLogic console.

a. Login to APEX WebLogic console. 

b. Navigate to Deployments > Control. 

c. Click Stop and select Force Stop Now. 

d. Click Yes. 

e. On the Configuration tab, click Lock and Edit. 

f. Under Deployments, select both i and ords. 

g. Click Delete. 

h. Confirm deletion and click Activate Changes to activate the changes. 

6. Unistall the existing ords.war from the database.

7. Navigate to the ords.war (ords.3.0.6.178.08.46) file location in server. 

Example: 

cd /scratch/bi_oradata_01/apex_setup/apex_listener 

8. Execute the following command: 

java -jar ords.war uninstall

Note: Use JDK1.8 to execute the command.

Provide the necessary inputs. 

Installation Steps
To install the Oracle Utilities Analytics Administration Tool: 

Download Apex 19.1. Copy it to the server where you want to set it up under the /scratch/
bi_oradata_01/Softwares/apex_19.1 directory. 

Note: As a prerequisite of 19c database upgrade, upgrade APEX version to 
atleast 18.1 before performing the database upgrade. Below are the steps to 
upgrade APEX before the database upgrade.

For detailed steps to install Apex, refer to the Upgrading to the Latest Oracle Application 
Express Release section at https://docs.oracle.com/en/database/oracle/application-express/
19.1/htmig/upgrading-to-latest-AE-release.html#GUID-4B4A2BDC-11AA-4ACF-88B2-
E320D6361596.

@apexins.sql <Tablespace name> <Tablespace name> <Temp Tablespace 
name> /i/
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Example: @apexins.sql CISTS_01 CISTS_01 TEMP /i/

@apex_epg_config.sql <directory path of apex 19 software>

Example: @apex_epg_config.sql /scratch/bi_oradata_01/softwares/APEX_191/

@apxchpwd.sql

To install Apex for the first time: 

1. Download Apex 19.1. Copy it to the server where you want to set it up under the /scratch/
bi_oradata_01/Softwares/apex_19.1 directory.

2. Connect to the Oracle Utilities Analytics database as the sys user and execute the following 
commands: 

EXEC DBMS_XDB.SETHTTPPORT(0);
SELECT DBMS_XDB.GETHTTPPORT FROM DUAL;

This query should result in zero(0).

3. Navigate to the Apex unzipped path and execute the following scripts. Connect to Oracle 
Utilities Analytics database as a sys user. 

@apexins.sql <Tablespace name> <Tablespace name> <Temp Tablespace 
name> /i/
(for example: @apexins.sql CISTS_01 CISTS_01 TEMP /i/)
@apxchpwd.sql
ALTER USER APEX_PUBLIC_USER ACCOUNT UNLOCK;
ALTER USER APEX_PUBLIC_USER IDENTIFIED BY APEX_PUBLIC_USER;
@apex_rest_config.sql

Make sure to note the password for these two users: APEX_Listener user and 
APEX_REST_PUBLIC_USER. 

4. Import the Admin Tool to configure Oracle Data Integrator. 

a. Unzip the Oracle Utilities Analytics v2.7.0.1 Multiplatform.zip file. The file includes the 
AdminTool folder. 

b. Create ../AdminTool directory on the database server and copy the contents of the 
AdminTool directory (from the zip file) to this directory. 

c. Navigate to the ../AdminTool directory (cd ../AdminTool)

d. Connect as the system user. Execute the following scripts: 

a. Create workspace and configure the users.

@CreateAppWorkspace.sql 

b. Import the application.

@DeployAdminApp.sql 

c. Deploy supporting objects.

@DeploySupportingObjects.sql

5. Download Oracle Rest Data service. Copy it to the server where you want to set it up under 
the ords-18.3.0.270.1456.zip directory.

6. Navigate to the scratch/bi_oradata_01/Softwares/apex_listner directory. Unzip the ords-
18.3.0.270.1456.zip file. 

7. Create a directory on the server to configure Apex. 
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For example: mkdir/scratch/bi_oradata_01/apex_configuration

8. Navigate to the /scratch/bi_oradata_01/Softwares/apex_listner directory. 

cd /scratch/bi_oradata_01/Softwares/apex_listner

9. Execute the following command: 

java -jar ords.war install advanced
Note: Use JDK1.8 or later to execute this command. 

10. Navigate to the /scratch/bi_oradata_01/Softwares/apex_listner directory. 

java -jar ords.war static <apex18.2 unzipped path>/apex/images

For example: java -jar ords.war static /scratch/bi_oradata_01/Softwares/ apex_18.2/apex/ 
images 

Note: The command creates the i.war file. 

11. Install WebLogic 12.2.1.3 with JDK 1.8.0+. 

12. Create the WebLogic domain. 

a. Navigate to <12.2.1.3_weblogic_home>oracle_common/common/bin directory. 

b. Execute the following command: 

./config.sh

The Fusion Middleware Configuration Wizard window appears. 

a. On the Create Domain tab, select Create a new domain. Click Next.
Do not change the domain location. 

b. On the Template tab, select the template category. Click Next. 
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c. On the Administrator Account tab, provide the WebLogic username and password. 
Ensure to note the same. Click Next. 

d. On the Domain Mode and JDK tab, select jdk1.8 and click Next. 

e. On the Advanced Configuration tab, select Administration Server and Topology 
options. Click Next. 
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f. On the Administration Server tab, provide the available ports as Listen Port. Click 
Next. 

g. On the Managed Servers tab, click Add and provide values as shown below. Click 
Next. 

h. Click Next on the Clusters, Server Templates, Machines, Virtual Targets and 
Partitions tabs respectively. There are no changes to these pages. 
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i. On the Configuration Summary tab, click Create to create the domain. 

Changing Default Password of Admin User
This section describes the APEX API used to change the password of the admin user. The script 
should be run after connecting to the database as user SYSTEM.

Replace the string 'New password' with the new password for the admin account before running 
the script. 

begin
wwv_flow_api.set_security_group_id(p_security_group_id=>nvl(wwv_fl
ow_application_install.get_workspace_id,2090606133849294));
end;
/

begin
apex_util.edit_user(
p_user_id      => '2090514487849294',
p_user_name => 'ADMIN',
p_web_password => 'New password',
p_new_password => 'New password'
);
end;
/

commit;
/

Note: It is strongly recommended to change the default password after logging 
in.
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Upgrading Oracle Utilities Analytics Dashboards Component
Make sure that the same operating system user used to install the prerequisite software is used to 
install the Oracle Utilities Analytics Dashboards component as well. 

The Oracle Utilities Analytics Dashboards component is installed on the Oracle Utilities Analytics 
application server. 

This section describes how to install the dashboards component of Oracle Utilities Analytics. 

• Prerequisites

• Copying and Decompressing Install Media

• Starting the Installer

• Upgrade Steps

• Deploying Web Catalog

• Deploying Repository (RPD) File 

Prerequisites
Oracle Utilities Analytics Dashboard component v2.7.0.1 requires Oracle Business Intelligence 
Enterprise Edition version 12.2.1.4.

Note: OBIEE 11.1.1.9 should be upgraded to 12.2.1.4 before proceeding with 
Oracle Utilities Analytics Dashboard component upgrade. 

Refer to OBIEE documentation for details about the upgrade from 11.1.1.9 to 
12.2.1.4 at https://docs.oracle.com/middleware/bi12214/lcm/OBIUP/
GUID-B66A074B-37BD-44EA-9EC4-A26B94676243.htm#OBIUP-GUID-
B66A074B-37BD-44EA-9EC4-A26B94676243. 

Copying and Decompressing Install Media
To download and decompress the install media: 

1. Download the Oracle Utilities Analytics Dashboards component v2.7.0.1 (Oracle Utilities 
Analytics V2.7.0.1 Multiplatform.zip) from the Oracle Software Delivery Cloud (https://
edelivery.oracle.com). 

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (referred to 
<TEMPDIR> below). 

This directory must be located outside any current working Oracle Utilities application 
environment. All files that are placed in this directory as a part of the installation can be 
deleted after completing a successful installation. 

3. Unzip Oracle Utilities Analytics V2.7.0.1 Multiplatform.zip to <TEMPDIR>.

Starting the Installer
For an AIX operating system, set the following environment variable before starting the Oracle 
Utilities Analytics installation. 

export IBM_JAVA_OPTIONS=”-Xmx2g  -XX:PermSize=64m -
XX:MaxPermSize=3200m”

https://edelivery.oracle.com
https://edelivery.oracle.com
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To start the installer: 

1. Navigate to the temporary folder where you downloaded the install. 

Run the following command from the folder: 

java -jar <TEMPDIR>/OUA_2.7.0.1_generic.jar -logLevel finest

Note: The minimum JDK required for running the Oracle Utilities Analytics 
installer is JDK 1.8. 

2. On the Welcome page, review the information before you begin the installation. 

3. Click Next to continue with the installation. 

4. Complete the installation by following the tasks on the navigation pane. 

Each item in the navigation pane represents a specific installer screen that prompts you for 
the information required to install the software. 

Upgrade Steps
To install the Dashboards component: 

1. Run the Oracle Utilities Analytics Installer. 

2. On the Welcome page, review the available information before you begin the installation.

3. On the Installation Inventory page, provide the inventory location. Click Next. 

4. On the Languages Selection page, make sure “English” is selected. Click Next. 

5. On the Installation Location page, provide the installation location and click Next. 

Note: The specified Oracle home directory must be an empty directory or a 
directory where the OUA ODI ETL 2.7.0.1 component was installed 
successfully.

6. On the Installation Type page, select Dashboards and click Next. Enter the following 
details in the respective fields and click Next. 

Note: Based on the selected installation type, the options on the left navigation 
panel change. When you select Dashboard as an Installation Type, you need 
to define Database and Java Home Details, Target Database Connection 
Details and OBIEE Home Details.  

7. On the Target Database Connection Details page, enter the following details in the 
respective fields and click Next. 

Field Name Description Value

Database Client Home Database client home location Example:

/u01/app/product/12.1.0/
dbhome_1

Java Home JDK home location JDK 1.8 location

Field Name Description Value

Host The host name of the server 
where the database resides.

Oracle Utilities Analytics 
Database Server
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8. On the OBIEE Home Details page, enter the following details in the respective fields and 
click Next. 

Note: You will be prompted for the Weblogic user’s password after installation. 

9. On the Java Home Location page provide the Java Home details that were provided earlier. 
Click Next. 

Port The database port number on 
the database server used for 
connecting to the database.

Oracle Utilities Analytics 
Database Port. The default value 
is 1521.

Service Name The service name for the 
database

Target Schema 
Password

The password for the target 
schema (DWADM).

Confirm Target 
Schema Password 

Confirm the password for the 
target schema (DWADM) 
here.

Metadata Schema 
Password

The password for the 
metadata schema (MDADM).

Confirm Metadata 
Schema Password

Confirm the password for the 
metadata (MDADM) schema 
here.

Field Name Description Value

BI Home The location on the disk 
where OBIEE is installed.

Example:

/u01/ Middleware/Oracle_BI1

BI Domain Home The domain Home location 
under the directory where 
OBIEE is installed.

Example:

/u01/ Middleware/
user_projects/domains/
bifoundation_domain

WebLogic Host The hostname on which 
WebLogic server for OBIEE 
is running.

WebLogic Port 
Number

A unique port number within 
the system that is assigned to 
the HTTP port. 

This port number is used as a 
part of the client URL request 
to connect to the host. It is 
the OBIEE WebLogic 
console admin port number. 

Example: 7001

WebLogic User WebLogic domain login user 
name. 

Field Name Description Value
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10. On the Installation Summary page, verify the installation options and click Install to begin 
the installation. 

For any changes to the configuration before starting the installation, use the navigation pane 
and select the topic to edit. 

11. The Installation Progress page allows you to view the progress of the installation. 
Operations being performed as part of the installation are logged to the terminal from which 
the installer was run. Detailed logs of the installation are also available in the logs/system 
directory under the installation location.

To quit before the installation is complete, click Cancel. Doing so will result in a partial 
installation; the portion of the software that was installed on your system before you click 
Cancel will remain on your system, and it needs to be deleted manually. 

12. On the Installation Completed page, click Finish to close the installer. 

The Dashboards component is installed successfully.

Deploying Web Catalog
Take the backup of existing BI Publisher reports from the catalog location. After the deployBAR 
step is completed successfully, copy the BI Publisher reports (for which backup was taken) to the 
location of the catalog. 

To deploy the web catalogs: 

1. Go to the <DOMAIN_HOME>/bidata/service_instances/ssi/metadata/content/catalog/
root/shared directory.

2. Delete the existing catalogs (if any) that were delivered out-of-the-box with Oracle Utilities 
Analytics in the previous release. 

Ensure any custom catalog related files in this directory are backed up in a separate location 
before running deployBar.sh.

If Oracle Utilities Network Management System BI Publisher reports were deployed, they 
should be retained. 

3. Login to the Enterprise Manager.

4. Navigate to Coreapplication > Deployment > Repository for viewing the catalog 
location. 

5. Go to the <Catalog location>/root/system directory and remove the spatialmetadata 
directory and spatialmetadata.atr file.

6. Follow the steps as below for UNIX:

a. Navigate to <Install_Dir>/bin directory. 

cd <Install_Dir>/bin

b. Add Java 8 to the path variable as shown in example below: 

export PATH=/scratch/softwares/jdk1.8.0_201/bin:$PATH

c. Run ksh ./deployBAR.sh.

The Web catalog is successfully deployed.

Note: If there are any customizations on rpd, ensure to backup the rpd before 
executing deployBAR.sh to deploy the catalog. After deploying the catalog 
follow the instructions in Deploying Repository (RPD) File section to deploy 
RPD files. 
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For an AIX operating system, after the deployBAR.sh is completed successfully, execute the 
following command: 

cp -r ../writeback/wbtemplates/* $DOMAIN_HOME/bidata/
service_instances/ssi/metadata/content/msgdb/l_en/customMessages

Deploying Repository (RPD) File
If no changes are made to the deployed RPD, then take the RPD file from the following location, 
where <install_dir> is the Oracle Utilities Analytics Dashboard Component installation directory:

<install_dir>/Reports/rpd/ UtilitiesBusinessAnalytics.rpd

Note: If you are using the default Oracle Utilities Analytics repository, you 
must change the default password the first time you open it in the 
Administration Tool. 

If it was merged, do the required database changes with the merged RPD. Copy this RPD file to 
the Windows machine on which Oracle Business Intelligence Developer Client Tool (12.2.1.4.0) is 
installed. 

To deploy the RPD file: 

1. Ensure Oracle Business Intelligence Developer Client Tool (12.2.1.4.0) is installed on the 
Windows machine before proceeding. 

2. Click Start > Programs > Oracle Business Intelligence > Administration. 

3. Click File > Open > Offline... to open the RPD in offline mode.

4. Provide the RPD password. The default password is “oracle123”. 

5. Double-click the Connection Pools to edit them. 

• In the Init Block Connection Pool group, enter the following: 

Datasource name = BI Database name

User name = DWREAD

Password = DWREAD User password
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• In the Init Block Pool - MDM group, provide the following (only for Oracle Utilities 
Meter Data Management): 

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

• In the Init Block Pool - NMS Replication group, provide the following (only for 
Oracle Utilities Network Management System): 

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password

• In the Materialized Views Connection group, enter the following:

Datasource name = BI Database name

User name =DWREAD

Password = DWREAD User password 

• In the MDM Database Connection group, provide the following (only for Oracle 
Utilities Meter Data Management): 

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

• In the NMS Replication Tables group, provide the following (only for Oracle Utilities 
Network Management System): 

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password 

Note: The default schema name is NMS1REP. If the replication schema name is 
different, then rename it. 

• In the ODIDEV Connection Pool group, provide the following: 

Datasource name = BI database name

User name = DWUSER

Password = DWUSER User password

• In the OUBI Database Connection group, provide the following: 

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password
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6. Click Save. 

Note: Click Yes when you see the prompt 'Do you wish to check global consistency?' 
and ignore any warnings that appear after consistency check is complete. 

7. Copy the modified RPD back to the <install dir>/Reports/rpd/
UtilitiesBusinessAnalytics.rpd where <install_dir> is the Oracle Utilities Analytics Dashboard 
Component installation directory.

8. Login to the server where OBIEE is installed. 

9. Navigate to <OBIEE DOMAIN>/bitools/bin.

10. Run the following command to deploy the RPD: 

In Unix: 

./datamodel.sh uploadrpd -I <OUA home>/Reports/rpd/
UtilitiesBusinessAnalytics.rpd -W <rpd password, default 
password is oracle123> -U <Weblogic user name of OBIEE domain> -
P <Weblogic password of OBIEE domain> -SI ssi 

11. Run the following commands from <OBIEE DOMAIN>/bitools/bin directory to stop and 
start the OBIEE domain services respectively. 

./stop.sh 

./start.sh 

Note: Since OBIEE 12.2.1.4 Mapviewer is not supported on AIX platforms, 
the Mapviewer URL is not accessible. 
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Chapter 7
Installing Demo Database

This chapter provides instructions to install the demo database. 

Note: The demo installation does not support ETL functionality. The ETL 
Job Control dashboard accesses Oracle Data Integrator tables, and the demo 
dump does not have Oracle Data Integrator objects. Hence, the ETL 
dashboard is not supported in the demo installation. 

• Installing Oracle Utilities Analytics Demo Database Component

• Installing Oracle Utilities Analytics Dashboards Component
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Installing Oracle Utilities Analytics Demo Database Component
This section describes how to install the demo database component of Oracle Utilities Analytics, 
including: 

• Copying and Decompressing Install Media

• Creating Database and Importing the Dump File

• Configuring Security

• Configuring Spatial Data

Copying and Decompressing Install Media
To copy and decompress install media: 

1. Download Oracle Utilities Analytics v2.7.0.1 Oracle Demo Data part from the 
Oracle_Utilities_Analytics_v2.7.0.1_Demo_Data.zip file. 

Download the zip from Oracle Software Delivery Cloud (https:// edelivery.oracle.com).

2. Create a temporary directory. 

For example: In Linux:
/OUA/temp

This directory (referred as <TEMPDIR>) should be located outside any current working 
Oracle Utilities application environment. After a successful installation, delete all files in this 
directory that are part of the installation. 

3. Unzip Oracle_Utilities_Analytics_v2.7.0.1_Demo_Data.zip to <TEMPDIR> using any 
zip utility.

The installation media is decompressed successfully. Proceed with creating the database. 

Creating Database and Importing the Dump File
This section describes how to create the demo database with AL32UTF8 character set using dbca. 
It includes the following: 

• Importing Demo Data Manually

• Post-Import Tasks

Ensure that Oracle Database Server Enterprise Edition 18.3 is already installed on the machine to 
create the database. 

Create at least one tablespace for storing the application objects before running the installation. 
The default name of the application tablespace is CISTS_01. 

1. Create database using the dbca utility. 

2. Run users.sql under <TEMPDIR>/BI2701/Demo directory after replacing tablespace name 
as required. 

3. Create the database directory in the database. 

Example: create directory dump_dir as '/scratch/dumps'; 

Note: If the following error messages occur while importing the demo data; it 
is recommended to ignore them. 

ORA-31684: Object type USER:”MDADM” already exists

ORA-31684: Object type USER:”RELADM” already exists

https:// edelivery.oracle.com
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ORA-31684: Object type USER:”DWADM” already exists
Failing sql is:
CREATE INDEX "DWADM"."STATES54004_SDX" ON "DWADM"."STATES54004" 
("GEOMETRY")  INDEXTYPE IS "MDSYS"."SPATIAL_INDEX" PARALLEL 1
Failing sql is:
CREATE INDEX "DWADM"."Q1_STATES54004_SDX" ON 
"DWADM"."Q1_STATES54004" ("GEOMETRY")  INDEXTYPE IS 
"MDSYS"."SPATIAL_INDEX" PARALLEL 1
ORA-39083: Object type INDEX:"DWADM"."STATES54004_SDX" failed 
to create with error:
ORA-29855: error occurred in the execution of ODCIINDEXCREATE 
routine
ORA-39082: Object type VIEW:"MDADM"."B1_JOBS_VW" created with 
compilation warnings
ORA-39082: Object type VIEW:"MDADM"."B1_CONTEXT_CFG_VW" created 
with compilation warnings

Ignore any errors related to grants, views or spatial indexes.

Importing Demo Data Manually
To import demo data manually: 

1. After the successful database creation, import the Demo data. Run the commands from the 
database server. 

Note: Ensure to change the tablespace_name to the tablespace name on which 
DWADM, RELADM, and MDADM have the quota. If DWADM, RELADM, 
and MDADM users have quota on cists_01 tablespace, then exclude whole 
remap_tablespace clause from the command. 

a. Set the correct ORACLE_SID and ORACLE_HOME. Run the below command to 
import demo dump.

Note: Gunzip the exp_demo.dmp.gz to obtain exp_demo.dmp. 

impdp directory=dump_dir dumpfile=exp_demo.dmp 
logfile=exp_demo.log schemas=DWADM,RELADM,MDADM 
remap_tablespace=cists_01:<tablespace_name>

b. Provide the user as system and system user’s password when prompted. 

Post-Import Tasks
Connect to MDADM schema and execute the following commands: 

create public synonym B1_TARGET_ENTITY for B1_TARGET_ENTITY;
create public synonym B1_PROD_INSTANCE for B1_PROD_INSTANCE;
create public synonym B1_JOB_CONFIG for B1_JOB_CONFIG;

grant select on B1_TARGET_ENTITY to public;
grant select on B1_PROD_INSTANCE to public;
grant select on B1_JOB_CONFIG to public;

Configuring Security 
The security scripts have to be executed after the initial load and the Materialized views are created 
for the given source product instance. 

To configure the security: 

1. In the Oracle Utilities Analytics database component installation package, navigate to the 
..\BI2701\DWADM\Install-Upgrade\ folder. 
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2. Run OraGenSec. 

In Unix environment:

a. Add Java 8 to path variable as shown in example below:

export PATH=/scratch/softwares/jdk1.8.0_201/bin:$PATH

b. Set classpath pointing to OraDBI.jar and all dependency jars.

export CLASSPATH=<Path to BI2701>/BI2701/DWADM/Jarfiles/*

c. Run OraGenSec. 

java com.oracle.ouaf.oem.install.OraGenSec -d 
DWADM,DWADM,jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE 
PORT>/<ORACLE SERVICE NAME> -u DWUSER,DWREAD -r DW_USER,DW_READ 
-p DWUSER,DWREAD -a A CAPTION:Configuring Security LANGUAGE:ALL

Configuring Spatial Data
This section describes how to load spatial metadata in the USER_SDO* tables for Oracle Utilities 
Analytics. 

Use the following procedure to load spatial metadata in the target database:

1. Create the dump_dir directory in the database and copy the user_sdo.dmp file from ../
BI2701/Spatial-Metadata folder to that location.

2. Import the released spatial tables to the target database. 

impdp directory=dump_dir dumpfile=user_sdo.dmp logfile=
impdp_user_sdo.log schemas=DWADM
remap_tablespace=cists_01:<tablespace_name>

Note: Run this command from database server. Ensure to change the 
tablespace_name to tablespace name on which DWADM has the quota. If 
DWADM user have quota on cists_01 tablespace, then exclude whole 
remap_tablespace clause from command.

3. Review the impdp_user_sdo.log file to ensure the tables are imported successfully.

4. After importing the tables, run the following SQL scripts from the ../BI2701/Spatial-
Metadata folder. 

sqlplus dwadm/<dwadm user password>@database-name 
@copy_spatial_metadata.sql

sqlplus dwadm/<dwadm user password>@database-name 
@clean_sdo_release_tbls.sql

5. Review the log files.

Installing Oracle Utilities Analytics Dashboards Component
Note: Ensure that the same operating system user to install the prerequisite 
software is used to install the Oracle Utilities Analytics Dashboards component 
as well. 

The Oracle Utilities Analytics Dashboards component is installed on the Oracle Utilities Analytics 
application server. This section describes how to install the dashboards component of Oracle 
Utilities Analytics. 

• Copying and Decompressing Install Media
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• Starting the Installer

• Installation Steps

• Deploying Web Catalog

• Deploying the Repository (RPD) File

• Configuring and Deploying the MapViewer

• Updating MapViewer Configuration

• Enabling WriteBack

• Enabling Auto Complete Feature in OBIEE

Copying and Decompressing Install Media
To download and decompress the install media:

1. Download the Oracle Utilities Analytics Dashboards component v2.7.0.1 (Oracle Utilities 
Analytics V2.7.0.1 Multiplatform.zip) from the Oracle Software Delivery Cloud (https://
edelivery.oracle.com). 

2. Create a temporary directory, such as /OUA/temp (referred to <TEMPDIR> below). 

This directory must be located outside any current working Oracle Utilities application 
environment. All files that are placed in this directory as a part of the installation can be 
deleted after completing a successful installation. 

3. Unzip Oracle Utilities Analytics V2.7.0.1 Multiplatform.zip to <TEMPDIR>.

Starting the Installer
For an AIX operating system, set the following environment variable before starting the Oracle 
Utilities Analytics installation: 

export IBM_JAVA_OPTIONS=”-Xmx2g  -XX:PermSize=64m -
XX:MaxPermSize=3200m”

To start the installer:

1. Navigate to the temporary folder where you downloaded the install. Run the following 
command from the folder: 

java -jar <TEMPDIR>/OUA_2.7.0.1.0_generic.jar -logLevel finest

Note: The minimum JDK required for running the Oracle Utilities Analytics 
installer is JDK 1.8. 

2. On the Welcome page, review the information before you begin the installation.

3. Click Next to continue with the installation. 

4. Complete the installation by following the tasks on the navigation pane. 

Each item in the navigation pane represents a specific installer screen that prompts you for 
the information required to install the software. 

Installation Steps
To install the Dashboards component: 

1. Run the Oracle Utilities Analytics Installer. 

2. On the Welcome page, review the available information before you begin the installation. 

https://edelivery.oracle.com
https://edelivery.oracle.com
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3. On the Installation Inventory page, provide the inventory location. Click Next. 

4. Click Next to continue with the installation. 

5. On the Installation Location page, define the Installation Location. Click Next. 

Note: The specified Oracle home directory must be an empty directory or a 
directory where the OUA ODI ETL 2.7.0.1.0 component was installed 
successfully.

6. On the Languages Selection page, select “English”. Click Next.

7. On the Select Installation Type page, select Dashboards. Click Next. 

Note: Based on the selected installation type, the options on the left navigation 
panel change. When you select Dashboard as an Installation Type, you need 
to define Database and Java Home Details, Target Database Connection 
Details and OBIEE Home Details. 

8. On the Database and Java Home Details page, enter the following details in the respective 
fields and click Next. 

The Target Database Connection Details page appears. 

9. Enter the following details in the respective fields and click Next. 

Field Name Description Value

Database Client Home Database client home location Example:

/u01/app/product/18.3/
dbhome_1

Java Home JDK home location JDK 1.8 location
Example:

/u01/jdk_1.8.0_201

Field Name Description Value

Host The host name of the server 
where the database resides.

Oracle Utilities Analytics 
Database Server

Port The database port number on 
the database server used for 
connecting to the database.

Oracle Utilities Analytics 
Database Port. The default value 
is 1521.

Service Name The service name for the 
database

Target Schema 
Password

The password for the target 
schema (DWADM).

Confirm Target 
Schema Password 

Confirm the password for the 
target schema (DWADM) 
here.

Metadata Schema 
Password

The password for the 
metadata schema (MDADM).
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The OBIEE Home Details page appears. 

10. Enter the following details in the respective fields and click Next. 

Note: You will be prompted for the WebLogic user’s password after 
installation. 

11. On the Java Home Location page, enter the Java Home details provided earlier. Click Next. 

12. On the Installation Summary page, verify the installation options and click Install to begin 
the installation. 

For any changes to the configuration before starting the installation, use the navigation pane 
and select the topic to edit. 

13. The Installation Progress page allows you to see the progress of the installation. Operations 
being performed as part of the installation are logged to the terminal from which the installer 
was run. Detailed logs of the installation are also available in the logs/system directory under 
the installation location.

To quit before the installation is complete, click Cancel. Doing so will result in a partial 
installation; the portion of the software that was installed on your system before you click 
Cancel will remain on your system, and it needs to be deleted manually. 

14. On the Installation Completed page, click Finish to close the installer. 

The Dashboards component is now installed successfully. 

Confirm Metadata 
Schema Password

Confirm the password for the 
metadata (MDADM) schema 
here.

Field Name Description Value

BI Home The location on the disk 
where OBIEE is installed.

Example:

/u01/ Middleware/Oracle_BI1

BI Domain Home The domain Home location 
under the directory where 
OBIEE is installed.

Example:

/u01/ Middleware/
user_projects/domains/
bifoundation_domain

WebLogic Host The hostname on which 
WebLogic server for OBIEE 
is running.

WebLogic Port 
Number

A unique port number within 
the system that is assigned to 
the HTTP port. 

This port number is used as a 
part of the client URL request 
to connect to the host. It is 
the OBIEE WebLogic 
console admin port number. 

Example: 9500

WebLogic User WebLogic domain login user 
name. 

Field Name Description Value
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Deploying Web Catalog
Take the backup of existing BI Publisher reports from the catalog location. After the deployBAR 
step is completed successfully, copy the BI Publisher reports (for which backup was taken) to the 
location of the catalog. 

To deploy the web catalog: 

1. Go to the <DOMAIN_HOME>/bidata/service_instances/ssi/metadata/content/catalog/
root/shared directory. 

2. Delete the existing catalogs (if any) that were delivered out-of-the-box with Oracle Utilities 
Analytics in the previous release. 

Ensure any custom catalog related files in this directory are backed up in a separate location 
before running deployBar.sh.

If Oracle Utilities Network Management System BI Publisher reports were deployed they 
should be retained. 

3. Follow the steps as below for UNIX:

a. Navigate to <Install_Dir>/bin directory. 

cd <Install_Dir>/bin

b. Add Java 8 to the path variable as shown in example below: 

export PATH=/scratch/softwares/jdk1.8.0_201/bin:$PATH

c. Run ksh ./deployBAR.sh.

The Web catalog is successfully deployed. 

For an AIX operating system, after the deployBAR.sh is completed successfully, execute the 
following command: 

cp -r ../writeback/wbtemplates/* $DOMAIN_HOME/bidata/
service_instances/ssi/metadata/content/msgdb/l_en/customMessages

Deploying the Repository (RPD) File
The RPD file is available in the following location, where <install_dir> is the Oracle Utilities 
Analytics Dashboard Component installation directory: 

<install_dir>/Reports/rpd/ UtilitiesBusinessAnalytics.rpd 

Note: If you are using the default Oracle Utilities Analytics repository, you 
must change the default password the first time you open it in the 
Administration Tool. 

To deploy the RPD file: 

1. Ensure that Oracle Business Intelligence Developer Client Tool (12.2.1.4.0) is installed on the 
Windows machine before proceeding. 

2. Click Start > Programs > Oracle Business Intelligence > Administration. 

3. Click File > Open > Offline... to open the RPD in offline mode.

4. Provide the RPD password. The default password is “oracle123”. 
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5. Double-click the Connection Pools to edit them. 

• In the Init Block Connection Pool group, enter the following: 

Datasource name = BI Database name

User name = DWREAD

Password = DWREAD User password

• In the Init Block Pool - MDM group, provide the following (only for Oracle Utilities 
Meter Data Management): 

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

• In the Init Block Pool - NMS Replication group, provide the following (only for 
Oracle Utilities Network Management System): 

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password

Note: The schema name is NMS1REP by default. Rename it if the replication 
schema name is different.

• In the Materialized Views Connection group, enter the following:

Datasource name = BI Database name

User name =DWREAD

Password = DWREAD User password 

• In the MDM Database Connection group, provide the following (only for Oracle 
Utilities Meter Data Management): 

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password
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• In the NMS Replication Tables group, provide the following (only for Oracle Utilities 
Network Management System): 

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password

Note: The default schema name is NMS1REP. If the replication schema name is 
different, then rename.

• In the ODIDEV Connection Pool group, provide the following: 

Datasource name = BI database name

User name = DWUSER

Password = DWUSER User password

• In the OUBI Database Connection group, provide the following: 

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password

6. Click Save. 

Note: Click Yes when you see the prompt 'Do you wish to check global consistency?' 
and ignore any warnings that appear after consistency check is complete. 

7. Copy the modified RPD back to the <install dir>/Reports/rpd/
UtilitiesBusinessAnalytics.rpd where <install_dir> is the Oracle Utilities Analytics Dashboard 
Component installation directory.
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8. Login to the server where OBIEE Enterprise Manager is installed. 

9. Navigate to <OBIEE DOMAIN>/bitools/bin.

10. Run the following command to deploy the RPD: 

In Unix: 

./datamodel.sh uploadrpd -I <OUA home>/Reports/rpd/
UtilitiesBusinessAnalytics.rpd -W <rpd password, default 
password is oracle123> -U <Weblogic user name of OBIEE domain> -
P <Weblogic password of OBIEE domain> -SI ssi 

11. Run the following commands from <OBIEE DOMAIN>/bitools/bin directory to stop and 
start the OBIEE domain services respectively. 

./stop.sh 

./start.sh 

Configuring and Deploying the MapViewer 
Configuring and deploying the MapViewer involves the following tasks: 

• Configuring the MapViewer

• Modifying instanceconfig.xml 

Configuring the MapViewer 
To configure the Mapviewer, follow these steps: 

1. Login to the WebLogic console. 

2. Create the 'MAP_DS' datasource. 

3. Lock and edit it. 

4. Navigate to Services > Data Sources. 

5. Select New > Generic Data Source and provide the following: 

Name = MAP_DS

JNDI Name = MAP_DS 

Database Type = oracle

6. Click Next.

7. Enter the following: 
Database Driver = *Oracle’s Driver (Thin) for Service connections; Versions:Any

8. Click Next. 

9. On the next page, do not change any values. Click Next.

10. Enter the following connection properties: 

• Database Name: BI Database Name 

• Host Name: Database host 

• Port: Database port

• Database User Name: dwadm

• Password: dwadm password

11. Click Next.
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12. On the next page, click Test Configuration. After the successful test click Next. 

13. On the Select Target page, select AdminServer under Servers and bi_cluster under 
Clusters. Click Finish. 

14. Click Activate Changes. 

15. Update the mapViewerConfig file with the tags mentioned below: 

File location: <Install Dir> 
/user_projects/domains/<obiee_domain>/config/fmwconfig/mapviewer/conf 

File: mapViewerConfig.xml 

16. If there is a proxy used, insert the list of host names for all the third-party service providers in 
the security_config node. 

<proxy_enabled_hosts>
elocation.oracle.com
</proxy_enabled_hosts>

17. Add the following ns_data_provider node: 

<ns_data_provider id="obieeNsdp" 
class="com.oracle.utilities.birdseye.BirdseyeNSDP" />

18. Add the current map_tile_server with the following map_tile_server node: 

<map_tile_server>
<tile_storage default_root_path="/mytilecache/"/>
</map_tile_server>

Modifying instanceconfig.xml 
Ensure you take a backup before updating the instanceconfig.xml file. Run the following 
commands in UNIX to go to the directory containing the instanceconfig.xml file. 

In Unix: 

<OBIEE_INSTALL_DIR>/user_projects/domains/<obiee_domain>/config/
fmwconfig/biconfig/OBIPS

Perform the following changes to the instanceconfig.xml file: 

1. Update the security node with the following values. If the security node is not present, add 
the following code before </Serverinstance>: 

<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies>
<CookieDomain />
<CookiePath>/</CookiePath>
</Security>

2. Update the following <ServerInstance> element:

<LightWriteback>true</LightWriteback>

3. Add the following code between the <ServerInstance> </ServerInstance> tags. 

<Prompts> 
<MaxDropDownValues>256</MaxDropDownValues> 
<AutoApplyDashboardPromptValues>true</AutoApplyDashboardPromptValues> 
<AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox> 
<AutoCompletePromptDropDowns> 
<SupportAutoComplete>true</SupportAutoComplete> 
<CaseInsensitive>true</CaseInsensitive> 
<MatchingLevel>MatchAll</MatchingLevel> 
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<ResultsLimit>50</ResultsLimit> 
</AutoCompletePromptDropDowns> 
</Prompts>
<SpatialMaps>
<MapViewerAPIV2Enabled>false</MapViewerAPIV2Enabled>
</SpatialMaps>

Updating MapViewer Configuration
Note: The Mapviewer URL is not accessible in AIX environment since it is not 
supported. Skip the following steps in AIX platforms.

To update the MapViewer configuration: 

1. Login to MapViewer. 

http://<Server>:<port>/mapviewer 

2. To update the MapViewer configuration, navigate to MapViewer > Administration > 
Configuration. Login to the Mapviewer at this location: 

http://<HOST>:<MANAGERPORT>/mapviewer

3. Add the below code in the mapViewerConfig.xml with the appropriate values: 

<map_data_source name="mapconn"
jdbc_host="<DB server name>"
jdbc_sid="//<DB Service name>"
jdbc_port="1521"
jdbc_user="DWADM"
jdbc_password="!<DWADM user password>" 
jdbc_mode="thin"
number_of_mappers="32"
allow_jdbc_theme_based_foi="true"
/>

4. Click Save and restart.

Enabling WriteBack
To enable the Write Back: 

1. Login to Analytics.

2. Navigate to Administration > Manage Privileges > WriteBack > Write Back to 
Database. 

3. Click Denied:Authenticated User and select the Granted permission. 

Enabling Auto Complete Feature in OBIEE 
To enable the auto complete feature in OBIEE: 

1. Restart the OBIEE services. 

Note: Refer to OBIEE documentation for detailed instructions on how to start 
and stop OBIEE services.

2. Login to Oracle Utilities Analytics. 

http://<Server>:<port>/analytics

3. Click WebLogic User (top-most-right section of the page). 

4. From the drop-down menu, select My Account. 

http://<Server>:<port>/mapviewer
http://<Server>:<port>/mapviewer
http://<Server>:<port>/mapviewer
http://<HOST>:<MANAGERPORT>/mapviewer
http://<Server>:<port>/analytics
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5. On the Preferences tab, set Prompt Auto Complete to ON.

3. Click OK. 
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Chapter 8
Configuring Spatial Data

This chapter contains information on how to setup spatial data for the Oracle Business 
Intelligence Enterprise Edition dashboards in Oracle Utilities Analytics and how to set up the 
spatial data. The mapping between the spatial columns and the dimensional columns, such as City, 
State from the Address dimension is defined in the spatial metadata catalog, which is available as a 
part of the Web Catalog component in Oracle Utilities Analytics. Using the spatial data and the 
map metadata, users can view the star schema data in on the map reports delivered out-of-the-box 
as part of Oracle Utilities Analytics.

The chapter focuses on the following:

• Acquiring the Spatial Data

• Installing Spatial Data

• Importing Spatial Data into Oracle Utilities Analytics Spatial Data Tables

• Loading the Oracle Utilities Specific Themes
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Acquiring the Spatial Data
Oracle Utilities Analytics does not include any spatial data. The spatial data can be loaded from the 
various third party vendors. Some of the spatial data vendors who partner with Oracle can be 
found in the below Oracle Technology Network page:

http://www.oracle.com/technetwork/database/options/spatialandgraph/community/partners/
spatial-partners-095101.html

Some of these vendors might require you to purchase a separate license for the spatial data. You 
need to get in touch with the vendor directly for the same. After this, you would be able to 
download a spatial data dump from the spatial data vendor.

Installing Spatial Data
The spatial data acquired from a third party vendor can be in various formats. Typical vendors 
provide shape files (.shp) or a database dump for download. The exact spatial data model varies 
from vary to vendor and there is no generic format to this. Hence, the documentation that comes 
along with the spatial data is of utmost importance. This is required to identify what type of spatial 
data is available in which table. 

The first task is to import the data in the shape file into the DWADM schema. A database dump 
can be imported by the standard oracle impdp command. A shape file can also contain the spatial 
data tables along with the data that can be imported by Oracle MapBuilder. 

Follow the steps mentioned below for this:

1. Unzip the .zip file (Typically, the shape file is zipped for data compression) to a temp 
directory. 

For example: /u01/Spatial/ 

2. Download the standalone MapBuilder application from this site: 
http://www.oracle.com/technetwork/middleware/mapviewer/downloads/index-
100641.html

3. Start the MapBuilder. 

Note: Refer to the MapViewer documentation for detailed instructions on 
installing and running MapBuilder from this site: http://www.oracle.com/
technetwork/middleware/mapviewer/documentation/index.html

4. Create a connection to the DWADM schema in the Oracle Utilities Analytics Data 
Warehouse database by navigating to File > New Connection.

5. Navigate to Tools > Import Shapefile, and click Next.

6. Click the Shapefile.

7. Browse to the C:\Spatial directory, select the .shp file, and click Open.

8. Click Next.

9. Ensure the Create Predefined Theme box is unchecked, and click Next.

http://www.oracle.com/technetwork/database/options/spatialandgraph/community/partners/spatial-partners-095101.html
http://www.oracle.com/technetwork/database/options/spatialandgraph/community/partners/spatial-partners-095101.html
http://www.oracle.com/technetwork/middleware/mapviewer/downloads/index-100641.html
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10. Review the summary information and click Finish. A sample screenshot is shown below.

Importing Spatial Data into Oracle Utilities Analytics Spatial Data 
Tables

Once the spatial data tables from an third party vendor have been imported into the DWADM 
schema, the next step is to import the spatial data needed by Oracle Utilities Analytics into certain 
specific tables. This step to import a certain subset of the data into a standardized set of Oracle 
Utilities Analytics tables is for decoupling. This decoupling helps the Oracle Business Intelligence 
Enterprise Edition map reports and other Oracle Business Intelligence Enterprise Edition map 
configuration to remain oblivious to the variations in the spatial data schema coming from various 
vendors. This way you need not touch any of the spatial metadata catalog or modify any of the 
map reports being delivered out-of-the-box. 

Oracle Utilities Analytics needs the administrative boundary type of spatial data at four levels - 
State, City, County and Postal Code. All map reports in Oracle Utilities Analytics are using one of 
these levels. Since the spatial data model varies from vendor to vendor, further details provided in 
this section is based on a sample spatial data from a specific vendor.

The following sections describe how the import the data based on a sample spatial data dump 
provided by HERE maps (formerly NAVTEQ).This sample data set contains administrative 
boundary data for the OHIO city in the US country. The sample data set from the Oracle partner 
can be downloaded from the Oracle Utilities Analytic's OTN (Oracle Technology Network) page:

http://www.oracle.com/technetwork/database/options/spatialandgraph/downloads/spatial-
partners-data-087203.html

However, the steps can be used with a little variation to setup the spatial data for Oracle Utilities 
Analytics for any city from any country. The extent of the changes need to be done varies based 
on the vendor used to purchase the spatial data. Read through the documentation of the spatial 
data model provided by the vendor to understand what type of data lies in what table. 

http://www.oracle.com/technetwork/database/options/spatialandgraph/downloads/spatial-partners-data-087203.html
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Below table provides a simple mapping based on the HERE maps sample data.

Apart from these four levels, there are also some standard themes and styles that need to be 
imported. 

Below sub-sections contain the SQL statements to create and populate the various spatial data 
tables for Oracle Utilities Analytics. The prerequisite is that spatial data has been purchased by you 
and the spatial data dump has been imported into the DWADM schema. It is assumed that the 
eLocation website is being used as the base map in the Oracle Business Intelligence Enterprise 
Edition mapviewer setup, for which the SRID (Spatial Reference System Identifier) is 54004. The 
SRID is a unique value used to identify the coordinate system used in a Geographic Information 
System (GIS) application. If some other base map is used, then the transform parameter in the 
insert statements should specify the SRID of the base map being used.

Importing Theme Related Spatial Data into Oracle Utilities Analytics
The sdo_ tables are standard tables expected to be present in the spatial data from any vendor.

INSERT INTO user_sdo_maps SELECT * FROM sdo_maps;
INSERT INTO user_sdo_themes SELECT * FROM sdo_themes;
INSERT INTO user_sdo_styles SELECT * FROM sdo_styles;
INSERT INTO user_sdo_cached_maps SELECT * FROM sdo_cached_maps;

Importing State Spatial Data into Oracle Utilities Analytics
In Oracle Utilities Analytics, the table Q1_STATES54004 is used to store the state related 
administrative boundary. Create the table based on the DDL below and insert the values from one 
of the spatial data tables obtained from the vendor.

CREATE TABLE Q1_STATES54004
 (
    feature_id     NUMBER,
    feature_name   VARCHAR2(255),
    area_id        NUMBER,
    name_langcode  VARCHAR2(35),
    feature_type   VARCHAR2(30),
    country_code_3 VARCHAR2(5),
    geometry SDO_GEOMETRY,
    carto_id NUMBER(10,0)
 );

INSERT INTO Q1_STATES54004_SDX
SELECT NULL,  name,  NULL,  lang_code,  feature_type,  
ISO_COUNTRY_CODE,  sdo_cs.transform(geometry, 3857),  carto_id
FROM WOM_AREA WHERE feature_type = 909996 AND iso_country_code = 
'ISO'; 

Spatial 
Data Level

Table in Navteq
Sample Data Additional Filters

Oracle Utilities 
Analytics Spatial 
Data Table

State WOM_AREA Feature Type = 90996

ISO Country Code = 
‘USA’

Q1_STATES54004

City PL39_d00 Q1_CITY54004 lsad_trans = 'city', 
’village'

County CO39_D00 Q1_COUNTY54004

Postal Code ZT39_D00 Q1_USZIP54004
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Note: Customize the table name WOM_AREA, the feature type value and the 
ISO country code as per the spatial data model obtained by you. The below 
insert statement is to define the Q1_ table as a spatial table and update the 
spatial metadata view to reflect the dimensional information for the areas. The 
parameters for the insert statement are table name, geometry column name, 
and X and Y boundaries (the latitude and the longitude) based on the data and 
the tolerance value.

INSERT INTO user_sdo_geom_metadata VALUES
('Q1_STATES54004', 'GEOMETRY', 
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)), 3857 );

CREATE INDEX Q1_STATES54004_SDX ON Q1_STATES54004 (geometry)  
indextype IS MDSYS.SPATIAL_INDEX;

Importing City Spatial Data into Oracle Utilities Analytics
In Oracle Utilities Analytics, the table Q1_CITY54004 is used to store the city related 
administrative boundary. Create the table based on the DDL below and insert the values from one 
of the spatial data tables obtained from the vendor.

CREATE TABLE Q1_CITY54004 AS
SELECT upper(name) FEATURE_NAME,  sdo_cs.transform(geometry, 3857) 
geometry,  'OHIO' state FROM pl39_d00 WHERE lsad_trans IN ('city', 
'village');

Note: Customize the table name pl39_d00 and additional filters as per the 
spatial data model obtained by you. Map the state name dynamically for the 
current city record in the spatial data. The below insert statement is to define 
the Q1_ table as a spatial table and update the spatial metadata view to reflect 
the dimensional information for the areas. The parameters for the insert 
statement are table name, geometry column name, and X and Y boundaries 
(the latitude and the longitude) based on the data and the tolerance value.

INSERT INTO user_sdo_geom_metadata VALUES
('Q1_CITY54004', 'GEOMETRY',  
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)),  3857 );
  
CREATE INDEX Q1_CITY54004_sdx ON Q1_CITY54004  (geometry) indextype 
IS MDSYS.SPATIAL_INDEX;

UPDATE Q1_CITY54004 SET geometry = 
SDO_UTIL.RECTIFY_GEOMETRY(geometry, .05);

Importing County Spatial Data into Oracle Utilities Analytics
In Oracle Utilities Analytics, the table Q1_COUNTY54004 is used to store the county related 
administrative boundary. Create the table based on the DDL below and insert the values from one 
of the spatial data tables obtained from the vendor.

CREATE TABLE Q1_COUNTY54004 AS
SELECT name FEATURE_NAME,  sdo_cs.transform(geometry, 3857) 
geometry, 'OHIO' state FROM CO39_D00;
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Note: Customize the table name CO39_D00 as per the available spatial data 
model. The below insert statement is to define the Q1_ table as a spatial table 
and update the spatial metadata view to reflect the dimensional information for 
the areas. The parameters for the insert statement are table name, geometry 
column name, and X and Y boundaries (the latitude and the longitude) based 
on the data and the tolerance value.

INSERT INTO user_sdo_geom_metadata VALUES
('Q1_COUNTY54004', 'GEOMETRY',  
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)),  3857 );

CREATE INDEX Q1_COUNTY54004_sdx ON q1_county54004 (geometry)  
indextype IS MDSYS.SPATIAL_INDEX;

UPDATE Q1_COUNTY54004 SET geometry = 
SDO_UTIL.RECTIFY_GEOMETRY(geometry, .05);

Importing Postal Code Spatial Data into Oracle Utilities Analytics
In Oracle Utilities Analytics, the table Q1_USZIP54004 is used to store the county related 
administrative boundary. Create the table based on the DDL below and insert the values from one 
of the spatial data tables obtained from the vendor.

CREATE TABLE Q1_USZIP54004 AS
SELECT zcta ZCTA5CE, sdo_cs.transform(geometry, 3857) geom. FROM 
ZT39_D00;

Note: Customize the table name ZT39_D00 as per the available spatial data 
model. The below insert statement is to define the Q1_ table as a spatial table 
and update the spatial metadata view to reflect the dimensional information for 
the areas. The parameters for the insert statement are table name, geometry 
column name, and X and Y boundaries (the latitude and the longitude) based 
on the data and the tolerance value. 

INSERT INTO user_sdo_geom_metadata VALUES
('Q1_USZIP54004', 'GEOM',  
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)),  3857 );

CREATE INDEX Q1_USZIP54004_SDX ON Q1_USZIP54004 (geom)  indextype 
IS MDSYS.SPATIAL_INDEX;

UPDATE Q1_USZIP54004 SET geom = SDO_UTIL.RECTIFY_GEOMETRY(geom, 
.05);

Improving Performance by Prefetching the Map Tiles 
Rendering map tiles dynamically can affect system performance. To avoid this, you may consider 
prefetching tiles by issuing an admin request to MapViewer on a non-production server or when 
the server is not under load. When MapViewer receives a prefetching request, it issues many 
concurrent map tile requests to itself, which are basically XML map requests, and stores them in 
the cache. This improves the system’s performance as the images are readily available.

Follow the following procedure to prefetch map tiles. These instructions are for MapViewer 
11.1.1.9.1 version. If you are using a different version, refer to the MapViewer documentation for 
instructions. 
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1. In the MapViewer console, click Admin in the top-right corner of the page and log into the 
Admin Console page.

2. In the Admin Console page, click Management > Manage Map Tile Layers.

3. Select the required online map tile and click View map/Manage Tiles.

The Prefetching wizard opens:

4. Enter the X, Y coordinates of the center of the map, the SRID and zoom level, and click 
Show Map. 

To prefetch map images, enter the latitude and longitude values. You need to know the 
latitude and longitude values of the center of the location in interest. The SRID is a unique 
value used to identify the coordinate system used in a GIS application. 

The X and Y axis used in the following example is for Ohio:

5. When you see the map, turn on the Area Selection tool and select the area on the map for 
which you want to prefetch the tiles.

6. Select one or more zoom-levels for which you want to prefetch the tiles.

Loading the Oracle Utilities Specific Themes
This section describes how to load spatial metadata in the USER_SDO* tables for Oracle Utilities 
Analytics. 

Use the following procedure to load spatial metadata in the target database:

1. Create the dump_dir directory in the database and copy the user_sdo.dmp file from ../
BI270/Spatial-Metadata folder to that location.

2. Import the released spatial tables to the target database using the following command:

impdp directory=dump_dir dumpfile=user_sdo.dmp logfile=
impdp_user_sdo.log schemas=DWADM
remap_tablespace=cists_01:<tablespace_name>

Note: Run this command from database server.
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Make sure to change the tablespace_name to tablespace name on which 
DWADM has the quota. If DWADM user have quota on cists_01 tablespace, 
then exclude whole remap_tablespace clause from command.

3. Review the impdp_user_sdo.log file to ensure the tables are imported successfully.

4. After importing the tables, run the following SQL scripts from the ../BI2701/Spatial-
Metadata folder:

sqlplus dwadm/<dwadm user password>@database-name 
@copy_spatial_metadata.sql

sqlplus dwadm/<dwadm user password>@database-name 
@clean_sdo_release_tbls.sql

5. Review the log files.

Additional Setup for Oracle Utilities Outage Analytics
The Outage Analytics product within Oracle Utilities Analytics needs some additional spatial data 
setup. The reason is that Outage Analytics alone uses point information from spatial data for 
plotting outage event related information on maps. This section should be skipped if NMS is not 
one of the source systems for Oracle Utilities Analytics.

The very first step is to replicate the DIAGRAM_OBJECTS table into the Oracle Utilities 
Analytics database. However, a suitable mechanism needs to be built to refresh this table with the 
latest data from Oracle Utilities Network Management System whenever there are changes in the 
source system.

Once this is done, then after replicating the DIAGRAM_OBJECTS table, the following steps set 
the Oracle Utilities Analytics dashboards up to use the data in this replicated table.

1. Create the required spatial metadata:

INSERT INTO user_sdo_geom_metadata
VALUES ('DIAGRAM_OBJECTS','LL_GEOMETRY', 
MDSYS.SDO_DIM_ARRAY (

SDO_DIM_ELEMENT ('X', -20037508, 20037508, .05), 
SDO_DIM_ELEMENT ('Y', -45884542, 45884542, .05)

), 3857);

2. Ensure that the spatial index is created on the LL_GEOMETRY column. The 
LL_GEOMETRY column by default stores spatial data using SRID 54004, so this works 
without changes with the eLocation base map:

create index Q1_DIAGRAM_OBJECTS_SDX
on diagram_objects (ll_geometry)
indextype is mdsys.spatial_index;

Once DIAGRAM_OBJECTS table is replicated to the Oracle Utilities Analytics database, follow 
the below steps to create Q1_DIAGRAM_OBJECTS_54004 table:

1. Connect to the DWADM schema of Oracle Utilities Analytics database and execute the 
following:

CREATE TABLE Q1_DIAGRAM_OBJECTS_54004 as select * from 
DIAGRAM_OBJECTS;

2. INSERT INTO user_sdo_geom_metadata:

VALUES ('Q1_DIAGRAM_OBJECTS_54004','LL_GEOMETRY', 
MDSYS.SDO_DIM_ARRAY (

SDO_DIM_ELEMENT ('X', -20037508, 20037508, .05), 
SDO_DIM_ELEMENT ('Y', -45884542, 45884542, .05)
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), 3857);

3. CREATE INDEX Q1_DIAGRAM_OBJECTS_SDX_54004 on 
Q1_DIAGRAM_OBJECTS_54004 (ll_geometry) indextype is mdsys.spatial_index;.

4. Under Tile Operations, click on Prefetch Tiles. Here is a snapshot of the area selection and 
the tile operation.

This process takes some time, depending upon the hardware configuration of the system and the 
amount of data to be prefetched. To check the current status of the operation, click Refresh 
under the Operation Status. The status will change to “Finished” when the operation is done.
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Chapter 9
Installing NMS BI Publisher Reports

To install the Oracle Utilities Analytics Oracle Utilities Network Management System IEEE 
outage reports:

1. Unzip the IEEE outage reports contained in OUA NMS BI Publisher reports.zip from the 
installation media to a temporary directory (example: TEMPDIR) on the server where Oracle 
BI Publisher is installed.

2. Log into Oracle BI Publisher (http://<BI Publisher server name>:9704/xmlpserver/) as an 
Administrator from a browser that has access to the TEMPDIR folder from the step 1. 

3. Set up a database connection. 

a. Navigate to Oracle BI Publisher Administration > Data Sources > JDBC 
Connection.

b. Click Add Data Source.

c. In the Data Source Name field, enter NMS BI Publisher or a name of your choice.

d. Set the Driver Type to Oracle 12c. 

e. Set the Database Driver Class to oracle.jdbc.OracleDriver. 

f. Set the Connection string 

to:jdbc:oracle:thin:@<yourmachine>:<Port>:<ORACLE_SID> 

Note: The database connection referring to OUA have to be setup here.

g. Set the username and password to match your Oracle Utilities Analytics database login 
values. 

Note: The username should be “MDADM” and the password corresponding 
to this user.

h. Click Test Connection and verify that it is properly configured. 

i. Click Apply. 

4. From the BI Publisher Catalog page, select Shared Folders from the folders tree. 

5. On top of the folders section, click the New drop-down list and select Folder from the list.

6. Enter NMS IEEE Reports as the folder name (or a name of your choice). Click Create. The 
new folder is added. You may have to click Refresh button to update the Folders list.

7. Select the NMS IEEE Reports folder in the folder list.
Under the NMS IEEE Reports folder, create another new folder named NMS IEEE Data 
Models. 
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8. Select the NMS IEEE Data Models directory, and then click Upload in the Tasks section 
on the bottom left. 

a. Browse to the directory where the NMS IEEE BI Publisher reports exist (TEMPDIR 
from step 1).

b. Locate all of the data model files and upload them to the NMS IEEE Data Models 
directory. These files contain the xdmz extension and include the following files:

• CELID DataModel.xdmz

• CEMI Data Model.xdmz

• DailyTroubleReport.xdmz

• DeviceOutageHistory.xdmz

• Feeder Impact on System Metrics.xdmz

• IEEE Benchmarking Model.xdmz

• IEEE_TMED_Calculations.xdmz

• IEEEIndiceCalculations.xdmz

• RecurringDeviceOutages.xdmz 

9. Select the NMS IEEE Reports directory and click Upload in the Tasks section. 

a. Browse to the directory where the OUA NMS IEEE BI Publisher reports exist 
(TEMPDIR from step 1). 

b. Locate all of the report files and upload them to the NMS IEEE Reports directory. 
These files contain xdoz extension and include the following files:

• CELID DataModel.xdoz

• CEMI Data Model.xdoz

• DailyTroubleReport.xdoz

• DeviceOutageHistory.xdoz

• Feeder Impact on System Metrics.xdoz

• IEEE Benchmarking Model.xdoz

• IEEE_TMED_Calculations.xdoz

• IEEEIndiceCalculations.xdoz

• RecurringDeviceOutages.xdoz

10. Assign the appropriate JDBC connection to the imported data models.

a. Click Catalog. 

b. Select the NMS IEEE Data Models directory and select the 
CriticalCustomerOutages.xdmz data model.

c. Click Data Model on the top left. 

d. In the Properties frame on the right, make sure that Default Data Source points to the 
data source you created earlier. This defaults to NMS BI Publisher.

e. You must perform this step for all of the data models under the NMS IEEE Data 
Models directory.

11. Assign the appropriate data model to all the NMS IEEE Reports.

a. Click Catalog. 
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b. Select the NMS IEEE Reports directory. Click Edit for the 
CriticalCustomerOutages report.

c. At the top-left of the page, click Search. 

d. Browse and select the appropriate data model file (will match the name of the report with 
an extension of xdmz).

e. Save the current report by clicking Save on the top-right of the page.

You should now be able view the standard IEEE indices reports from BI Publisher by simply 
selecting the desired report from the NMS IEEE Reports directory under the Catalog.
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Chapter 10
Installing/Upgrading to Oracle Analytics Server

Oracle Analytics Server is an on-premise self-service visualization and augmented AI analytics 
platform. Existing OBIEE customers (currently on their maintenance and support) are entitled to 
upgrade to Oracle Analytics Server with no additional cost. It enables the existing OBIEE 
customers to experience self-service data visualization, a modern analytics user experience, 
leverage pre-built advanced analytical models, machine learning and more. 

Starting with Oracle Utilities Analytics 2.7.0.1.3, Oracle Analytics Server v5.5.0 is supported. 

To utilize the features available in Oracle Analytics Server, upgrade to Oracle Utilities Analytics 
2.7.0.1.3 and do either of the following: 

• Upgrade the OBIEE 12.2.1.4 environment to Oracle Analytics Server 5.5.0

• Install Oracle Analytics Server 5.5.0 on a new environment and migrate OBIEE RPD and 
Web Catalog to Oracle Analytics Server. 

This chapter addresses the following three use cases for initial installation and upgrade of Oracle 
Analytics Server for Oracle Utilities Analytics: 

• New customers performing a fresh Oracle Analytics Server installation. 

• Existing customers performing a fresh Oracle Analytics Server installation. Note that this will 
be the most common scenario since customers will opt to migrate the customized RPD and 
catalog from OBIEE to Oracle Analytics Server. 

• Existing customers performing an in-place upgrade. This scenario requires that a product 
OBIEE instance be down for a significant time so that an in-place upgrade can happen. This 
use case is not practical for most customers. 

Note that Oracle Analytics Server 5.5.0 is supported only on Oracle Linux. Refer to the Operating 
Systems and Application Servers section in Chapter 2: Supported Platforms and Hardware 
Requirements. 

The chapter includes the following: 

• Prerequisites

• Installing Oracle Analytics Server for the First Time

• Existing Customers Performing New Oracle Analytics Server Installation

• In-place Upgrade to an Existing Oracle Analytics Server 
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Prerequisites
For prerequisite information, refer to the Migrating and Upgrading To Oracle Analytics Server 
documentation at https://docs.oracle.com/en/middleware/bi/analytics-server/migrate-upgrade-
oas/index.html 

Installing Oracle Analytics Server for the First Time
This section deals with the tasks to be performed when Oracle Analytics Server is installed for the 
first time. 

• Installing Oracle Utilities Analytics Dashboards Component

• Deploying Repository (RPD) File

• Deploying Writeback Templates in Oracle Analytics Server Domain

• Configuring and Deploying the MapViewer

• Updating the MapViewer Configuration

• Enabling WriteBack

• Enabling Auto Complete Feature Oracle Analytics Server 

Installing Oracle Utilities Analytics Dashboards Component
Make sure that the same operating system user is used to install all prerequisites software and 
Oracle Utilities Dashboard Analytics component. 

The Oracle Utilities Analytics Dashboards component is installed on the Oracle Utilities Analytics 
application server.

This section describes the process to install the Oracle Utilities Analytics Dashboards component. 

• Prerequisites

• Copying and Decompressing Install Media 

• Starting the Installer 

• Install Steps

• Deploying Web Catalog

Prerequisites
Oracle Utilities Analytics Dashboards component requires Oracle Analytics Server 5.5.0. For 
instructions to install and configure Oracle Analytics Server, see Installing and Configuring 
Oracle Analytics Server at https://docs.oracle.com/en/middleware/bi/analytics-server/install-
config-oas/oracle-analytics-server-installation.html#GUID-439A0AFE-4D45-43E4-9C00-
CCB018AC3E4A. 

Copying and Decompressing Install Media
To download and decompress the install media: 

1. Download the Oracle Utilities Analytics Dashboards component v2.7.0.1.3 
(p31545468_27013_Generic.zip) from My Oracle Support. 

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (referred to 
<TEMPDIR> below). 

This directory should be located outside any current working Oracle Utilities application 
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environment. All files placed in this directory as a part of the installation can be deleted after 
completing a successful installation. 

3. Unzip the Oracle Utilities Analytics 2.7.0.1.3 installer p31545468_27013_Generic.zip to 
<TEMPDIR>.

Starting the Installer
To start the installer: 

1. Navigate to the temporary folder where you downloaded the installer. Run the following 
command from the folder: 

java -jar <TEMPDIR>/OUA_2.7.0.1.3_generic.jar -logLevel finest 

Note: The minimum JDK required to run the Oracle Utilities Analytics installer is JDK 1.8. 

2. On the Welcome page, review the information before beginning the installation. 

3. Click Next to continue with the installation. 

4. Complete the installation by following the tasks on the navigation pane. 

Each item in the navigation pane represents a specific installer screen that prompts you for 
the information required to install the software. 

Install Steps
To install the Oracle Utilities Analytics Dashboards component:

1. Run the Oracle Utilities Analytics installer. 

2. On the Welcome page, review the available information before beginning the installation. 

3. On the Installation Inventory page, provide the inventory location. Click Next. 

4. On the Languages Selection page, make sure “English” is selected. Click Next. 

5. On the Installation Location page, provide the installation location and click Next. 

6. On the Installation Type page, select Dashboards and click Next. 

7. Enter the following details in the respective fields and click Next. 

Note: Based on the selected installation type, the options on the left navigation 
panel change. When the Installation Type selected is Dashboard, define the 
Database and Java Home Details, Target Database Connection Details and 
OAS Home Details. 

8. On the Target Database Connection Details page, enter the following details in the 
respective fields and click Next. 

Field Name Description Value

Database Client Home Database client home location Example: 
/u01/app/product/12.1.0/
dbhome_1

Java Home JDK home location JDK 1.8 location 
Example: /u01/jdk_1.8.0_201

Field Name Description Value

Host Host name of the server 
where the database resides

Oracle Utilities Analytics 
Database Server
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9. On the OBIEE Home Details page, enter the following details in the respective fields and 
click Next. 

Note: You will be prompted for the Infrastructure user’s password after 
installation. 

10. On the Java Home Location page, provide the same Java Home details provided earlier. 
Click Next. 

11. On the Installation Summary page, verify the installation options and click Install to begin 
the installation. 

Port Database port number on the 
database server used for 
connecting to the database

Oracle Utilities Analytics 
Database Port. The default value 
is 1521.

Service Name Service name for the database

Target Schema 
Password

Password for the target 
schema (DWADM)

Confirm Target 
Schema Password 

Confirm password for the 
target schema (DWADM)

Metadata Schema 
Password

Password for the metadata 
schema (MDADM)

Confirm Metadata 
Schema Password

Confirm password for the 
metadata (MDADM) schema

Field Name Description Value

BI Home The location on the disk 
where OAS is installed.

Example:

/u01/ Middleware/bi

BI Domain Home The domain Home location 
under the directory where 
OAS is installed.

Example:

/u01/ Middleware/
user_projects/domains/
oas_domain

Infrastructure Host The hostname on which 
Infrastructure server for OAS 
is running.

Infrastructure Port 
Number

A unique port number within 
the system that is assigned to 
the HTTP port. 

This port number is used as a 
part of the client URL request 
to connect to the host. It is 
the OAS Infrastructure 
console admin port number.

Example: 7001

Infrastructure User Infrastructure domain login 
username

Field Name Description Value
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For any changes to the configuration before starting the installation, use the navigation pane 
and select the topic to edit. 

12. The Installation Progress page appears allowing you to see the progress of the installation. 
Operations being performed as part of the installation are logged to the terminal from which 
the installer was run. Detailed logs of the installation are also available in the logs/system 
directory under the installation location.

To quit before the installation is complete, click Cancel. It will result in a partial installation; 
the portion of the software that was installed on the system before clicking Cancel will 
remain on the system and needs to be deleted manually. 

13. On the Installation Completed page, click Finish to close the installer. 

The Dashboards component is installed successfully.

Deploying Web Catalog
Oracle Analytics Server no longer supports offline mode to deploy catalogs. Deploy the latest 
catalogs into the environment via online mode. Refer to Doc ID 2655137.1 on My Oracle Support 
for details about deploying catalogs. 

To deploy web catalog: 

1. Navigate to OAS_DOMAIN_HOME/bitools/bin.

2. Use runcat.sh to deploy the catalogs. 

3. Create a new credentials file boot.txt at a standard location, typically in the location where 
runcat.sh is executed. 

$OAS_DOMAIN_HOME/bitools/bin/boot.txt file 
login=admin user
pwd=admin password 

4. For each catalog run the following from the Oracle Analytics Server domain/bitools/bin 
location. 

./runcat.sh -cmd unarchive -folder "/shared" -online http://<OAS 
Host>:<OAS SERVER PORT>/analytics-ws/saw.dll -credentials boot.txt 
-inputFile "<install_dir>/Catalog/<Catalog Name>" -overwrite all

Example: 

cd $OAS_DOMAIN_HOME/bitools/bin
./runcat.sh -cmd unarchive -folder "/shared" -online http://
slc14vob.us.oracle.com:9502/analytics-ws/saw.dll -credentials boot.txt 
-inputFile "/scratch/OUA27013_install/Catalog/Sample NMS DV 
Projects.Catalog" -overwrite all
……
Command 'unarchive' completed successfully.
Return status from Catalogmanager command : 0

Note: inputFile parameter must be in double quotes if the filename includes 
spaces.

Deploying Repository (RPD) File
The RPD file exists in the following location, where <install_dir> is the Oracle Utilities Analytics 
Dashboards Component installation directory: 

<OUA_install_dir>/Reports/rpd/ UtilitiesBusinessAnalytics.rpd

Note: If using the default Oracle Utilities Analytics repository, change the 
default password the first time opened in the Administration Tool.

To deploy the RPD file: 
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1. Make sure Oracle Analytics Server 5.5.0 Client tool is installed on the Windows machine. 

2. Navigate to Start > Programs > Oracle Business Intelligence > Administration. 

3. Click File > Open > Offline... to open the RPD in offline mode. 

4. Provide the RPD password. The default password is “oracle123”. 

5. Double-click the Connection Pools to edit them. 

• In the Init Block Connection Pool group, enter the following: 

Datasource name = BI Database name

User name = DWREAD

Password = DWREAD User password

• In the Init Block Pool - MDM group, provide the following (only for Oracle Utilities 
Meter Data Management): 

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

• In the Init Block Pool - NMS Replication group, provide the following (only for 
Oracle Utilities Network Management System): 

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password

Note: The schema name is NMS1REP by default. Rename it if the replication 
schema name is different.

• In the Materialized Views Connection group, enter the following:

Datasource name = BI Database name

User name =DWREAD

Password = DWREAD User password 



Deploying Repository (RPD) File

Installing/Upgrading to Oracle Analytics Server 10-7
Oracle Utilities Analytics Installation Guide

• In the MDM Database Connection group, provide the following (only for Oracle 
Utilities Meter Data Management): 

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

• In the NMS Replication Tables group, provide the following (only for Oracle Utilities 
Network Management System): 

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password

Note: The default schema name is NMS1REP. If the replication schema name is 
different, then rename.

• In the ODIDEV Connection Pool group, provide the following: 

Datasource name = BI database name

User name = DWUSER

Password = DWUSER User password

• In the OUBI Database Connection group, provide the following: 

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password
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14. Click Save. 

Note: Click Yes when you see the prompt 'Do you wish to check global consistency?' 
and ignore any warnings that appear after consistency check is complete. 

15. Copy the modified RPD back to the <install dir>/Reports/rpd/
UtilitiesBusinessAnalytics.rpd where <install_dir> is the Oracle Utilities Analytics Dashboard 
Component installation directory.

16. Login to the server where Oracle Analytics Server is installed. 

17. Navigate to <OAS DOMAIN>/bitools/bin.

18. Run the following command to deploy the RPD: 

In Unix if SSL is enabled: 

./datamodel.sh uploadrpd -I <Install_Dir>/Reports/rpd/
UtilitiesBusinessAnalytics.rpd -W <rpd password, default 
password is oracle123> -U <Infrastructure user name of OAS 
domain> -P <Infrastructure password of OAS domain> -SI ssi -SSL 
-TS <keystore> -TSP <keystore_password> 

In Unix if SSL is disabled: 

./datamodel.sh uploadrpd -I <Install_Dir>/Reports/rpd/
UtilitiesBusinessAnalytics.rpd -W <rpd password, default 
password is oracle123> -U <Infrastructure user name of OAS 
domain> -P <Infrastructure password of OAS domain> -SI ssi 

19. Run the following commands from <OAS DOMAIN>/bitools/bin directory to stop and 
start the OAS domain services respectively. 

./stop.sh 

./start.sh 

Deploying Writeback Templates in Oracle Analytics Server Domain
WriteBack template is an xml file that takes user inputs and writes it directly to the database using 
SQL commands. Copy these WriteBack template files to the following location: 

$OAS_DOMAIN_HOME/bifoundation/web/msgdb/l_en/custommessages/

cp -r <install_dir>/writeback/wbtemplates/* $OAS_DOMAIN_HOME/
bifoundation/web/msgdb/l_en/custommessages/

If the directory structure in the Oracle Analytics Server domain does not exist, create it by running 
the command above. Below are the list of writeback templates files: 

• Base_Field_Update_Template.xml

• Configuration_Update_Template.xml

• Custom_Field_Delete_Template.xml

• Custom_Field_Insert_Template.xml

• Custom_Field_Update_Template.xml

• ETL_Job_Control_Update_Template.xml

• Map_Profile_Update_Template.xml
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Restart the Oracle Analytics Server services after deploying these writeback templates in the 
specified path. 

Configuring and Deploying the MapViewer 
Configuring and deploying the MapViewer involves the following tasks: 

• Configuring the MapViewer 

• Modifying instanceconfig.xml 

Configuring the MapViewer
To configure the Mapviewer: 

1. Login to the Infrastructure console Oracle Analytics Server domain. 

2. Create the 'MAP_DS' datasource. 

3. Lock and edit it. 

4. Navigate to Services > Data Sources. 

5. Select New > Generic Data Source and provide the following: 

Name = MAP_DS

JNDI Name = MAP_DS 

Database Type = oracle

6. Click Next.

7. Enter the following: 
Database Driver = *Oracle’s Driver (Thin) for Service connections; Versions:Any

8. Click Next. 

9. On the next page, do not change any values. Click Next.

10. Enter the following connection properties: 

• Database Name: BI Database Name 

• Host Name: Database host 

• Port: Database port

• Database User Name: dwadm

• Password: dwadm password

11. Click Next.

12. On the next page, click Test Configuration. After the successful test, click Next. 

13. On the Select Target page, select AdminServer under Servers and bi_cluster under 
Clusters. Click Finish. 

14. Click Activate Changes. 

15. Update the mapViewerConfig file with the tags mentioned below: 

File location: <Install Dir> 
/user_projects/domains/<oas_domain>/config/fmwconfig/mapviewer/conf 

File: mapViewerConfig.xml 

16. If there is a proxy used, insert the list of host names for all the third-party service providers in 
the security_config node. 

<proxy_enabled_hosts>
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elocation.oracle.com
</proxy_enabled_hosts>

17. Add the following ns_data_provider node: 

<ns_data_provider id=”oasNsdp" 
class="com.oracle.utilities.birdseye.BirdseyeNSDP” />

18. Add the current map_tile_server with the following map_tile_server node: 

<map_tile_server>
<tile_storage default_root_path=”/mytilecache/”/>
</map_tile_server> 

Modifying instanceconfig.xml
Make sure to take a backup before updating the instanceconfig.xml file. Run the following 
commands in UNIX to go to the directory containing the instanceconfig.xml file. 

In Unix:

<OAS_INSTALL_DIR>/user_projects/domains/<oas_domain>/config/ 
fmwconfig/biconfig/OBIPS

Perform the following changes to the instanceconfig.xml file: 

1. Update the security node with the following values. If the security node is not present, add 
the following code before </Serverinstance>: 

<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies>
<CookieDomain />
<CookiePath>/</CookiePath>
</Security>

2. Update the following <ServerInstance> element:

<LightWriteback>true</LightWriteback>

3. Add the following code between the <ServerInstance> </ServerInstance> tags. 

<Prompts> 
<MaxDropDownValues>256</MaxDropDownValues> 
<AutoApplyDashboardPromptValues>true</AutoApplyDashboardPromptValues> 
<AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox> 
<AutoCompletePromptDropDowns> 
<SupportAutoComplete>true</SupportAutoComplete> 
<CaseInsensitive>true</CaseInsensitive> 
<MatchingLevel>MatchAll</MatchingLevel> 
<ResultsLimit>50</ResultsLimit> 
</AutoCompletePromptDropDowns> 
</Prompts>
<SpatialMaps>
<MapViewerAPIV2Enabled>false</MapViewerAPIV2Enabled>
</SpatialMaps> 

Updating the MapViewer Configuration
To update the MapViewer configuration: 

1. Login to MapViewer. 

2. To update the MapViewer configuration, navigate to MapViewer > Administration > 
Configuration. 
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3. Login to the Mapviewer at this location. 

3. Add the below code in the mapViewerConfig.xml with the appropriate values: 

<map_data_source name=”mapconn”
jdbc_host=”<DB server name>”
jdbc_sid=”//<DB Service name>”
jdbc_port=”1521”
jdbc_user=”DWADM”
jdbc_password=”!<DWADM user password>” 
jdbc_mode=”thin”
number_of_mappers=”32”
allow_jdbc_theme_based_foi=”true”
/>

4. Click Save and restart.

Enabling WriteBack
To enable the Write Back:

1. Login to Analytics and navigate to Administration > Manage Privileges > WriteBack > 
Write Back to Database. 

2. Click Denied:Authenticated User and select the Granted permission. 

Enabling Auto Complete Feature Oracle Analytics Server 
To enable the auto complete feature in Oracle Analytics Server: 

1. Restart the Oracle Analytics Server services. 

Note: Refer to Oracle Analytics Server documentation for detailed instructions 
on how to start and stop the services.

2. Login to Analytics. 

3. Click Infrastructure User (top-most-right section of the page). 

4. From the drop-down menu, select My Account. 

5. On the Preferences tab, set Prompt Auto Complete to ON.

6. Click OK. 

Existing Customers Performing New Oracle Analytics Server 
Installation 

This section focuses on the following tasks: 

• Upgrading Oracle Utilities Analytics Dashboards Component

• Deploying Repository (RPD) File

• Deploying Writeback Templates in Oracle Analytics Server Domain

• Configuring and Deploying the MapViewer

• Updating the MapViewer Configuration

• Enabling Writeback 

• Enabling Auto Complete Feature Oracle Analytics Server
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Upgrading Oracle Utilities Analytics Dashboards Component
Ensure that the same operating system user used to install the prerequisite software is used to 
install the Oracle Utilities Analytics Dashboards component. 

The Oracle Utilities Analytics Dashboards component is installed on the Oracle Utilities Analytics 
application server. 

This section describes how to upgrade the dashboards component of Oracle Utilities Analytics. 

• Prerequisites

• Copying and Decompressing Install Media

• Starting the Installer

• Upgrade Steps

• Deploying Web Catalog

Prerequisites
Oracle Utilities Analytics Dashboard component requires Oracle Analytics Server 5.5.0. For 
instructions refer to the Installing and Configuring Oracle Analytics Server section at https://
docs.oracle.com/en/middleware/bi/analytics-server/install-config-oas/oracle-analytics-server-
installation.html#GUID-439A0AFE-4D45-43E4-9C00-CCB018AC3E4A. 

Copying and Decompressing Install Media
To download and decompress the install media: 

1. Download the Oracle Utilities Analytics Dashboards component v2.7.0.1.3 
(p31545468_27013_Generic.zip) from My Oracle Support. 

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (referred to 
<TEMPDIR> below). 

This directory must be located outside any current working Oracle Utilities application 
environment. All files that are placed in this directory as a part of the installation can be 
deleted after completing a successful installation. 

3. Unzip p31545468_27013_Generic.zip to <TEMPDIR>. 

Starting the Installer
To start the installer: 

1. Navigate to the temporary folder where you downloaded the install. Run the following 
command from the folder: 

java -jar <TEMPDIR>/OUA_2.7.0.1.3_generic.jar -logLevel finest

Note: The minimum JDK required for running the Oracle Utilities Analytics 
installer is JDK 1.8. 

2. On the Welcome page, review the information before you begin the installation. 

3. Click Next to continue with the installation. 

4. Complete the installation by following the tasks on the navigation pane. 

Each item in the navigation pane represents a specific installer screen that prompts you for 
the information required to install the software. 

Upgrade Steps
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To install the Dashboards component: 

1. Run the Oracle Utilities Analytics Installer. 

2. On the Welcome page, review the available information before you begin the installation.

3. On the Installation Inventory page, provide the inventory location. Click Next. 

4. On the Languages Selection page, make sure “English” is selected. Click Next. 

5. On the Installation Location page, provide the installation location and click Next. 

6. On the Installation Type page, select Dashboards and click Next. Enter the following 
details in the respective fields and click Next. 

Note: Based on the selected installation type, the options on the left navigation 
panel change. When you select Dashboard as an Installation Type, define 
Database and Java Home Details, Target Database Connection Details 
and OAS Home Details. 

7. On the Target Database Connection Details page, enter the following details in the 
respective fields and click Next. 

Field Name Description Value

Database Client Home Database client home location Example:

/u01/app/product/12.1.0/
dbhome_1

Java Home JDK home location JDK 1.8 location
Example:

/u01/jdk_1.8.0_201

Field Name Description Value

Host Host name of the server 
where the database resides.

Oracle Utilities Analytics 
Database Server

Port Database port number on the 
database server used for 
connecting to the database.

Oracle Utilities Analytics 
Database Port. The default value 
is 1521.

Service Name Service name for the database

Target Schema 
Password

Password for the target 
schema (DWADM).

Confirm Target 
Schema Password 

Confirm the password for the 
target schema (DWADM) 
here.

Metadata Schema 
Password

Password for the metadata 
schema (MDADM).

Confirm Metadata 
Schema Password

Confirm the password for the 
metadata (MDADM) schema 
here.
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8. On the OAS Home Details page, enter the following details in the respective fields and click 
Next. 

Note: You will be prompted for the Infrastructure user’s password after 
installation. 

9. On the Java Home Location page provide the Java Home details that were provided earlier. 
Click Next. 

10. On the Installation Summary page, verify the installation options and click Install to begin 
the installation. 

For any changes to the configuration before starting the installation, use the navigation pane 
and select the topic to edit. 

11. The Installation Progress page allows you to view the progress of the installation. 
Operations being performed as part of the installation are logged to the terminal from which 
the installer was run. Detailed logs of the installation are also available in the logs/system 
directory under the installation location.

To quit before the installation is complete, click Cancel. Doing so will result in a partial 
installation; the portion of the software that was installed on your system before you click 
Cancel will remain on your system, and it needs to be deleted manually. 

12. On the Installation Completed page, click Finish to close the installer. 

The Dashboards component is installed successfully. 

Deploying Web Catalog
Migrating Existing RPD and Catalog from OBIEE to Oracle Analytics Server 

Field Name Description Value

BI Home The location on the disk 
where OAS is installed.

Example:

/u01/ Middleware/bi

BI Domain Home The domain Home location 
under the directory where 
OAS is installed.

Example:

/u01/ Middleware/
user_projects/domains/
oas_domain

Infrastructure Host The hostname on which 
Infrastructure server for OAS 
is running.

Infrastructure Port 
Number

A unique port number within 
the system that is assigned to 
the HTTP port.

This port number is used as a 
part of the client URL request 
to connect to the host. It is 
the OAS Infrastructure
console admin port number.

Example: 7001

Infrastructure User Infrastructure domain login 
username
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Migrate the BI Application Archive (BAR file) from OBIEE to Oracle Analytics Server. BAR files 
are compressed archive files that contain a cohesive set of BI metadata artifacts (data model, 
content model, and authorization model). 

For more information on BAR files, refer to the Managing Metadata and Working with 
Service Instances section at https://docs.oracle.com/middleware/1221/biee/BIESG/
configrepos.htm#BIESG2889. 

For information about exporting BAR file, refer to the export_service_instance section at 
https://docs.oracle.com/en/middleware/bi/analytics-server/administer-oas/
exportserviceinstance.html. For information about importing BAR file, refer to the import_bar 
section at https://docs.oracle.com/en/middleware/bi/analytics-server/administer-oas/
importserviceinstance.html. 

For instructions to export BAR and import BAR file in Oracle Analytics Server, refer to Doc ID 
2406648.1 on My Oracle Support. 

Deploying Catalogs 

Oracle Analytics Server no longer supports offline mode to deploy catalogs. Deploy the latest 
catalogs into the environment via online mode as shown below. Refer to Doc ID 2655137.1 for 
details about deploying catalogs. 

Make sure to take a backup of any custom catalog related files in this directory in a separate 
location. 

Navigate to the OAS_DOMAIN_HOME/bitools/bin use the runcat.sh to deploy the catalogs. 
Create a new credentials file called boot.txt at a standard location, typically at runcat.sh location 
itself as shown below.

$OAS_DOMAIN_HOME/ bitools/bin/boot.txt file 
login=admin user
pwd=admin password

For each catalog run the following from the OAS_DOMAIN_HOME/bitools/bin location. 

./runcat.sh -cmd unarchive -folder "/shared" -online http://<OAS 
Host>:<OAS SERVER PORT>/analytics-ws/saw.dll -credentials boot.txt -
inputFile "<install_dir>/Catalog/<Catalog Name>" -overwrite all

Example: 

cd $OAS_DOMAIN_HOME/bitools/bin
./runcat.sh -cmd unarchive -folder "/shared" -online http://
slc14vob.us.oracle.com:9502/analytics-ws/saw.dll -credentials boot.txt 
-inputFile "/ scratch/OUA27013_install/Catalog/Sample NMS DV 
Projects.Catalog" -overwrite all
……
Command 'unarchive' completed successfully.
Return status from Catalogmanager command : 0

Note: inputFile parameter must be in double quotes if the filename includes 
spaces.

Deploying Repository (RPD) File
If no changes are made to the deployed RPD, take the RPD file from the following location, 
where <install_dir> is the Oracle Utilities Analytics Dashboard Component installation directory: 

<install_dir>/Reports/rpd/ UtilitiesBusinessAnalytics.rpd

Note: If using the default Oracle Utilities Analytics repository, change the 
default password the first time it is opened in the Administration Tool. 
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If it was merged, do the required database changes with the merged RPD. Copy this RPD file to 
the Windows machine on which Oracle Analytics Server Client Tool (5.5.0) is installed. 

To deploy the RPD file: 

1. Make sure Oracle Analytics Server 5.5.0 Client is installed on the Windows machine before 
proceeding. 

2. Click Start > Programs > Oracle Business Intelligence > Administration. 

3. Click File > Open > Offline... to open the RPD in offline mode.

4. Provide the RPD password. The default password is “oracle123”. 

5. Double-click the Connection Pools to edit them. 

• In the Init Block Connection Pool group, enter the following: 

Datasource name = BI Database name

User name = DWREAD

Password = DWREAD User password

• In the Init Block Pool - MDM group, provide the following (only for Oracle Utilities 
Meter Data Management): 

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

• In the Init Block Pool - NMS Replication group, provide the following (only for 
Oracle Utilities Network Management System): 

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password

• In the Materialized Views Connection group, enter the following:

Datasource name = BI Database name

User name =DWREAD
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Password = DWREAD User password 

• In the MDM Database Connection group, provide the following (only for Oracle 
Utilities Meter Data Management): 

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

• In the NMS Replication Tables group, provide the following (only for Oracle Utilities 
Network Management System): 

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password 

Note: The default schema name is NMS1REP. If the replication schema name is 
different, then rename it. 

• In the ODIDEV Connection Pool group, provide the following: 

Datasource name = BI database name

User name = DWUSER

Password = DWUSER User password

• In the OUBI Database Connection group, provide the following: 

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password
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6. Click Save. 

Note: Click Yes when you see the prompt 'Do you wish to check global consistency?' 
and ignore any warnings that appear after consistency check is complete. 

7. Copy the modified RPD back to the <install dir>/Reports/rpd/
UtilitiesBusinessAnalytics.rpd where <install_dir> is the Oracle Utilities Analytics Dashboard 
Component installation directory.

8. Login to the server where Oracle Analytics Server is installed. 

9. Navigate to <OAS DOMAIN>/bitools/bin.

10. Run the following command to deploy the RPD: 

In Unix if SSL is enabled: 

./datamodel.sh uploadrpd -I <Install_Dir>/Reports/rpd/
UtilitiesBusinessAnalytics.rpd -W <rpd password, default 
password is oracle123> -U <Infrastructure user name of OAS 
domain> -P <Infrastructure password of OAS domain> -SI ssi -SSL 
-TS <keystore> -TSP <keystore_password>

In Unix if SSL is disabled: 

./datamodel.sh uploadrpd -I <Install_Dir>/Reports/rpd/
UtilitiesBusinessAnalytics.rpd -W <rpd password, default 
password is oracle123> -U <Infrastructure user name of OAS 
domain> -P <Infrastructure password of OAS domain> -SI ssi 

11. Run the following commands from <OAS DOMAIN>/bitools/bin directory to stop and 
start the Oracle Analytics Server domain services respectively. 

./stop.sh 

./start.sh 

Deploying Writeback Templates in Oracle Analytics Server Domain
WriteBack template is an xml file that takes user inputs and writes it directly to the database using 
SQL commands. Copy these WriteBack template files from the existing Oracle Utilities Analytics 
environment (in the older OBIEE domain location $OBIEE_DOMAIN_HOME/bidata/
service_instances/ssi/metadata/content/msgdb/l_en/customMessages) to the new installed and 
configured Oracle Analytics Server domain Home location at $OAS_DOMAIN_HOME/
bifoundation/web/msgdb/l_en/custommessages. 

If the directory structure in the Oracle Analytics Server domain not exist, create it. 

Below id a list of writeback template files:

• Base_Field_Update_Template.xml

• Configuration_Update_Template.xml

• Custom_Field_Delete_Template.xml

• Custom_Field_Insert_Template.xml

• Custom_Field_Update_Template.xml

• ETL_Job_Control_Update_Template.xml

• Map_Profile_Update_Template.xml

Restart the Oracle Analytics Server services after the above writeback templates are deployed in 
the specified path. 
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Note: In OBIEE bi_domain, these write back templates are stored at 
$DOMAIN_HOME/bidata/service_instances/ssi/metadata/content/
msgdb/l_en/customMessages in the directory. 

Configuring and Deploying the MapViewer
Configuring and deploying the MapViewer involves the following tasks:

• Configuring the MapViewer

• Modifying instanceconfig.xml

Configuring the MapViewer
To configure the Mapviewer: 

1. Login to the Infrastructure console in the Oracle Analytics Server domain. 

2. Create the 'MAP_DS' datasource. 

3. Lock and edit it. 

4. Navigate to Services > Data Sources. 

5. Select New > Generic Data Source and provide the following: 

Name = MAP_DS 

JNDI Name = MAP_DS Database Type = oracle 

6. Click Next. Enter the following: 

Database Driver = *Oracle's Driver (Thin) for Service connections; Versions:Any 

7. Click Next. 

8. On the next page, do not change any values. Click Next. 

9. Enter the following connection properties: 

Database Name: BI Database Name

Host Name: Database host

Port: Database port

Database User Name: dwadm

Password: dwadm password

10. Click Next. 

11. On the next page, click Test Configuration. After the successful test click Next. 

12. On the Select Target page, select AdminServer under Servers and bi_cluster under 
Clusters. Click Finish. 

13. Click Activate Changes. 

14. Update the mapViewerConfig file with the tags mentioned below. 

File location: <Install Dir>/user_projects/domains/<oas_domain>/config/fmwconfig/
mapviewer/conf File: mapViewerConfig.xml

If there is a proxy used, insert the list of host names for all the third-party service providers in 
the security_config node. 

<proxy_enabled_hosts> elocation.oracle.com </proxy_enabled_hosts>
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15. Add the following ns_data_provider node: 

<ns_data_provider id="obieeNsdp" class="com.oracle.utilities.birdseye.BirdseyeNSDP" />

16. Add the current map_tile_server with the following map_tile_server node: 

<map_tile_server>

<tile_storage default_root_path="/mytilecache/"/> </map_tile_server>

Modifying instanceconfig.xml
Make sure to take a backup before updating the instanceconfig.xml file. Run the following 
commands in UNIX to navigate to the directory containing the instanceconfig.xml file. 

In UNIX:

<OAS_INSTALL_DIR>/user_projects/domains/<oas_domain>/config/ 
fmwconfig/biconfig/OBIPS

Perform the following changes to the instanceconfig.xml file: 

1. Update the security node with the following values. If the security node is not present, add 
the following code before </Serverinstance>. 

<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies> <CookieDomain /> 
<CookiePath>/</CookiePath> </Security>

2. Update the following <ServerInstance> element: 

<LightWriteback>true</LightWriteback>

3. Add the following code between the <ServerInstance> </ServerInstance> tags. 

<Prompts>
<MaxDropDownValues>256</MaxDropDownValues>
<AutoApplyDashboardPromptValues>true</ 
AutoApplyDashboardPromptValues>
<AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox>
<AutoCompletePromptDropDowns>
<SupportAutoComplete>true</SupportAutoComplete>
<CaseInsensitive>true</CaseInsensitive>
<MatchingLevel>MatchAll</MatchingLevel>
<ResultsLimit>50</ResultsLimit>
</AutoCompletePromptDropDowns>
</Prompts>
<SpatialMaps>
<MapViewerAPIV2Enabled>false</MapViewerAPIV2Enabled>
</SpatialMaps>

Updating the MapViewer Configuration
To update the MapViewer configuration: 

1. Login to MapViewer. 
http://<Server>:<port>/mapviewer 

2. Navigate to MapViewer > Administration > Configuration. 

3. Add the below code in the mapViewerConfig.xml with the appropriate values. 

<map_data_source name="mapconn" jdbc_host="<DB server name>" 
jdbc_sid="//<DB Service name>" jdbc_port="1521" jdbc_user="DWADM" 
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jdbc_password="!<DWADM user password>" jdbc_mode="thin" 
number_of_mappers="32" allow_jdbc_theme_based_foi="true"

/>
4. Click Save and restart. 

Enabling Writeback
To enable the Writeback: 

1. Login to Oracle Utilities Analytics.

2. Navigate to Administration > Manage Privileges > WriteBack > Write Back to 
Database. 

3. Click Denied:Authenticated User and select the Granted permission. 

Enabling Auto Complete Feature Oracle Analytics Server 
To enable the auto complete feature in Oracle Analytics Server: 

1. Restart the Oracle Analytics Server services. 

Note: Refer to the Oracle Analytics Server documentation for detailed 
instructions on how to start and stop the Oracle Analytics Server services. 

12. Login to Oracle Utilities Analytics. 
http://<Server>:<port>/analytics

2. Click Infrastructure User (top right section of the page). 

3. From the drop-down menu, select My Account. 

4. On the Preferences tab, set Prompt Auto Complete to ON. 

5. Click OK. 

In-place Upgrade to an Existing Oracle Analytics Server
This section focuses on the following tasks: 

• Upgrading Oracle Utilities Analytics Dashboards Component

• Deploying Repository (RPD) File

• Deploying Writeback Templates in Oracle Analytics Server Domain

• Configuring and Deploying the MapViewer

• Updating MapViewer Configuration 

Upgrading Oracle Utilities Analytics Dashboards Component
Make sure that the same operating system user used to install the prerequisite software is used to 
install the Oracle Utilities Analytics Dashboards component. 

The Oracle Utilities Analytics Dashboards component is installed on the Oracle Utilities Analytics 
application server. 

This section describes how to upgrade the dashboards component of Oracle Utilities Analytics. 

• Prerequisites

• Copying and Decompressing Install Media

• Starting the Installer

http://<Server>:<port>/analytics
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• Upgrade Steps

• Deploying Web Catalog

Prerequisites
Oracle Utilities Analytics Dashboard component requires Oracle Analytics Server 5.5.0. For 
instructions refer to the Upgrading to Oracle Analytics Server section at https://
docs.oracle.com/en/middleware/bi/analytics-server/migrate-upgrade-oas/migrating-and-
upgrading-oracle-analytics-server.pdf. 

Copying and Decompressing Install Media
To download and decompress the install media: 

1. Download the Oracle Utilities Analytics Dashboards component v2.7.0.1.3 
(p31545468_27013_Generic.zip) from My Oracle Support. 

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (referred to 
<TEMPDIR> below). 

This directory must be located outside any current working Oracle Utilities application 
environment. All files that are placed in this directory as a part of the installation can be 
deleted after completing a successful installation. 

3. Unzip p31545468_27013_Generic.zip to <TEMPDIR>. 

Starting the Installer
To start the installer: 

1. Navigate to the temporary folder where you downloaded the install. Run the following 
command from the folder: 

java -jar <TEMPDIR>/OUA_2.7.0.1.3_generic.jar -logLevel finest

Note: The minimum JDK required for running the Oracle Utilities Analytics 
installer is JDK 1.8. 

2. On the Welcome page, review the information before you begin the installation. 

3. Click Next to continue with the installation. 

4. Complete the installation by following the tasks on the navigation pane. 

Each item in the navigation pane represents a specific installer screen that prompts you for 
the information required to install the software. 

Upgrade Steps
To install the Dashboards component: 

1. Run the Oracle Utilities Analytics Installer. 

2. On the Welcome page, review the available information before you begin the installation.

3. On the Installation Inventory page, provide the inventory location. Click Next. 

4. On the Languages Selection page, make sure “English” is selected. Click Next. 

5. On the Installation Location page, provide the installation location and click Next. 

6. On the Installation Type page, select Dashboards and click Next. Enter the following 
details in the respective fields and click Next. 

Note: Based on the selected installation type, the options on the left navigation 
panel change. When you select Dashboard as an Installation Type, define 
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Database and Java Home Details, Target Database Connection Details 
and OAS Home Details. 

7. On the Target Database Connection Details page, enter the following details in the 
respective fields and click Next. 

8. On the OAS Home Details page, enter the following details in the respective fields and click 
Next. 

Field Name Description Value

Database Client Home Database client home location Example:

/u01/app/product/12.1.0/
dbhome_1

Java Home JDK home location JDK 1.8 location
Example:

/u01/jdk_1.8.0_201

Field Name Description Value

Host Host name of the server 
where the database resides.

Oracle Utilities Analytics 
Database Server

Port Database port number on the 
database server used for 
connecting to the database.

Oracle Utilities Analytics 
Database Port. The default value 
is 1521.

Service Name Service name for the database

Target Schema 
Password

Password for the target 
schema (DWADM).

Confirm Target 
Schema Password 

Confirm the password for the 
target schema (DWADM) 
here.

Metadata Schema 
Password

Password for the metadata 
schema (MDADM).

Confirm Metadata 
Schema Password

Confirm the password for the 
metadata (MDADM) schema 
here.

Field Name Description Value

BI Home The location on the disk 
where OAS is installed.

Example:

/u01/ Middleware/bi

BI Domain Home The domain Home location 
under the directory where 
OAS is installed.

Example:

/u01/ Middleware/
user_projects/domains/
oas_domain
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Note: You will be prompted for the Infrastructure user’s password after 
installation. 

9. On the Java Home Location page provide the Java Home details that were provided earlier. 
Click Next. 

10. On the Installation Summary page, verify the installation options and click Install to begin 
the installation. 

For any changes to the configuration before starting the installation, use the navigation pane 
and select the topic to edit. 

11. The Installation Progress page allows you to view the progress of the installation. 
Operations being performed as part of the installation are logged to the terminal from which 
the installer was run. Detailed logs of the installation are also available in the logs/system 
directory under the installation location.

To quit before the installation is complete, click Cancel. Doing so will result in a partial 
installation; the portion of the software that was installed on your system before you click 
Cancel will remain on your system, and it needs to be deleted manually. 

12. On the Installation Completed page, click Finish to close the installer. 

The Dashboards component is installed successfully. 

Deploying Web Catalog
Oracle Analytics Server no longer supports offline mode to deploy catalogs. Deploy the latest 
catalogs into the environment via online mode as shown below. Refer to Doc ID 2655137.1 for 
details about deploying catalogs. 

Make sure to take a backup of any custom catalog related files in this directory in a separate 
location. 

Navigate to the OAS_DOMAIN_HOME/bitools/bin use the runcat.sh to deploy the catalogs. 
Create a new credentials file called boot.txt at a standard location, typically at runcat.sh location 
itself as shown below.

$OAS_DOMAIN_HOME/ bitools/bin/boot.txt file 
login=admin user
pwd=admin password

For each catalog run the following from the OAS_DOMAIN_HOME/bitools/bin location. 

Infrastructure Host The hostname on which 
Infrastructure server for OAS 
is running.

Infrastructure Port 
Number

A unique port number within 
the system that is assigned to 
the HTTP port.

This port number is used as a 
part of the client URL request 
to connect to the host. It is 
the OAS Infrastructure
console admin port number.

Example: 7001

Infrastructure User Infrastructure domain login 
username

Field Name Description Value
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./runcat.sh -cmd unarchive -folder "/shared" -online http://<OAS 
Host>:<OAS SERVER PORT>/analytics-ws/saw.dll -credentials boot.txt -
inputFile "<install_dir>/Catalog/<Catalog Name>" -overwrite all

Example: 

cd $OAS_DOMAIN_HOME/bitools/bin
./runcat.sh -cmd unarchive -folder "/shared" -online http://
slc14vob.us.oracle.com:9502/analytics-ws/saw.dll -credentials boot.txt 
-inputFile "/ scratch/OUA27013_install/Catalog/Sample NMS DV 
Projects.Catalog" -overwrite all
……
Command 'unarchive' completed successfully.
Return status from Catalogmanager command : 0

Note: inputFile parameter must be in double quotes if the filename includes 
spaces.

Deploying Repository (RPD) File
If no changes are made to the deployed RPD, take the RPD file from the following location, 
where <install_dir> is the Oracle Utilities Analytics Dashboard Component installation directory: 

<install_dir>/Reports/rpd/ UtilitiesBusinessAnalytics.rpd

Note: If using the default Oracle Utilities Analytics repository, change the 
default password the first time it is opened in the Administration Tool. 

If it was merged, do the required database changes with the merged RPD. Copy this RPD file to 
the Windows machine on which Oracle Analytics Server Client Tool (5.5.0) is installed. 

To deploy the RPD file: 

1. Make sure Oracle Analytics Server 5.5.0 Client is installed on the Windows machine before 
proceeding. 

2. Click Start > Programs > Oracle Business Intelligence > Administration. 

3. Click File > Open > Offline... to open the RPD in offline mode.

4. Provide the RPD password. The default password is “oracle123”. 
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5. Double-click the Connection Pools to edit them. 

• In the Init Block Connection Pool group, enter the following: 

Datasource name = BI Database name

User name = DWREAD

Password = DWREAD User password

• In the Init Block Pool - MDM group, provide the following (only for Oracle Utilities 
Meter Data Management): 

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

• In the Init Block Pool - NMS Replication group, provide the following (only for 
Oracle Utilities Network Management System): 

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password

• In the Materialized Views Connection group, enter the following:

Datasource name = BI Database name

User name =DWREAD

Password = DWREAD User password 

• In the MDM Database Connection group, provide the following (only for Oracle 
Utilities Meter Data Management): 

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password
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• In the NMS Replication Tables group, provide the following (only for Oracle Utilities 
Network Management System): 

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password 

Note: The default schema name is NMS1REP. If the replication schema name is 
different, then rename it. 

• In the ODIDEV Connection Pool group, provide the following: 

Datasource name = BI database name

User name = DWUSER

Password = DWUSER User password

• In the OUBI Database Connection group, provide the following: 

Datasource name = BI database name

User name = DWREAD

Password = DWREAD User password

6. Click Save. 

Note: Click Yes when you see the prompt 'Do you wish to check global consistency?' 
and ignore any warnings that appear after consistency check is complete. 

7. Copy the modified RPD back to the <install dir>/Reports/rpd/
UtilitiesBusinessAnalytics.rpd where <install_dir> is the Oracle Utilities Analytics Dashboard 
Component installation directory.



Deploying Writeback Templates in Oracle Analytics Server Domain

Installing/Upgrading to Oracle Analytics Server 10-28
Oracle Utilities Analytics Installation Guide

8. Login to the server where Oracle Analytics Server is installed. 

9. Navigate to <OAS DOMAIN>/bitools/bin.

10. Run the following command to deploy the RPD: 

In Unix if SSL is enabled: 

./datamodel.sh uploadrpd -I <Install_Dir>/Reports/rpd/
UtilitiesBusinessAnalytics.rpd -W <rpd password, default 
password is oracle123> -U <Infrastructure user name of OAS 
domain> -P <Infrastructure password of OAS domain> -SI ssi -SSL 
-TS <keystore> -TSP <keystore_password>

In Unix if SSL is disabled: 

./datamodel.sh uploadrpd -I <Install_Dir>/Reports/rpd/
UtilitiesBusinessAnalytics.rpd -W <rpd password, default 
password is oracle123> -U <Infrastructure user name of OAS 
domain> -P <Infrastructure password of OAS domain> -SI ssi 

11. Run the following commands from <OAS DOMAIN>/bitools/bin directory to stop and 
start the Oracle Analytics Server domain services respectively. 

./stop.sh 

./start.sh 

Deploying Writeback Templates in Oracle Analytics Server Domain
WriteBack template is an xml file that takes user inputs and writes it directly to the database using 
SQL commands. Copy these WriteBack template files from the existing Oracle Utilities Analytics 
environment (in the older OBIEE domain location $OBIEE_DOMAIN_HOME/bidata/
service_instances/ssi/metadata/content/msgdb/l_en/customMessages) to the new installed and 
configured Oracle Analytics Server domain Home location at $OAS_DOMAIN_HOME/
bifoundation/web/msgdb/l_en/custommessages. 

If the directory structure in the Oracle Analytics Server domain not exist, create it. 

Below is a list of writeback template files:

• Base_Field_Update_Template.xml

• Configuration_Update_Template.xml

• Custom_Field_Delete_Template.xml

• Custom_Field_Insert_Template.xml

• Custom_Field_Update_Template.xml

• ETL_Job_Control_Update_Template.xml

• Map_Profile_Update_Template.xml

Restart the Oracle Analytics Server services after the above writeback templates are deployed in 
the specified path. 

Note: In OBIEE bi_domain, these write back templates are stored at 
$DOMAIN_HOME/bidata/service_instances/ssi/metadata/content/
msgdb/l_en/customMessages in the directory. 
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Configuring and Deploying the MapViewer
Configuring and deploying the MapViewer involves the following tasks:

• Configuring the MapViewer

• Modifying instanceconfig.xml

Configuring the MapViewer
To configure the Mapviewer: 

1. Login to the Infrastructure console in the Oracle Analytics Server domain. 

2. Create the 'MAP_DS' datasource. 

3. Lock and edit it. 

4. Navigate to Services > Data Sources. 

5. Select New > Generic Data Source and provide the following: 

Name = MAP_DS 

JNDI Name = MAP_DS Database Type = oracle 

6. Click Next. Enter the following: 

Database Driver = *Oracle's Driver (Thin) for Service connections; Versions:Any 

7. Click Next. 

8. On the next page, do not change any values. Click Next. 

9. Enter the following connection properties: 

Database Name: BI Database Name

Host Name: Database host

Port: Database port

Database User Name: dwadm

Password: dwadm password

10. Click Next. 

11. On the next page, click Test Configuration. After the successful test click Next. 

12. On the Select Target page, select AdminServer under Servers and bi_cluster under 
Clusters. Click Finish. 

13. Click Activate Changes. 

14. Update the mapViewerConfig file with the tags mentioned below. 

File location: <Install Dir>/user_projects/domains/<oas_domain>/config/fmwconfig/
mapviewer/conf File: mapViewerConfig.xml

If there is a proxy used, insert the list of host names for all the third-party service providers in 
the security_config node. 

<proxy_enabled_hosts> elocation.oracle.com </proxy_enabled_hosts>

15. Add the following ns_data_provider node: 

<ns_data_provider id="obieeNsdp" class="com.oracle.utilities.birdseye.BirdseyeNSDP" />
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16. Add the current map_tile_server with the following map_tile_server node: 

<map_tile_server>

<tile_storage default_root_path="/mytilecache/"/> </map_tile_server>

Modifying instanceconfig.xml
Make sure to take a backup before updating the instanceconfig.xml file. Run the following 
commands in UNIX to navigate to the directory containing the instanceconfig.xml file. 

In UNIX:

<OAS_INSTALL_DIR>/user_projects/domains/<oas_domain>/config/ 
fmwconfig/biconfig/OBIPS

Perform the following changes to the instanceconfig.xml file: 

1. Update the security node with the following values. If the security node is not present, add 
the following code before </Serverinstance>. 

<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies> <CookieDomain /> 
<CookiePath>/</CookiePath> </Security>

2. Update the following <ServerInstance> element: 

<LightWriteback>true</LightWriteback>

3. Add the following code between the <ServerInstance> </ServerInstance> tags. 

<Prompts>
<MaxDropDownValues>256</MaxDropDownValues>
<AutoApplyDashboardPromptValues>true</ 
AutoApplyDashboardPromptValues>
<AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox>
<AutoCompletePromptDropDowns>
<SupportAutoComplete>true</SupportAutoComplete>
<CaseInsensitive>true</CaseInsensitive>
<MatchingLevel>MatchAll</MatchingLevel>
<ResultsLimit>50</ResultsLimit>
</AutoCompletePromptDropDowns>
</Prompts>
<SpatialMaps>
<MapViewerAPIV2Enabled>false</MapViewerAPIV2Enabled>

</SpatialMaps>

Updating MapViewer Configuration
For information about taking back up of and restoring mapViewerConfig.xml, see the Migrating 
and Upgrading to Oracle Analytics Server section in Chapter 3: Upgrading Oracle Business 
intelligence 12.2.1.4.0 to Oracle Analytics Server at https://docs.oracle.com/en/middleware/bi/
analytics-server/migrate-upgrade-oas/migrating-and-upgrading-oracle-analytics-server.pdf.  


	Contents
	Preface
	Audience
	Pre-requisite Knowledge
	Related Documents
	Conventions
	Abbreviations
	Documentation Accessibility
	Documentation Roadmap

	Chapter 1
	Introduction
	Installation Components
	Installation Types
	Initial Installation
	Upgrade
	Demo Installation

	Media Pack Components

	Chapter 2
	Supported Platforms and Hardware Requirements
	Operating Systems and Application Servers
	Additional Notes on Supported Platforms
	Support for Software Patches and Upgrades

	Chapter 3
	Planning the Installation
	Pre-requisite Software
	Pre-requisite Software for Oracle Utilities Analytics Database
	Pre-requisite Software for Oracle Utilities Analytics Installer
	Pre-requisite Software for Oracle Data Integrator Based ELT Component
	Pre-requisite Software for Oracle Utilities Analytics Administration
	Pre-requisite Software for Oracle Utilities Analytics Dashboards

	Supported Source Application Versions
	Deployment
	Installation Checklist

	Chapter 4
	Installing Oracle Utilities Analytics - Initial Installation
	Before You Install
	Installing Oracle Utilities Analytics Database
	Installing Prerequisite Software
	Copying and Decompressing Install Media
	Creating the Database
	Creating Users and Tablespaces
	Installing RELADM Schema
	Installing MDADM Schema
	Installing DWADM Schema
	Configuring Spatial Data

	Installing Oracle Data Integrator Based ELT Component
	Installing Prerequisite Software
	Setting up Oracle GoldenGate
	Copying and Decompressing Install Media
	Starting the Installer
	Installation Steps
	Creating a Database Directory
	Configuring Oracle Data Integrator Repository Creation Utility (RCU)
	Creating WebLogic Domain for Oracle Data Integrator Agent
	Starting the WebLogic Admin Server
	Starting the Managed Server (ODI_server1)

	Installing Oracle Utilities Analytics Administration Component
	Installation Steps
	Changing Default Password of the Admin User

	Installing Oracle Utilities Analytics Dashboards Component
	Copying and Decompressing Install Media
	Starting the Installer
	Installation Steps
	Deploying Web Catalog
	Deploying the Repository (RPD) File
	Configuring and Deploying the MapViewer
	Updating MapViewer Configuration
	Enabling WriteBack
	Enabling Auto Complete Feature in OBIEE


	Chapter 5
	Upgrading Oracle Utilities Analytics from v2.7.0.0.11
	Pre-requisites
	Upgrading Oracle Utilities Analytics Database Component
	Copying and Decompressing the Install Media
	Creating Users and Tablespaces
	Installing RELADM Schema
	Installing MDADM Schema
	Installing DWADM Schema

	Upgrading Oracle Data Integrator Based ELT Component
	Prerequisites for Running Oracle Utilities Analytics Installer
	Setting up Oracle GoldenGate
	Copying and Decompressing Install Media
	Configuring Source Applications
	Upgrading Oracle Utilities Analytics Administration Tool Component

	Upgrading Oracle Utilities Analytics Dashboards Component
	Prerequisites
	Copying and Decompressing Install Media
	Starting the Installer
	Upgrade Steps
	Deploying Web Catalog
	Deploying Repository (RPD) File
	Enabling WriteBack
	Enabling Auto Complete Feature in OBIEE


	Chapter 6
	Upgrading Oracle Utilities Analytics from v2.6.0.0.10
	Pre-requisites
	ODI Related Settings
	Upgrading Source Applications to be Compatible with Oracle Utilities Analytics v2.7.0.1

	Upgrading Oracle Utilities Analytics Database Component
	Upgrading Oracle Data Integrator Based ELT Component
	Prerequisites for Running Oracle Utilities Analytics Installer
	Setting Up Oracle GoldenGate
	Copying and Decompressing Install Media
	Starting the Installer
	Upgrade Steps
	Configuring Source Applications

	Upgrading Oracle Utilities Analytics Administration Tool Component
	Prerequisites
	Installation Steps
	Changing Default Password of Admin User

	Upgrading Oracle Utilities Analytics Dashboards Component
	Prerequisites
	Copying and Decompressing Install Media
	Starting the Installer
	Upgrade Steps
	Deploying Web Catalog
	Deploying Repository (RPD) File


	Chapter 7
	Installing Demo Database
	Installing Oracle Utilities Analytics Demo Database Component
	Copying and Decompressing Install Media
	Creating Database and Importing the Dump File
	Configuring Security
	Configuring Spatial Data

	Installing Oracle Utilities Analytics Dashboards Component
	Copying and Decompressing Install Media
	Starting the Installer
	Installation Steps
	Deploying Web Catalog
	Deploying the Repository (RPD) File
	Configuring and Deploying the MapViewer
	Updating MapViewer Configuration
	Enabling WriteBack
	Enabling Auto Complete Feature in OBIEE


	Chapter 8
	Configuring Spatial Data
	Acquiring the Spatial Data
	Installing Spatial Data
	Importing Spatial Data into Oracle Utilities Analytics Spatial Data Tables
	Importing Theme Related Spatial Data into Oracle Utilities Analytics
	Improving Performance by Prefetching the Map Tiles

	Loading the Oracle Utilities Specific Themes
	Additional Setup for Oracle Utilities Outage Analytics

	Chapter 9
	Installing NMS BI Publisher Reports
	Chapter 10
	Installing/Upgrading to Oracle Analytics Server
	Prerequisites
	Installing Oracle Analytics Server for the First Time
	Installing Oracle Utilities Analytics Dashboards Component
	Deploying Repository (RPD) File
	Deploying Writeback Templates in Oracle Analytics Server Domain
	Configuring and Deploying the MapViewer
	Updating the MapViewer Configuration
	Enabling WriteBack
	Enabling Auto Complete Feature Oracle Analytics Server

	Existing Customers Performing New Oracle Analytics Server Installation
	Upgrading Oracle Utilities Analytics Dashboards Component
	Deploying Repository (RPD) File
	Deploying Writeback Templates in Oracle Analytics Server Domain
	Configuring and Deploying the MapViewer
	Updating the MapViewer Configuration
	Enabling Writeback
	Enabling Auto Complete Feature Oracle Analytics Server

	In-place Upgrade to an Existing Oracle Analytics Server
	Upgrading Oracle Utilities Analytics Dashboards Component
	Deploying Repository (RPD) File
	Deploying Writeback Templates in Oracle Analytics Server Domain
	Configuring and Deploying the MapViewer
	Updating MapViewer Configuration



